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Safety Considerations. 
 

Throughout this manual Monitor is used for: 

Photoacoustic Gas Monitor – INNOVA 1412i 
Photoacoustic Gas Monitor – INNOVA 1512 

Photoacoustic Gas Monitor – INNOVA 1314i 

LumaSense SF6 Leak Detector - 3434i 
 

The Monitor complies with: 

 
• EN/IEC 61010-1, 3rd Edition: Safety requirements for electrical 

equipment for measurement, control and laboratory use. 
•  

 
 

• Can/CSA-C22.2 No. 61010-1-04 - Safety Requirements for 
Electrical Equipment for Measurement, Control, and Laboratory 

Use. 
 

• UL Std. No. 61010A-1 (3rd Edition) - Safety Requirements for 
Electrical Equipment for Measurement, Control, and Laboratory 

Use. 
 

 
To ensure safe operation and retain the Monitor in safe condition, note 

the following: 
 

 

EXPLOSION HAZARD! 
 

TO AVOID THE POSSIBILITY OF AN EXPLOSION; MONITORING 
OF FLAMMABLE GASES IN EXPLOSIVE CONCENTRATIONS MUST 

NEVER BE ATTEMPTED. 

 
 

Never operate the Monitor in potentially explosive 
environments. 

 
When monitoring potentially flammable or toxic gases it is essential 

that: 
 

• The instrument itself is placed in a well-ventilated area outside the 
potentially hazardous zone. 
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• A sufficiently long tube is connected to the air-outlet on the back 

panel so that the sampled gas is carried away to the open air or to 
an extraction and/or filtration unit. 

 

 Warnings! 
 

• Avoid water condensation in the Monitor. 
 

• Switch off all equipment before connecting or disconnecting their 
digital interface. Failure to do so could damage the equipment. 

 
• Whenever it is likely that correct function or operating safety of the 

apparatus has been impaired, the apparatus must be made in-

operative and secured against unintended operation. 
 

• Any adjustment, maintenance and repair of the open apparatus 
under voltage must be avoided as far as possible and, if 

unavoidable, must be carried out only by trained personnel. 
 

• If a fault is reported by the Monitor that indicates correct function 
of the instrument may be impaired, consult your local LumaSense 

Technologies representative. Under no circumstances should repair 
be attempted by persons not qualified in service of electronic 

instrumentation. 
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1.1 Introduction 
 

This manual can be used in several ways. The first time users can 

work their way through the examples in order to get to know the 
monitoring system. The more experienced users can jump directly to 

the relevant chapters in order to gain assistance, and experts can use 
this manual as a reference book by using the index. 

 
The LumaSoft Gas Single Point 7820 Software is used as a single 

channel monitoring software for Photoacoustic Gas Monitor’s 
 

The LumaSoft Gas Multi Point 7880 Software is used as a multi 
channel monitoring Software for a Photoacoustic Gas Monitor in a 

system with a Multipoint Sampler – INNOVA 1409. 

 
NOTE: The LumaSoft Gas Multi Point 7880 Software requires a license 

dongle connected to the USB port in order to run. 
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1.2 Screens 
 

The information displayed on screen is presented in this manual as 
shown below: 

 

 
Radio push-buttons: these are not illustrated above, but are 

commonly used in the software. They act as a toggle function when 
several options are available, but only one can be selected at a time. 

 

1.3 Stand-alone Use 
 

In some situations, it may be necessary to set up the Monitor without 
connecting it to a PC. The way these instructions are presented is 

shown below: 
 

 

    SELECT SET-UP BRANCH  
MEASUREMENT                   FORMAT                       CONFIGURATION 

1. Menu bar option e.g. File 

2. Pull down menu option Export Task 

3. Index card e.g. Gas 

4. Group e.g. Gas Setup 

5. Select Field e.g. Select SIT 

6. Check box used to select options 

7. Soft-key e.g. Read Filter Info 
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The display above is used through-out this manual. It assists you 
displaying the text on screen and by indicating which of the push-

buttons can and should be pressed. 
 

In general, the push-buttons shown above are used to navigate 
through the various modes possible within the Monitor but are 

described in more detail below: 
 

 
These push-buttons are illustrated as S1, S2 and S3.  They 

correspond to the key and their position on the instrument. 
 

These select push-buttons enable you to select one of the options 
displayed. 

 
This group of 5 push-buttons are referred to in this manual 

collectively as the direction keys. The symbols below are used to 

simplify the instruction in this manual. 
 
▲ & ▼ enable you to increase & decrease numbers, respectively, or to 

go to the Previous & Next Displays, respectively. 
 
◄ & ► enable you to move across number fields or go to the Previous 

& Next gases, respectively. 

 

, depending on the situations, acts as an “Enter” or “Go To Head” 

key. 

 

Memory Function push-buttons are always represented with the name of 

the push-button enclosed in a box which is shaded-in. 

 
SYSTEM Text that appears on the display screen is shown in an open 

shaded box, using UPPER case letters. 
 

FORMAT System General Clock 
  

  

            S1                           S2                            S3 
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 When referring to any part of the Set-up “tree”, the text is 
shown in open shaded boxes with the same typeface as that 

used in the “tree”. 
 

For further description refer to the Gas-Monitor Instruction Manual 
delivered with your monitor. 

 

1.4 Tool-bar Icons in LumaSoft Gas Monitoring 

Software 7820 and 7880 
 

The instructions in this manual use the pull-down menu paths to 
describe how operations are possible. However, in many cases, the 

icons in the tool-bars can be used to speed things up. Top Level 
toolbars and icons are presented in the following sections. 

Other toolbars and icons will be presented in subsequent chapters. 
 

1.4.1 Toolbar: Manage Users 
 

 
 

 

      Opens a window dialog to create new users 

 

     Change the password for the administrator  

 

     Log off administrator 

 

     Show information about software version 

 
 

1.4.2 Toolbar: Main menu 
 

 

 
 

      Create new task 

 

     Open existing task  

 

     Delete task 

 

     Log off 

 

     Exit program 
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     Show information about software version 

 

1.4.3 Toolbar: Measurement 
 

  

 

 

      System configuration 
 

     Start measurement 

 

     Stop measurement 
 

     Close task 

 

     Show information about software version 
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When taking delivery of the System three very important and 
preliminary tasks must be completed before starting to operate it: 

 
Install the LumaSoft Gas Software (7820 or 7880) see Section 2.1. 

Connect the Monitor and the Multiplexer to a PC (Section 2.2). 
Setting-up User Accounts (Section 2.3). 

 
Both the LumaSoft Gas Software (7820 or 7880) can be installed next 

to each other as they (7820 or 7880) each have their own database. 
 

For compatibility with the previous LumaSoft Gas 7810/7870 please 
refer to section 2.1.3. 

 
Please note that measurement data saved in 7820 database cannot 

be moved to the 7880 database and vica versa. 
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2.1 Install the LumaSoftGas SinglePoint (7820) or 

MultiPoint (7880) Monitoring Software 
 

2.1.1 Computer requirements 
 
The Software is targeted to work on a Desktop/Laptop PC 

environment running a Microsoft Windows Operating System. 
 

Before installing the Software the PC must meet the following 
minimum requirements: 

 
The Software is targeted to work on a Desktop/Laptop PC 

environment running a Microsoft Windows Operating System. 

 
Before installing the Software the PC must meet the following 

minimum requirements: 
 

Processor Minimum: 2 gigahertz (GHz) Dual-Core 
 i3 processor or compatible 

Operating System Windows 7 Service Pack 1 

Windows 8.1 Service Pack 1 
Windows 10 v1909 

RAM Minimum: 2048 MB (Win7+10) 4096MB (Win8) 

Hard Disk Up to 500 MB of available space may be 
required. 

Display Minimum: 1440 x 900 high color 

Total port 

connections 

2 (1 with 7820) USB ports 

Or 

1 (0 with 7820)  USB port and 1 Ethernet 
(TCP/IP) port 

Or 
1 (0 with 7820)   USB port and one RS232 port 

Connection to Gas 
Monitor 

1 USB port 
Or 

1 Ethernet (TCP/IP) port 
Or 

1 RS-232 port 

Connection to 
License dongle 

(LumaSoft Gas 
7880 only) 

1 USB port for LumaSoft Gas License Dongle 
Key (This License Dongle key is delivered by 

LumaSense) 

Table 2.1 Computer requirements 
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Microsoft Office is required if using the export to Excel file 
format functionality in LumaSoft Gas. 

 
 

 

2.1.2 Installing LumaSoft Gas 
 
The LumaSoft Gas software is delivered on a USB memory key with 

an installation program. Please refer to Appendix A how to perform 
the installation of the LumaSoft Gas software. It is recommended that 

your system administrator performs the task of installing the 
LumaSoft Gas program. 

 
After the installation is successfully completed the LumaSense -> 

LumaSoft Gas program menu is created. 
 

The “LumaSoftGas 7820” program icon (Figure 2.1a) or the 

“LumaSoftGas 7880” program icon (Figure 2.1b) is placed on your 
desktop for easy access to the program. 

 

 
Figure 2.1a LumaSoftGas 7820 desktop shortcut 

 

 
Figure 2.1b LumaSoftGas 7880 desktop shortcut 

 

 

2.1.3 Compatibility with LumaSoft Gas 7810 and 7870 
 

Measurement tasks which has been backed up using LumaSoft Gas 
7810 application, can be restored into the LumaSoft Gas 7820 

application.  
 

Measurement tasks which has been backed up using LumaSoft Gas 
7870 application, can be restored into the LumaSoft Gas 7880 

application.  
 

Please check 5.3.1 how to backup a measurement task and 5.3.2 how 
to restore a measurement task. 
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2.2 Connecting the Monitor and the Multiplexer to a PC 
 

The Monitor comes complete with an USB interface cable. 
 

Optionally an Ethernet (TCP/IP) interface cable or a 9-pin to 9-pin null 
modem RS-232 interface cable can be delivered. 

 
 

2.2.1 Fitting the USB Cable 
 
The USB interface cable can be connected while the gas monitor is 

switched on. 

 
Locate an USB port at the back of the PC; refer to your PC manual if 

in doubt. Push the connector on the USB cable on to the USB port 
socket on the PC. 

 

Locate the USB port labelled  at the back of the Monitor. Push the 

connector at the other end of the USB cable on to this socket. 
 

 

2.2.1 Setting the USB Communication Parameters 
 

No setup on the gas monitor is necessary in order to be able to 
communicate with the gas monitor through an USB connection.  

 
 

2.2.3 Fitting the Ethernet (TCP/IP) Cable. 
 
The gas monitor can be connected to a local Ethernet network, which 

communicates using the TCP/IP network interface protocol or to view 
the homepage of the gas monitor in a standard PC internet browser. 

 
The Ethernet network cable can be connected while the gas monitor is 

switched on. 

Locate the Ethernet socket connector labelled   at the back of the 

Monitor. Connect a standard Ethernet network cable to the Ethernet 
socket connector on the back of the gas monitor. Connect the other 

end of the Ethernet network cable to your local network. The yellow 
LED on the Ethernet socket connector will lit, if a local network 

connection is detected. 
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2.2.4 Setting the TCP/IP Communication Parameters 

 
It is recommended that your system administrator sets-up the TCP/IP 

communication parameters. 
 

The communication parameters for the TCP/IP interface can be set by 
using the push-buttons on the front of the monitor. 

 
1. Press SET-UP CONFIGURATION System Communication  

The screen display now shows the following text. 

 
2. Press Ethernet to enter the Ethernet setup. During this setup you 

can also use the ▲ and ▼ keys to go back and forth between the 

available Ethernet settings. The screen display now shows the 

following text. 

 

3.  Here you can select whether the IP address of the gas monitor is 
to be assigned by a DHCP server in the local network. If you want 

the gasmonitor’s IP address to be assigned by the DHCP server 
press the Yes key, where after you will proceed to the below step 

6, as the IP address is set by the DHCP server. If you want 
yourself to set the IP address of the Gas Monitor press the No key. 

The screen display now shows the following text. 

 
4.  Here you can change the IP address of the gas monitor in case the 

IP address is not set by a DHCP server in the local network. If you 

want to change the IP address, press the  key. If the IP address 

does not need to be changed, press the ▼ key and you will 

proceed to the below step 6. 

If you selected to change the IP address, the screen display now 
shows the following text. 

 

 SELECT COMMUNICATION SET-UP BRANCH 

  RS232                Ethernet                Connections  

 IS 1412i'S IP ADDRESS SET BY DHCP ? 
               NO                                      YES 

 1412i'S IP ADDRESS 192.168.000.200 

               PRESS ENTER TO CHANGE VALUE 

 1412i'S IP ADDRESS 192.168.000.200 

               CANCEL                         DEFAULT 
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5.  Here you can change the 4 individual numbers in the IP address 
by using the ▲ and ▼ keys. Each of the 4 individual numbers can 

be set in the range from 000 to 255. 

You can step between the 4 individual numbers in the IP address 
by using the ◄ and ► keys. 

In case you want to return to the start value of the IP address 

press the CANCEL key. In case you want to return to the default 

stored value of the IP address press the DEFAULT key. 

When you have set the IP address, press the  key. The screen 

display now shows the following text. 

 

 
6.  Here you can set the IP port number for the TCP/IP 

communication. This normally does not need to be changed. If you 

want to change the IP port number press the  key. If the IP port 

numbers does not need to be changed, press the ▼ key and you 

will proceed to the below step 8. If you selected to change the IP 

port number the screen display now shows the following text. 

 
7.  Now you can change the IP port number by using the ▲ and ▼ 

keys. The port number can be set in the range from 0 to 32767. 

In case you want to return to the start value of the IP port number 
press the CANCEL key. In case you want to return to the default 

stored value of the IP port number press the DEFAULT key. 

When you have set the IP port number, press the  key. The 

screen display now shows the following text. 

 

8.  In case you want the gas monitor to be able to communicate only 

with a certain PC on the local network, you can set the IP address 
of this PC as the protected IP address. This can be desired due to 

security reasons so no other PC is able to communicate with the 
gas monitor. 

If no protection is desired the protected IP address should be set 
to a value of 000.000.000.000. 

If you want to change the protected IP address, press the  key. 

If the protected IP address does not need to be changed, press the 
▼ key and you will proceed to the below step 10. 

 1412i'S IP PORT NUMBER:        23  

              PRESS ENTER TO CHANGE VALUE 

 1412i'S IP  PORT NUMBER:        23 

               CANCEL                         DEFAULT 

         PROTECTED IP ADDRESS 000.000.000.000 
               PRESS ENTER TO CHANGE VALUE 
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If you selected to change the protected IP address the screen 
display now shows the following text. 

 

9.  Here you can change the 4 individual numbers in the protected IP 
address by using the ▲ and ▼ keys. Each of the 4 individual 

numbers can be set in the range from 000 to 255. 
You can step between the 4 individual numbers in the protected IP 
address by using the ◄ and ► keys. 

In case you want to return to the start value of the protected IP 
address press the CANCEL key. In case you want to return to the 

default stored value of the protected IP address press the 
DEFAULT key. 

When you have set the protected IP address, press the  key. 

If you previously selected the IP address NOT to be set by the 
DHCP server, you can proceed to the below step 11. 

If you instead selected that the IP address to be set by the DHCP 
server, the screen display now shows the following text. 

 

10. Here the IP address of the gasmonitor, which has been assigned 
by the DHCP server is displayed. This IP address can be used to 

manually set TCP/IP communication in a PC application, which 
accesses the gas monitor. 

Press the ACCEPT key to accept. 
 

11. This concludes the setup of the TCP/IP parameters of the gas 

monitor. 

Press the SET-UP key to leave the setup. 

 

2.2.5 Fitting the RS-232 Cable 
 

Ensure that both the Monitor and the PC are switched off at the 
mains. Failure to do so may result in your equipment being damaged. 

Locate the serial port at the back of the PC; refer to your PC manual if 
in doubt. 

Push the connector on the RS-232 cable on to the serial port socket, 
and secure it firmly using the securing screws. 

Locate the output labelled “RS-232” at the back of the Monitor. 

Push the connector at the other end of the RS-232 cable on to this 
socket, and secure it firmly using the securing screws. 

Turn on the PC. Wait for Windows to start up. 
The Monitor can be turned on at the mains. 

         PROTECTED IP ADDRESS 000.000.000.000 

                CANCEL                         DEFAULT 
 

         CURRENT DHCP ADDRESS 192.168.000.062 

                                 ACCEPT 
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2.2.6 Setting the RS232 Communication Parameters 
 

In order for the RS-232 communication to be successful, it is essential 
that the communication parameters are set correctly. This is a two 

stage process: the PC communication port is selected via the 

LumaSoft Gas software while the baud rate, parity, data bits and stop 
bits are defined via the Monitor. 

 
The communication parameters necessary for the Monitor to 

communicate with the LumaSoft Gas are shown below in Table 2.2. 
 

Baud rate 9600 

Stop bits 1 

Data bits 7 

Parity Even 

Hardwire mode Leased line 

Handshake type Hardwire 

Table 2.2 Monitor RS232 communication parameters 

 
These are set as the default values in the Monitor. 

 
To prevent communication errors, the text line terminator, print data 

log and print error log must be set as shown in Table 2.3. 
 

 
 

Text line Terminator CR-LF 

Print Data Log NO 

Print Error Log NO 

Table 2.3 More Monitor parameters 
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2.2.7 Checking/Changing the RS-232 Communication 
Parameters in the Monitor 

 

The communication parameters for the serial interface must be set 
using the push-buttons on the front of the Monitor. 

 

1. Press SET-UP S3 S1 S3 S1 (see Chapter 1.3) .The screen display 

shows the following text. 

 

 

If the baud rate displayed is incorrect press  and use ▲ and ▼ to 

display the correct value. Press  again to store the selection. 

If the baud rate displayed is correct, then press ▼ to continue to the 

next parameter. 
Press S1 to select 1 STOP BIT. 

Press S1 to select 7 DATA BITS 
Press S2 to select EVEN PARITY 

Press S3 to select LEASED-LINE 
Press S3 to select HARD-WIRED HANDSHAKE. 

Press SET-UP to exit the set-up mode 

Press RESET and S1 in order that the new settings are enabled. 

 

The Monitor and the LumaSoft Gas Monitoring Software are now able 

to communicate together. 
 

 

2.2.8 Checking/Changing the Text line Terminator in the 
Monitor. 

 

The Text line Terminator must be set using the push-buttons on the 
front of the Monitor. 

 

Press SET-UP S2 ▼S3 

 

Press SET-UP to exit the set-up mode 

 
 



Chapter 2 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 23 of 215 

 

2.2.9 Selecting the PC communication Port 
 

It is just a simple case of selecting the correct port on the PC. The 

software shows the COM ports that are present in the system to 
choose from: COM1, COM2, COM3…. If you are not sure which port 

the cable is connected on your computer refer to your PC manual. 
 

 

2.2.10 Setting up a Multipoint System with Multipoint Sampler 
- INNOVA 1409 

 
The 1409 is connected to the Gas Monitor using an USB cable, type A 

to Type B according to the USB 2.0 standard. LumaSense can supply 

the correct cable, Cable order no. AS0001A. 
 

 

2.3 Setting-up User Accounts 
 

Setting up user accounts can be performed by the administrator only. 
 

After starting the LumaSoft Gas application the User Authentication 
window opens, where you authenticate yourself as the administrator 

by specifying the administrator user name and password. 
 

The default administrator password is: Administra 
 

 
Figure 2.2 Login dialogue window 

 

To create new users you can either select the Manage User icon  

from the toolbar or select Manage User from the User pull down 
menu, see Figure 2.3. 

 

 
Figure 2.3 User pull-down: Manage User 
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The User Accounts window appears showing a list of the current 

user accounts, see Figure 2.4. 
 

A predefined user account named LumaSoftGas with the highest 
access level appears the first time the User Accounts window is 

opened. The predefined password for the LumaSoftGas user is: 
lumasoftgas 

 

 
Figure 2.4 User Accounts 

 

2.3.1 Add User Account 
 
In order for the administrator to add a new user account the Add 

soft-key can be selected. 
The Add New User window appears (see Figure 2.5). 

 

 
Figure 2.5 Add User Account 

 
The User Name, Password and Access Level for the new user 

account can be specified. 
Please note that the User Name and Password must contain at 

least 6 characters and must contain no special characters. Only 
alphabets and numeric characters are allowed [(a-z), (A-Z), (0-9)] for 

the User Name and Password (see Figure 2.6). 
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Figure 2.6 User access Levels 

 
Three different access levels can be specified. The rights for each of 

the access levels are described below in table 2.6. 
 

Access level Rights 

Super All expert rights 
Delete task 

Expert All operator rights 
Create a new task 

Make setup of a task 
Backup/restore a task 

Operator Open a task. 

Start a measurement 
Export a task 

Export log 
Export/import a task configuration 

Table 2.6 User access levels 
 

2.3.2 Edit User Account 
 

 
Figure 2.7 User Accounts: Edit 

 

A user account can be edited by the administrator by selecting the 

Edit soft-key in the User Accounts window. Before selecting the 
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Edit soft-key a User Name must be selected in the User Accounts 
window. 

 

 
Figure 2.8 Edit User Account 

 
The access level can be changed by selecting the Access Level field. 

Also the Password can be changed by selecting the Reset Password 
soft-key. (See Figure 2.8). 

 

 
Figure 2.9 Reset password dialogue 

 

The Reset Password dialogue window appears and the new 
password for the user account can be entered. (See Figure 2.9). 

 

2.3.3 Remove User Account 
 

 
Figure 2.10 User Accounts: Remove 

 

A user account can be removed by selecting the Remove soft-key in 
the User Accounts window, see Figure 2.10. Before selecting the 
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Remove soft-key a User Name must be selected in the User 
Accounts window. 

 

2.3.4 Change password of the administrator 
 
To change the password of the administrator you select the Change 

password icon  from the toolbar or select Change Password 

from the User pull down menu. (See Figure 2.11) 

 

 
Figure 2.11 User pull-down: Change Password 

 

The Change Password dialogue window (Figure 2.12) appears and 

the old and new password for the administrator can be entered. 
 

 
Figure 2.12 Change Password dialogue 

 

2.3.5 Disable the User Authentication logon 
 

After starting the LumaSoft Gas application the User Authentication 
window (see figure 23) will normally open.   

 
It is possible to disable the User Authentication window logon, by 

creating a special user with the name ‘skipLogin’. 

 
The special user named ‘skipLogin’ can be created by doing as 

follows: 
 

1. After starting the LumaSoft Gas application make a login as 
administrator as shown in figure 2.2. 

 
2. Select the Manage User menu item (figure 23). 

 
3. The User Accounts window appears (figure 24). Press the Add 

button in order to define a new user. 



Chapter 2 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 28 of 215 

4. In the Add New User window (Figure 2.13) enter ‘skipLogin’ as 
the User Name, any password and select the Access Level as 

Super, in order to grant the ‘skipLogin’ all rights.  
 

 
Figure 2.13 Define the ‘skipLogin’ user 

 

5. Press OK twice to close the Add New User window and the User 
Accounts window. Close the application by clicking the ‘X’ in the 

upper right corner 
 

6. Start the LumaSoft Gas application, where the User 
Authentication logon window now shouldn’t appear. Notice that 

the current user is now ‘skipLogin’ as shown in the status bar 
below to the right. 

 

If you want to enable the User Authentication window logon again 
the ‘skipLogin’ user should be removed. This can be done choosing 

the File menu Log Off (Figure 2.14). 
 

 
Figure 2.14 File pull-down: Log Off 
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Make an administrator login (2.3).  

 
Select the Manage User menu item (23). 

 
In the User Accounts window use the Remove button to remove the 

‘skipLogin’ user (see 2.3.3). 
 

 

2.4 Download of the latest version 
 

You will find the latest version of the software on 
http://innova.lumasenseinc.com/downloads 

 

2.5 Back-up and Restoring of calibration data 
 

If you have ordered a calibration from our calibration laboratory, you 
will receive a CD with a backup of the calibration data. It is very 

important that you store these data in your Gas Monitoring Software 
BZ7002, supplied with the Monitor. Please refer to the Instruction 

Manual BE6034 for guidance in how to backup and restore 
calibration data. 

 

2.6 Configuration of Automated backup of the 

Database 
 
For guidance how to set-up for automated backup of the entire 

database please refer to Appendix B 
 

 
 

 

http://innova.lumasenseinc.com/downloads
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This chapter will show the steps how to set-up a measurement task. 
 

Please note that measurement set-up is only allowed for users with 
Expert or Super access level. (See Table 2.6) 

 
Logon to the software using your username and password. 

 

 
Figure 3.1 User Authentication 

 

The User Authentication logon can be disabled as described in 2.3.5 
. 

 
 

3.1 Select Communication Interface 
 
The first time you start the LumaSoft Gas application you need to 

configure the interface used to communicate with the gas monitor. 
 

The LumaSoft Gas application comes preconfigured for the USB 

interface, so if that is your communication interface of choice, you can 
proceed to 3.2 . 

 
After having defined the communication interface, it needs not to be 

configured again after restarting the LumaSoft Gas application, unless 
you want to use another communication interface. 

 
If you already configured the communication interface, you can 

proceed to 3.2 . 
 

Please make sure that you have an USB, Ethernet (TCP/IP) or a RS-
232 interface cable connected to the Gas Monitor device. 

 
IMPORTANT! Please note that only one interface cable (either 

USB, Ethernet (TCP/IP) or RS-232) should be connected at any 

time. 
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Select the Select Communication Interface pull-down menu 

(Figure 3.2). 
 

 
Figure 3.2 File pull-down: Select Communication Interface 

 
If you are using the USB interface cable connection please proceed to 

section 3.1.1. 
 

If you are using the Ethernet (TCP/IP) interface cable connection 
please proceed to section 3.1.2. 

 
If you are using the RS-232 interface cable connection please 

proceed to section 3.1.3. 
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3.1.1 Configuration of the USB interface 
 

The System Configuration Setup window appears. Now you select 

the USB radio button as shown in figure 3.3 in case it is not selected. 
 

 
Figure 3.3 Select the USB communication interface. 

 
To close the System Configuration Setup press the OK soft-key. 

 
Please make sure that the USB interface cable between the PC and 

the Gas Monitor is securely connected.  
 

Now proceed to 3.2 in order to create a new task. 

 
 

In the case that you are having a communication error (see 3.2) with 
the gas monitor through the USB connection,  please ask your PC 

Administrator to check for the presence of the 1412i USB driver in the 
Device Manager (Figure 3.4). Please note that the 1412i USB driver 

also supports the 1512, 1314i, 3436i and 3434i Gas Monitor. 
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Figure 3.4 The 1412i USB driver. 
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3.1.2 Configuration of the Ethernet (TCP/IP) interface 
 

The System Configuration Setup window appears. Now you select 

the TCP/IP: radio button as shown in Figure 3.5 . 
 

 
Figure 3.5 Select the TCP/IP communication interface. 

 
Enter the IP address of the Gas Monitor into the IP-address field as 

shown in Figure 3.6. 
 

 
Figure 3.6 Enter the IP Address of the Gas Monitor. 

 
Refer to Section 2.2.4 to find the IP address of the Gas Monitor. 
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In order to set further TCP-IP related settings, you can select the 
Advanced Settings soft-key. These TCP-IP settings needs normally 

only to be altered in the case that you cannot access the TCP-IP 
connection of the gas monitor. Please consult your system 

administrator or your local TCP-IP network in case you need to 
change the TCP-IP settings. 

 

 
Figure 3.7 Advanced TCP-IP settings 

 
Press the OK soft-key to close the Communication (TCP-IP) 

window.  
 

Press the OK soft-key to close the System Configuration Setup 
window.  

 

Proceed to Section 3.2 in order to create a new task. 
 

If the creation of a new task failed the following message box will 
appear. It is caused by the LumaSoft Gas being unable to 

communicate with the Gas Monitor through Ethernet (TCP/IP). 
 

 
Figure 3.8 Communication failed with the Gas Monitor. 

 

Please make sure that the Ethernet (TCP/IP) interface cable between 

your network and the Gas Monitor is securely connected. 
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Please ask your Administrator to check the TCP/IP settings of the 
Gas Monitor as described in Section 2.2.4. 

 
Make sure that the PROTECTED IP ADDRESS either is set to the IP 

Address of your PC or set to 000:000:000:000.  
 

Make a note of the IP Address of the Gas Monitor device as displayed 
in the TCP/IP settings.  

 
Your Administrator can now open a DOS Command Prompt to check 

for a ping reply from the IP Address of the Gas Monitor device. 
 

 
Figure 3.9 Ping reply from the Gas Monitor device. 
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3.1.3 Configuration of the RS-232 interface 
 

The System Configuration Setup window appears. Now you select the 
COM Port: radio button as shown in figure 3.10, in order to select the 

appropriate COM Port, according the serial port on your PC, which is 
used to connect to the gas monitor.  

 

 
Figure 3.10 Select the RS-232 communication interface. 

 

By selecting the Advanced Settings soft-key the communication 
parameters can be altered. These settings do normally not need to be 

changed as they reflect the default settings for the gas monitor. Press 

the OK soft-key to save and close the altered settings. 
 

 
Figure 3.11 The RS-232 communication parameters 

 

Now proceed to 3.2 in order to create a new task. 
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3.2 New Task 
 

In order to create a new task select the New Task pull-down menu 
(Figure 3.12). 

 

 
Figure 3.12 File pull-down: New Task 

 
If the Gas Monitor device is recognized the New Task window (Figure 

3.13) opens, where you enter the name of the new task and press the 

OK soft-key. After that you can proceed to section 3.3. 
 

 

 
Figure 3.13 Type in the name of the new task. 

 
If the Gas Monitor device is NOT recognized the Communication Error 

message box (Figure 3.14) will appear. Press the OK soft-key. 
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Figure 3.14 Communication Error message box. 

 

Please check the communication interface as shown in 3.1. 
 

 

3.3 Measurement set-up 
 
The set up of a new measurement task is carried out in five steps. 

 

3.3.1 Configuration 
 

First step is System Configuration Setup, select Configuration in the 

Set Up pull down menu (Figure 3.17) or select the  icon from the 
task bar. 

 
Figure 3.17 Set-up pull-down: Configuration 

 

The following System Configuration Set Up window will appear.  
 

No setup is needed here, but you can recheck which communication 
interface has been selected. 

 
In case of the LumaSoft Gas 7880 application, it can be checked how 

many sample valves are available, if a 1409 Multipoint Sampler is 
connected. 

 
Please refer to the sections 3.1.1 (USB), 3.1.2 (TCP/IP) and 3.1.3 

(COM Port) for an explanation of the communication interface types. 
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Figure 3.18 System Configuration SetUp 

 

3.3.2 Monitor Setup 
 

Set up of the Monitor is done by selecting Monitor in the Set Up pull 
down menu. (Figure 3.19) 

 

 
Figure 3.19 Set up pull-down: Monitor 

 

The Monitor Setup will appear. For LumaSoft Gas 7820 (Figure 
3.20). For LumaSoft Gas 7880 (Figure 3.20a). 
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Figure 3.20 7820 Monitor Setup, Sampling 

 

 
Figure 3.20a 7880 Monitor Setup, Sampling 

 
Sampling Index Card 

 
In the Flushing group box select if the flushing of the instrument 

should be Auto or Fixed Time. 
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By selecting Auto the monitoring system controls the flushing by 
selecting the optimum flushing time. This time can vary as the option 

takes into account the cleanness of the external air filters and the 
length of the sampling tube. Type in the length of the tubing. (See 

Figure 3.20 or Figure 3.20a). 
 

Selecting Fixed Time allows the user to define a flushing time for 
chamber and tubing. Table 3.1 shows the acceptable values for 

flushing chamber and tubing. 
 

Acceptable Values Interval Default 

Value 

Chamber: 2 to 60 s 

Tube: 0 (=off), 3 to 120 s 

1 s 

1 s 

8 s 

3 s 

Table 3.1 Acceptable values for flushing the system when selecting 

Fixed Time flushing 

 
In the Compensation group box, see Figure 3.20 or Figure 3.20a, 

compensation for Water and Cross Interference can be checked 
on/off. 

It is suggested that Water should be compensated for in all measuring 
situations except where extremely dry gases are being measured. 

 
If any interfering gas other than Water Vapour is present in the 

ambient air sample, the Monitor can cross compensate for the 
interference caused by its presence provided that a selective optical 

filter is installed in the Monitor to measure the concentration of the 
interfering gas present. 

 
LumaSoft Gas 7820: 

In the Sample Information group box, see Figure 3.20, select 

whether sampling is continuous or with a time interval. Select 
Sample Continously if you want the next sampling immediately 

after finishing the previous sampling. If Sample Interval is selected 
a time interval (in minutes) can be set to define the time between the 

individual samples. 
 

LumaSoft Gas 7880: 
In the Sample Information group box, see Figure 3.20a, select 

whether multiplexer sequences are continuous. Select Sample 
Continously if you want the next multiplexer sequence immediately 

after finishing the previous multiplexer sequence. If Sequence 
Interval is selected a time interval (in minutes) can be set to define 

the start of one multiplexer sequence to the beginning of the next. If 
Sample Interval Mode is ticked, the time interval will be between 

the individual samples rather than between the multiplexer 

sequences. 
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Gas Index Card 

 
Select the Gas index card and press the Read Filter Info soft-key 

(See Figure 3.21) to read the filter configuration from the Monitor. 
 

 
Figure 3.21 Monitor Setup, Gasses to be measured 

 
The calibrations in the Monitor will appear as Gas A, B, C, D and E, 

see Figure 3.22. Select the gasses which should be measured by 

using the checkboxes. 
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Figure 3.22 Monitor Setup 

 
Also select the Sample Integration Time (SIT) to be used in the 

measurements and press OK. 
 

To select different SIT’s for different gases use the Sample 
Integration Time field selection and select Advanced. 

A select field appears for each gas, see Figure 3.23. Then it is possible 

to define a SIT for individual gases. 
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Figure 3.23 Selecting Advanced the user can define SIT for the 

different gases 
 

3.3.3 Multiplexer setup 
 

If a multiplexer is connected to the Monitor select Multiplexer in the 
Set Up pull down menu. (See Figure 3.24) 

 

 
Figure 3.24 Set Up pull-down: Multiplexer 
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Figure 3.25 Multiplexer SetUp 

 
Select the channels from which the multiplexer should draw air 

samples. For each channel a specific location or name can be 
assigned. 
 

Choose between a Normal sequence and a User sequence. By 
selecting a normal sequence (see Figure 3.25), air samples will be 

drawn first from channel 1 then 2, 3, 4 etc., that is in ascending 

order. Selecting User Sequence allows you to define the sampling 
order arbitrarily, by typing in the channel numbers in a specific order, 

see Figure 3.26. 
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Figure 3.26 User defined sample sequence 

 

3.3.4 Alarms 
 

This function is used to define software alarms for each gas when the 
concentration reaches either a minimum or a maximum level. 

 

 
Figure 3.27 Set Up pull-down: Alarm 

 

Select Alarm in the Set Up pull down menu, and the following 

window will appear, Figure 3.28. 
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Figure 3.28 Alarm Setup for specific gases 

 

First select the channel number in the field selection box for which the 

alarm should be configured, as shown in Figure 3.29. 
 

 
Figure 3.29 Select a channel number in the left pull down box. 
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Then select the gas for which the alarm should be configured in the 

Gas selection box, see Figure 3.30. 
 

 
Figure 3.30 Select for which gas the alarm should be configured 

 

There are four different alarms which can be configured: Low, Low 
Low, High and High High. The Low alarm can be set to give a warning 

that the concentration of the gas is dropping below the normal level. 
The Low Low alarm can then be configured to give a warning 

whenever the gas concentration drops below the lowest allowable 
concentration. The High and the High High alarm levels are set to 

give a warning for a concentration above a certain limit and that the 
maximum allowable concentration is exceeded. 
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To set up an alarm first select between the four mentioned alarms, 
select concentration unit, and then type in the concentration, se 

Figure 3.31. 
 

 
Figure 3.31 Select a type of alarm and type in a value for the gas 

concentration 
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When the alarms have been configured choose whether there should 
be a PC beep when the alarm level is reached. Press Add soft-key to 

add the configured alarms and then OK to proceed. (See Figure 3.32) 
 

 
Figure 3.32 Press Add soft-key to add the configured alarms 

 

To remove a gas from the alarm list highlight the gas using a mouse 

click and press the Remove soft-key. (See Figure 3.32) 
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3.3.5 Units 
  
Select Unit in the Set Up drop down menu. (See Figure 3.33) 

 

 
Figure 3.33 Set Up pull-down: Unit 

 

 
Figure 3.34 Select in which units the data should be displayed 

 

In this window the user can select in which units Humidity, Pressure, 
Gas Concentration, Temperature and Length will be shown. The 

Normalization Temperature can also be changed. The normalization 
temperature is the reference temperature, for reporting data in 

absolute unit mg/m3. A normalization temperature of 25°C means 
that the measured gas concentrations will be calculated in mg/m3 at 

25°C. The user can choose between three different normalization 
temperatures, see table 3.2. 

 
Display Text Options Default 

Value 

NORMALIZATION TEMPERATURE 0°C, 20°C and 25°C 20°C 

NORMALIZATION TEMPERATURE 32°F, 68°F and 77°F 68°F 

NORMALIZATION TEMPERATURE 273K, 293K and 298K 293K 

Table 3.2 The possible values and the default values of the 

normalization temperature 
 



Chapter 3 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 54 of 215 

 

3.4 Special Parameters 
 

If you select the Special Parameters file menu (see Figure 3.35) it is 

possible to setup special parameters (see Figure 3.36).  
 

 

 
Figure 3.35 File pull-down: Special Parameters 

 

 

 

Figure 3.36 The Special Parameters window 

 
 

If you tick the Red background color when not measuring option 

the numerical windows (4.2) and the graphical windows (4.3) will have a 
red background color, when measurement has not been started. This is 

to clearly signal to the operator, that the measurement has not been 

started. 
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If you tick the Disable Numeric Setup in Excel Gas View (Export 
Task -> Selected Channel/Gas Excel Sheet) the Numeric Setup will not 

be inserted into the Channel/Gas Excel sheet (see Section 4.5.2). This is 
possible in order to be compatible with older versions of the LumaSoft 

Gas 7880 application. This setting is not relevant for the LumaSoft Gas 
7820 application, as the 7880 only can make the Channel/Gas Excel 

sheet. 
 

If you tick the Country Specific date & time in Excel Files then the 
date & time stamp of the measurements in the exported  Excel files (see 

Section 4.5), will be generated according to the country setting in 
Windows, rather than the default application setting. 

 
All these settings will be retained when restarting the LumaSoft Gas 

application. 
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This chapter shows how to 
 

- Perform a measurement task. (Section 4.1) 
- Present the measurement data in graphic display (Channel view). 

(Section 4.2.1) 
- Present the measurement data in graphic display (Gas view). (Section 

4.2.2) 
- Present the measurement data in numeric display. (Section 4.3) 

- Set user events. (Sections 4.2.1.7{Channel view}, 4.2.2.8{Gas view} 
and 4.3.3) 

- Print graphic and numeric displays. (Sections 4.2.1.8{Channel view}, 
4.2.2.9{Gas view} and 4.3.4) 

- Display historical data. (Section 4.2.1.9{Channel view}, 4.2.2.10{Gas 
view} 

- View alarms. (Section 4.4) 

- Export measurement data. (Section 4.5) 
- View error and warnings. (Section 4.6) 

- Export log (Section 4.7) 
 

4.1 Measurement start and stop 
 

If a measurement task is not open, select File and Open Task, see 

Figure 4.1 or select  from the task bar. 
 

 
Figure 4.1 File pull-down: Open Task 
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Select an existing task to open, see Figure 4.2  

 
Figure 4.2 Select which task to open 

 

4.1.1 Start Measurement 
 

To start the measurement, select Measurement and Start, see Figure 

4.3, or press the icon with the green arrow  in the task bar.  

 

 
Figure 4.3 Measurement pull-down: Start 

 

The measurement can be started immediately (Now option) or at a 
specific starting time by using the option: Start at, see Figure 4.4. 

 

 
Figure 4.4 Start and stop measurement task 

 

The measurement can be stopped manually (Manual option) or at a 
fixed time using the Stop at option. (See Figure 4.4) 

 
A measurement task can be stopped and then restarted at your 

convenience. 
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4.1.2 Stop Measurement 
 

To stop the measurement, select Measurement and Stop, see Figure 

4.5, or press the  icon in the task bar. 

 

 
Figure 4.5 Measurement pull-down: Stop 

 

4.2 Presentation of Data in Graphical Window 
 

The measurement data can be presented graphically in two different 
ways either channel-wise or gas-wise. 

 
If measurement data is presented channel-wise the gas filters is shown 

in a graphical view for each channel. Proceed to Section 4.2.1 for 
presentation of graphical data channel-wise. 

 
If measurement data is presented gas-wise the multiplexer channels is 

shown in a graphical view for each gas filter. Proceed to Section 4.2.2 
for presentation of graphical data Gas View. 

 

 

4.2.1 Presentation of Data in Graphical Window Channel-
View 

 
To display measurement data graphically channel-wise select Graphical 

Window>Single Channel with Selected Gases View in the View 
pull-down menu. (See Figure 4.6) 

 

 
Figure 4.6 View pull-down: Graphical Window>Single Channel with 

Selected Gases View 
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4.2.1.1 Configuration of the (Channel-View) graphical 

window  
 

In the Configuration window select if the data should be presented as 
a Real Time Graph, while measurement is in progress, or Historical 

Graph, see Figure 4.7. 
 

 
Figure 4.7 Select if the data should be presented in real time or historic 

 
Real Time Graph means that measurement data will be plotted as they 

arrive from the Monitor. 
Historical Graph means viewing of previously measured data 

 
Select Real Time Graph and press Next to continue. 
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4.2.1.2 Select Gases (Channel view) 
 

In the gas Configuration window, see Figure 4.8, select which of the 
measured gases to be included in the Graph and press the right going 

arrow. 
 

 
Figure 4.8 Select which gasses to be presented 

 
To select more gasses at one time press Ctrl while selecting. When the 

gases have been chosen they will appear in the right window, see Figure 
4.9. Press Next to proceed. 

 

 
Figure 4.9 The gasses chosen for presentation 
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4.2.1.3 Configuration of curves (Channel view) 
 

CurveColor 
 

Each of the filters has a default selected curve color, see Figure 4.10. 
 

To change the color of the curves press the colored square in the 

CurveColor column. 
 

 
Figure 4.10 Change the color of the curves 

 

Select a color for the curve in the Color window, see Figure 4.11. 
 

 
Figure 4.11 Select a color for the curve 

 

Repeat the procedure for all the gasses. 
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PointStyle 
 

It is possible to change the style of the plotted measuring points to 
Square or Circle using the field selection in the Point Style column. 

 

 
Figure 4.12 Change the style of the measurement points 

 

Scaling 
 

The scaling on the Y-axis can be set to AutoScaleMinAndMax, 
AutoScaleMax or AutoScaleOff in the field selection individually for 

each filter in the Scaling column. The possible scaling types are 
described in Table 4.1. 

 

 
Figure 4.13 Setting the scaling of the axis 

 



Chapter 4 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 64 of 215 

 

AutoScaleMinAndMax The scale will cover from 

the lowest measurement 
value to the highest 

measured value, i.e. all 
measurement points will 

be visible on the graph. 

AutoScaleMax The Y-axis will begin at 

0 and the maximum 
value depends on the 

highest measured value. 

AutoScaleOff The user defines both 
minimum and maximum 

values for the Y scale 
manually, by defining 

YScalemin and 
YScaleMax. This can be 

of use to view 
measurement points in a 

particular range. 

Table 4.1 Shows the possible Scaling types of the Y-axis 
 

Units 
 

In the Unit column the unit in which each gas will be displayed in the 
graphical window can be selected. 

 

 
Figure 4.14 Select the unit in which the gas concentrations will be 

displayed 

 
Table 4.2 shows the possible parameter units and their default settings. 
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Paramet

ers 
Units 

Defaul
t Unit 

Humidity 
  mg/m3, ppm, Tdew, 

kPa 
Tdew 

 Pressure mbar, mmHg, kPa kPa 

Gas 
Concentr

ations 
mg/m3, ppm ppm 

Table 4.2 The possible parameter units with defaults 

 
Tension 

 

By adjusting the Tension it is defined how soft/hard the lines between 
the measuring points should be. If the tension is set to 0 the points are 

connected by straight lines. 
 

 
Figure 4.15 Define how hard/soft the lines between measurement points 

should be 
 

When all the settings has been adjusted press Next to proceed.  
 

4.2.1.4 Configuration of the Graph Window (Channel view) 
 
In this configuration window the trend properties are configured. The 

trend can be given a title by entering a name in the Graph Title field. 
(See Figure 4.16). 
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Figure 4.16 Configuration of graph window properties 

 

The number of decimals on the measured values can be selected in the 

field selection: Y Axis Decimal places. 

The time interval (X Interval) on the X-axis can be set to days, hours, 
minutes or seconds. 

 
Back Color, Cursor Color, Text Color and Font etc. can be changed 

by pressing the appropriate grey squares. 
 

Gradient Mode gives a shading of a dark background color. 
 

Grid Visible turns on/off the grid. 
 

User Events turns on/off the display of user events (see Section 
4.2.1.7). 

 
In the Rolling Average group box the calculation and display of 

averaged values rather than instantaneous values can be Enabled. The 

Minutes setting determines how long back in time the rolling averaged 
value should be calculated. Up to 1440 minutes (24 hours) is allowed. 

Please note when changing the Rolling Average setting during a real 
time measurement session, only the new incoming values will calculated 

with the changed setting.  
When displaying historical measurement data all values will be 

presented with the selected Rolling Average setting. Historical data 
plotting is described in Section 4.2.1.9. 

 
 

Press Finish when the configuration is completed. 
 



Chapter 4 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 67 of 215 

 
Figure 4.17 The graphical window (Channel View) 

 
Changing the configuration 

 
To change any of the above settings after the configuration is ended 

press the right mouse button while the cursor is placed in the graph 
area. Select Setup (see Figure 4.18) and the Configuration window 

will appear, see Figure 4.10 and Figure 4.16. 
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Figure 4.18 To change the configuration in the graphical window press 

the right button on the mouse 
 

To add a curve for a measured gas, which has not been previously 
added, press the right mouse button while the cursor is placed in the 

graph area and select AddTag. (See Figure 4.18) 

 

4.2.1.5 The Graphical Window (Channel view) 
 

The graphic window shows the measurement data in a graph. Each filter 

in the Monitor has its own axis on the graph, see Figure 4.18. Below the 
graph a window containing a list of the measured gases, and statistics 

performed from all obtained measurement data (Min, Max, Mean and 
Std. Deviation) is shown. The bottom window is the Error and 

Warnings and Alarm window. The number of curves displayed, their 
color and style are defined by the user as described in Section 4.2.1.1, 

Section 4.2.1.2, Section 4.2.1.3 and Section 4.2.1.4. 
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The user can toggle between the Errors/Warnings, Measurement 
Errors/Warnings and Measurement Alarm windows. The 

Errors/Warnings window will register if any errors have occurred while 
running the measurement. The window can be hidden by pressing Auto 

Hide  icon, or by selecting Errors/Warnings Window in the View 
drop down menu, see Figure 4.19. 

 

 
Figure 4.19 View pull-down: Errors/Warnings Window 

 
 

4.2.1.6 Functions in the Graphical Window (Channel view) 
 

In the top of the Graphical window the Icon Tool Bar is displayed. 

 

 
 

The tool bar makes it easier to handle and process the obtained 
measurement data. 

 
The function behind each icon will be explained in the following section. 

 

Find Difference  
 

The function h, will calculate the difference in the value for two data 

points on the same filter curve. Press the  icon and then select the 

two data points with mouse clicks. In the top right corner the difference 
between the two measurements will be displayed, see Figure 4.20. 
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Figure 4.20 Select two measurement points on the same curve to get 

the difference in concentration 
 

Historical Data Plotting  
 

Historical data plotting is described in Section 4.2.1.9. 
 

X Delta Cursor  

 

Press the X Delta Cursor  icon and select two points to determine 

the difference in time. A light red area will appear between the two 

points and the time difference will be displayed, see Figure 4.21. When 
using this function the statistics shown in the middle window are 

calculated for the measurement points within the chosen interval and 
will be marked with red text color, see Figure 4.21. 
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Figure 4.21 Select two measurement points in the graphic window to get 

the difference in time 

 

Y Delta Cursor  

 

Press the Y Delta Cursor  icon and select two points where the 

difference in concentration is needed. A green area will appear between 
the two points and the min and max value in concentration will be 

displayed, see Figure 4.22. 
 

By double-clicking on a Gas Name in the middle window it is selected 

for which Gas the min and max concentrations is displayed. 
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Figure 4.22 Select two measurement points in the graphic window to get 

the min and max concentrations 

 

Cursor On/Off  

 

The Cursor function  will give the user opportunity to see the exact 
measurement values for any given measurement point. Drag the cursor 

to a specific measurement point and the values will be displayed in 
colored boxes, see Figure 4.23. 
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Figure 4.23 Drag the cursor to the measurement point to view the 

measurement data 
 

Delete Delta Cursor  

 

A X or Y Delta Cursor can be deleted by pressing this icon . The 

window below will appear and the desired cursor can be selected and 
deleted by pressing Delete, see Figure 4.24. 

 

 
Figure 4.24 Select the cursor which should be deleted and press Delete 
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Zoom     

 
This function enables the user to zoom in and out on areas of particular 

interest on the graph by using the two icons: Zoom In  and Zoom 

Out . 

 

Scroll     

 
If a measurement is running over a longer period of time, these icons 

can be used to scroll the x axis forth  or  and back  or . 

 

Expand/Compress   
 

These two icons can be used to expand and compress the x-axis. This 

function can be used to get a better visibility of measurement points 
lying very close to each other. 

 

Start/Pause measurement   
 

These two icons allow the user to start  and pause  the display of 

new measurements points at any time. 

 
Select Channel 

 
This select field box enables switching between the channels on the 

1409 which are used to draw air samples, allowing viewing all obtained 
measurement data for a specific channel, see Figure 4.25. 

 

 
 
By ticking the Generate Export Image for this Channel, you store a 

snapshot image of the graph for the selected channel. The stored 
snapshot image will then be added as a tab, when making an export 

task (channel view) into an Excel file (see 4.5.1).  
 

The look of the Export Image will be as shown in Figure 4.29. .  

 
You can make individual snapshot images for each of the available 

channels, where each snapshot image will then be added as individual 
tabs in the exported Excel file. 

 
The snapshot image can be removed again by unticking the Generate 

Export Image for this Channel. 
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Figure 4.25 Select a channel number in the select field box 

 

4.2.1.7 User Events in the graphical window (Channel view) 
 

If an event occurs or a changed condition happened during a 
measurement task, it is possible to indicate this event by using the User 

Event function. 
 

To insert a user event press the right mouse button while placing the 
cursor on the measurement point where the event should be added and 

select Add UserEvent, see Figure 4.26. 
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Figure 4.26 Insert User Event by pressing the right mouse button. 

 

The following window, see Figure 4.27, will appear to add a comment to 
be displayed for this specific user event. 

 

 
Figure 4.27 Add a comment to be displayed for the user event 

 

Press OK to proceed. The user event which has been set up will be 

shown as an envelope  right beside the measurement point, to which 

it belongs. 
 

To display a user event set the cursor at the envelope. 
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A user event can be updated or deleted by pressing the right mouse 
button while placing the cursor on the envelope and selecting either 

Update UserEvent or Delete UserEvent. 
 

4.2.1.8 Printing the graphical window (Channel view) 
 

The graphical window can be output to a printer by right-clicking with 
the mouse button anywhere inside the graphical window to get the 

print-menu. 
 

Select either Print or Print Preview, see Figure 4.28. 
 

The Print option will make a printer output and the Print Preview will 
make a screen view of the printout. 

 

 
Figure 4.28 Printing the Graphical window(Channel view) 
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The printout contain the curves and a footer with task name, monitor 
type and serial number, channel number, information about the task 

setup, statistical data, see Figure 4.29. 
 

 

Figure 4.29 Print preview of the Graphical window (Channel view) 
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4.2.1.9 Displaying historical data (Channel view) 

 
Open an existing task by selecting Open Task or Open Task Offline in 
the File drop down menu, see Figure 4.30. The Open Task Offline 

allows opening a task without a Monitor connected. 
 

 
Figure 4.30 File menu: Open Task/Open Task Offline 

 

The desired task can be opened, see Figure 4.31. 
 

 
Figure 4.31 Open Task list. 

 
By selecting Task Contents in the File pull-down menu, see Figure 

4.32, active filters and start/stop time is displayed, see Figure 4.33. 
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Figure 4.32 File menu: Task Contents. 

 

 
Figure 4.33 Contents window 

 
The historical data can be displayed by selecting Graphical 

Window>Single Channel with Selected Gases View in the View 
drop down menu, see Figure 4.34, then press the Historical Data 

Plotting icon . 

 

 
Figure 4.34 View menu: Graphical Window>Single Channel with 

Selected Gases View 
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A specific time interval can be selected by entering date and time in the 
two fields: From Date and To Date, see Figure 4.35. 

 

 
Figure 4.35 Select time interval for historic data plotting. 

 

Click OK to display the historical data in a graph. 
 

The functions of the icons in the historical window are the same as in 
the Real Time Window described in Section 4.2.1.6. 

 
To continue the measurements performed in the specific task, press the 

green arrow icon  or select Start in the Measurement drop down 

menu, see Figure 4.3. 

 

To display the incoming measuring data (real time data) select the  
icon. 

 

4.2.2 Presentation of Data in Graphical Window Gas-View 
 

To display measurement data graphically channel-wise select Graphical 
Window>Single Gas with Selected Channel View in the View pull-

down menu. (See Figure 4.36) 
 

 
Figure 4.36 View pull-down: Graphical Window>Single Gas with 

Selected Channel View 
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4.2.2.1 Configuration of the (Gas-View) graphical window  
 

In the Configuration window select if the data should be presented as 
a Real Time Graph, while measurement is in progress, or Historical 

Graph, see Figure 4.37. 
 

 
Figure 4.37 Select if the data should be presented in real time or historic 

 
Real Time Graph means that measurement data will be plotted as they 

arrive from the Monitor. 
Historical Graph means viewing of previously measured data 

 
Select Real Time Graph and press Next to continue. 
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4.2.2.2 Select Channels (Gas view) 
 

In the channel Configuration window, see Figure 4.38, select which of 
the channels to be included in the Graph and press the right going 

arrow. 
 

 
Figure 4.38 Select which channels to be presented 

 

To select more channels at one time press Ctrl while selecting. When the 
channels have been chosen they will appear in the right window, see 

Figure 4.39. Press Next to proceed. 
 

 
Figure 4.39 The channels chosen for presentation 
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4.2.2.3 Configuration of curves (Gas view) 
 

CurveColor 
 

Each of the channels has a default selected curve color, see Figure 4.40. 
 

To change the color of the channel press the colored square in the 

CurveColor column. 
 

 
Figure 4.40 Change the color of the curves 

 
Select a color for the curve in the Color window, see Figure 4.41. 

 

 
Figure 4.41 Select a color for the curve 

 
Repeat the procedure for all the gasses. 
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PointStyle 
 

It is possible to change the style of the plotted measuring points to 
Square or Circle using the field selection in the Point Style column. 

 

 
Figure 4.42 Change the style of the measurement points 

 

Tension 
 

By adjusting the Tension it is defined how soft/hard the lines between 
the measuring points should be. If the tension is set to 0 the points are 

connected by straight lines. 
 

 
Figure 4.43 Define how hard/soft the lines between measurement points 

should be 
 

When all the settings has been adjusted press Next to proceed.  
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4.2.2.4 Configuration of filters (Gas view) 
 

 
Scaling 

 
The scaling on the Y-axis can be set to AutoScaleMinAndMax, 

AutoScaleMax or AutoScaleOff in the field selection individually for 

each filter in the Scaling column. The possible scaling types are 
described in Table 4.3. 

 

 
Figure 4.44 Setting the scaling of the axis 

 

 

AutoScaleMinAndMax The scale will cover from 
the lowest measurement 

value to the highest 

measured value, i.e. all 
measurement points will 

be visible on the graph. 

AutoScaleMax The Y-axis will begin at 

0 and the maximum 
value depends on the 

highest measured value. 

AutoScaleOff The user defines both 
minimum and maximum 

values for the Y scale 
manually, by defining 

YScalemin and 
YScaleMax. This can be 

of use to view 
measurement points in a 

particular range. 

Table 4.3 Shows the possible Scaling types of the Y-axis 
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Units 

 
In the Unit column the unit in which each gas will be displayed in the 

graphical window can be selected. 
 

 
Figure 4.45 Select the unit in which the gas concentrations will be 

displayed 

 
Table 4.4 shows the possible parameter units and their default settings. 

 
Paramet

ers 
Units 

Defaul
t Unit 

Humidity 
  mg/m3, ppm, Tdew, 

kPa 
Tdew 

 Pressure mbar, mmHg, kPa kPa 

Gas 
Concentr

ations 

mg/m3, ppm ppm 

Table 4.4 The possible parameter units with defaults 
 

When all the settings has been adjusted press Next to proceed.  
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4.2.2.5 Configuration of the Graph Window (Gas view) 
 

In this configuration window the trend properties are configured. The 

trend can be given a title by entering a name in the Graph Title field. 
(See Figure 4.46). 

 

 
Figure 4.46 Configuration of graph window properties 

 

The number of decimals on the measured values can be selected in the 

field selection: Y Axis Decimal places. 
The time interval (X Interval) on the X-axis can be set to days, hours, 

minutes or seconds. 
 

Back Color, Cursor Color, Text Color and Font etc. can be changed 

by pressing the appropriate grey squares. 
 

Gradient Mode gives a shading of a dark background color. 
 

Grid Visible turns on/off the grid. 
 

User Events turns on/off the display of user events (see Section 
4.2.2.7). 

 
In the Rolling Average group box the calculation and display of 

averaged values rather than instantaneous values can be Enabled. The 
Minutes setting determines how long back in time the rolling averaged 

value should be calculated. Up to 1440 minutes (24 hours) is allowed. 
Please note when changing the Rolling Average setting during a real 

time measurement session, only the new incoming values will calculated 

with the changed setting. When displaying historical measurement data 
all values will be presented with the selected Rolling Average setting. 
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When displaying historical measurement data all values will be 
presented with the selected Rolling Average setting. Historical data 

plotting is described in Section 4.2.2.10. 
 

 
Press Finish when the configuration is completed. 

 
 

 
Figure 4.47 The graphical window (Gas View) 

 

Changing the configuration 
 

To change any of the above settings after the configuration is ended 
press the right mouse button while the cursor is placed in the graph 

area. Select Setup (see Figure 4.48) and the Configuration window 

will appear, see Figure 4.40. 
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Figure 4.48 To change the configuration in the graphical window(Gas 

View) press the right button on the mouse 
 

To change (add or remove) the selected channels, press the right mouse 
button while the cursor is placed in the graph area and select AddTag. 

(See Figure 4.48) 

 

4.2.2.6 The Graphical Window (Gas view) 
 

The graphic window shows the measurement data in a graph. Each filter 

in the Monitor has its own axis on the graph, see Figure 4.18. Below the 
graph a window containing a list of the measured gases, and statistics 

performed from all obtained measurement data (Min, Max, Mean and 
Std. Deviation) is shown. The bottom window is the Error and 

Warnings and Alarm window. The number of curves displayed, their 
color and style are defined by the user as described in Section 4.2.2.1, 

Section 4.2.2.2, Section 4.2.2.3 and Section 4.2.2.4. 

 
The user can toggle between the Errors/Warnings, Measurement 

Errors/Warnings and Measurement Alarm windows. The 
Errors/Warnings window will register if any errors have occurred while 

running the measurement. The window can be hidden by pressing Auto 
Hide  icon, or by selecting Errors/Warnings Window in the View 

drop down menu, see Figure 4.49. 
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Figure 4.49 View pull-down: Errors/Warnings Window 

 

 

4.2.2.7 Functions in the Graphical Window (Gas View) 
 

In the top of the Graphical window the Icon Tool Bar is displayed. 
 

 
 
The tool bar makes it easier to handle and process the obtained 

measurement data. 
 

The function behind each icon will be explained in the following section. 

 
Find Difference  

 
The function h, will calculate the difference in the value for two data 

points on the same filter curve. Press the  icon and then select the 
two data points with mouse clicks. In the top right corner the difference 

between the two measurements will be displayed, see Figure 4.50. 
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Figure 4.50 Select two measurement points on the same curve to get 

the difference in concentration 

 

Historical Data Plotting  
 

Historical data plotting is described in Section 4.2.2.10. 
 

X Delta Cursor  
 

Press the X Delta Cursor  icon and select two points to determine 

the difference in time. A light red area will appear between the two 
points and the time difference will be displayed, see Figure 4.52. When 

using this function the statistics shown in the middle window are 
calculated for the measurement points within the chosen interval and 

will be marked with red text color, see Figure 4.51. 
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Figure 4.51 Select two measurement points in the graphic window to get 

the difference in time 
 

Y Delta Cursor  
 

Press the Y Delta Cursor  icon and select two points where the 

difference in concentration is needed. A green area will appear between 
the two points and the min and max value in concentration will be 

displayed, see Figure 4.52. 
 

By double-clicking on a Channel in the middle window it is selected for 
which Gas the min and max concentrations is displayed. 
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Figure 4.52 Select two measurement points in the graphic window to get 

the min and max concentrations 
 

Cursor On/Off  

 

The Cursor function  will give the user opportunity to see the exact 
measurement values for any given measurement point. Drag the cursor 

to a specific measurement point and the values will be displayed in 
colored boxes, see Figure 4.53. 
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Figure 4.53 Drag the cursor to the measurement point to view the 

measurement data 
 

Delete Delta Cursor  

 

A X or Y Delta Cursor can be deleted by pressing this icon . The 

window below will appear and the desired cursor can be selected and 
deleted by pressing Delete, see Figure 4.54. 

 

 
Figure 4.54 Select the cursor which should be deleted and press Delete 

 

Zoom     

 

This function enables the user to zoom in and out on areas of particular 

interest on the graph by using the two icons: Zoom In  and Zoom 

Out . 
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Scroll     
 

If a measurement is running over a longer period of time, these icons 

can be used to scroll the x axis forth  or  and back  or . 

 

Expand/Compress   

 
These two icons can be used to expand and compress the x-axis. This 

function can be used to get a better visibility of measurement points 

lying very close to each other. 
 

Start/Pause measurement   

 

These two icons allow the user to start  and pause  the display of 

new measurements points at any time. 
 

Select Gas 
 

This select field box enables switching between the gasses, allowing 
viewing all obtained measurement data for a specific gas, see Figure 

4.55. 
 

 
 
By ticking the Generate Export Image for this Gas, you store a 

snapshot image of the graph for the selected gas. The stored snapshot 
image will then be added as a tab, when making an export task (gas 

view) into an Excel file (see 4.5.2).  
 

The look of the Export Image will be as shown in Figure 4.59.  

 
You can make individual snapshot images for each of the available 

gasses, where each snapshot image will then be added as individual 
tabs in the exported Excel file. 

 
The snapshot image can be removed again by unticking the Generate 

Export Image for this Gas. 
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Figure 4.55 Select a gas in the select field box 

 

4.2.2.8 User Events in the graphical window (Gas view) 
 

If an event occurs or a changed condition happened during a 

measurement task, it is possible to indicate this event by using the User 
Event function. 

 
To insert a user event press the right mouse button while placing the 

cursor on the measurement point where the event should be added and 
select Add UserEvent, see Figure 4.56. 
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Figure 4.56 Insert User Event by pressing the right mouse button. 

 

The following window, see Figure 4.57, will appear to add a comment to 
be displayed for this specific user event. 

 

 
Figure 4.57 Add a comment to be displayed for the user event 

 

Press OK to proceed. The user event which has been set up will be 

shown as an envelope  right beside the measurement point, to which 

it belongs. 

 
To display a user event set the cursor at the envelope. 

 
A user event can be updated or deleted by pressing the right mouse 

button while placing the cursor on the envelope and selecting either 
Update UserEvent or Delete UserEvent. 
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4.2.2.9 Printing the graphical window (Gas view) 
 

The graphical window can be output to a printer by right-clicking with 
the mouse button anywhere inside the graphical window to get the 

print-menu. 
 

Select either Print or Print Preview, see Figure 4.58. 
 

The Print option will make a printer output and the Print Preview will 
make a screen view of the printout. 

 

 
Figure 4.58 Printing the Graphical window (Gas view) 

 

The printout contain the curves and footer with task name, monitor type 
and serial number, channel number, information about the task setup, 

statistical data, see Figure 4.59. 
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Figure 4.59 Print preview of the Graphical window(Gas view) 
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4.2.2.10 Displaying historical data (Gas view) 

 
Open an existing task by selecting Open Task or Open Task Offline in 
the File drop down menu, see Figure 4.60. The Open Task Offline 

allows opening a task without a Monitor connected. 
 

 
Figure 4.60 File menu: Open Task/Open Task Offline 

 

The desired task can be opened, see Figure 4.61. 

 

 
Figure 4.61 Open Task list. 

 

By selecting Task Contents in the File pull-down menu, see Figure 
4.62, active filters and start/stop time is displayed, see Figure 4.63. 
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Figure 4.62 File menu: Task Contents. 

 

 
Figure 4.63 Contents window 

 
The historical data can be displayed by selecting Graphical 

Window>Single Gas with Selected Channel View in the View drop 
down menu, see Figure 4.64, then press the Historical Data Plotting 

icon . 

 

 
Figure 4.64 View menu: Graphical Window>Single Gas with Selected 

Channel View 
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A specific time interval can be selected by entering date and time in the 
two fields: From Date and To Date, see Figure 4.65. 

 

 
Figure 4.65 Select time interval for historic data plotting. 

 

Click OK to display the historical data in a graph. 
 

The functions of the icons in the historical window are the same as in 
the Real Time Window described in Section 4.2.2.7. 

 
To continue the measurements performed in the specific task, press the 

green arrow icon  or select Start in the Measurement drop down 

menu, see Figure 4.3. 

 

To display the incoming measuring data (real time data) select the  
icon. 

 

4.3 Presentation of Data in the Numeric Window 
 

To display measurement data numeric select Numeric Window in the 

View pull-down menu.  
 

 
Figure 4.66 View pull-down: Numeric Window 
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4.3.1 Configuration of the Numeric Window 

 
The Numeric Window Properties consists of two Index cards: 

Interval and Columns, see Figure 4.67. 
 

 
Figure 4.67 Numeric Window Properties 

   
Interval Index Card 

 
Type in a title for the numeric window in the Window Title box, see 

Figure 4.67. 

 
Choose which time interval on a specific date that should be included in 

the numeric window. This option enables to define the column length as 
a period of time. 

 
Also the number of decimal places for concentration and pressure values 

can be selected. 
 

In the Rolling Average group box the calculation and display of 
averaged values rather than instantaneous values can be Enabled. The 

Minutes setting determines how long back in time the rolling averaged 
value should be calculated. Up to 1440 minutes (24 hours) is allowed. 
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Columns Index Card 
 

Define which component’s parameters are displayed in the numeric 
window. 

 

 
Figure 4.68 Column Index Card 

 

In the Single Column Setup select the gases which should be 
displayed and their units, see Figure 4.68. 

 
Select parameter: by clicking in this field, the names of all the gases 

and atmospheric pressure measured during this monitoring task are 
displayed. The gases and pressure are selected individually, see Figure 

4.69. 
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Figure 4.69 Select which gases should be displayed 

 

Select unit: this enables to display the desired unit for each gas and for 
the atmospheric pressure. Click in the select unit field, and the available 

units for this parameter will be displayed. 
 

 
Figure 4.70 Select the units in which the concentration should be 

displayed 
 

Press Add after each selected parameter, see Figure 4.71. To insert the 
second parameter before the first press Add Before. It is also possible 

to remove a selected parameter by pressing Remove. 
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Figure 4.71 The selected gases are shown in the All Columns field 

 

For convenience it is possible to add all the filter parameters using the 
Add All soft-key, see Figure 4.72. 

 

 
Figure 4.72 All filter parameters added with the Add All soft-key 

 

In the All Columns field all component parameters to be displayed in 
the numeric window must appear. Note that if a parameter already 
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appears here, but you want to edit the units, then you must remove the 
existing parameter and add it again with the changed unit. 

 
When all the parameters, which should be displayed in the numeric 

window, have been selected, press OK to proceed. 
 

The numeric window is shown, see Figure 4.73. 
 

 
Figure 4.73 The numeric window 

 

4.3.2 The Numeric Window 
 

In the top of the numeric window the serial number for the Monitor and 

other settings are shown. 
 

This window can display all the measurement data, simultaneously. Gas 
measurement data are displayed as instantaneous values. If any events 

have been added during the monitoring task, these are also displayed 
here. How to generate user events is explained in Section 4.3.3. 

 
The latest measurement results are always displayed at the bottom of 

the column, previous measurement data roll upwards, disappearing 

from the view at the top of the column when the defined interval is full. 
 

The Error and Warnings window will register if any errors have occurred 
while running the measurement. The window can be hidden by pressing 
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Auto Hide  icon or by selecting Errors/Warnings Window in the 
View drop down menu, see Figure 4.74. 

 

 
Figure 4.74 View menu: Errors/Warnings Window 

 

4.3.3 User Events in the numeric window 
 

If an event occurs or some conditions are changed during a 

measurement task it is possible to indicate this event by using the User 
Event function.  

 
To insert a user event press the right mouse button while placing the 

cursor on the measurement point where the event should be added and 
then select Add User Event, see Figure 4.75. 
 

 

Figure 4.75 To add a User Event 
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The following window will appear, see Figure 4.76. Add a comment 
which will be displayed for this specific user event. 

 

 
Figure 4.76 Add a comment to be displayed for the user event 

 

Press OK to proceed. The user event which has been set up will be 

shown next to the measurement point, to which it belongs (here the 
user event “window open” has been added, see Figure 4.77. 

 

 
Figure 4.77 The User Event “Window open” has been added to a 

measurement point 

 
An user event can be edited or deleted by pressing the right mouse 

button while placing the cursor on the event and selecting either Edit 
User Event or Delete User Event, see Figure 4.78. 
 



Chapter 4 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 111 of 215 

 
Figure 4.78 Edit or delete an User Event 
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4.3.4 Printing the numeric window 
 

The numeric window can be output to a printer by selecting either the 
Print or the Print Preview button, see Figure 4.79. 

 
The Print option will make a printer output and the Print Preview will 

make a screen view of the printout. 

 

 
Figure 4.79 Printing the numeric window 

 

 

The printout contain the numeric data and a header with task name, 
monitor type and serial number, channel number, information about the 

task setup, see Figure 4.80. 
 

The printout can expand to more pages if the measurement data does 

not fit one page. 
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Figure 4.80 Print preview of the Numeric window 
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4.4 View Measurement alarms 
 

A description of measurement alarms can be found in Section 3.2.4. 

 
To show the alarms in the numeric window check the tick box Show 

Alarm,   refer to Figure 4.81. 
 

An extra Alarm column for every filter is then shown.  
 

If an alarm occurred for a measured value it is shown as either High, 

High High, Low or Low Low in the Alarm column, see Figure 4.81.  
 

 
Figure 4.81 Alarms shown in numeric display 

 
 

The Measurement Alarms view can be switched on/off by using the 

View menu pull-down Alarms Window, see Figure 4.82. 
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Figure 4.82 View pull-down: Alarms Window 

 

The Measurement Alarms view shows the latest occurred software 
alarms, see Figure 4.83. 

 

Figure 4.83 The Measurement Alarms view 

 
Each alarm is date and time stamped, with channel number, Gas and 

filter name, measured value and Alarm type. 
 

The Sr No. check box gives the user the opportunity to acknowledge an 
alarm. 

 

4.5 Export Task 
 

During or after measurement all the current measurements can be 
exported to Microsoft Excel file format. This gives the opportunity to do 

custom data processing on the measurement data, like calculation, 
presentation in table or graph format. 

 
Two types exports are available, either channel-wise (see Section 4.5.1) 

or gas-wise (see Section 4.5.2). 

 
Please note that Microsoft Office must be installed for the export 

task functionality to work. 
 

4.5.1 Export Task (Channel view) 
 

The measurement data export can be initiated by using the File menu 

pull-down Export Task>Select Gases/Channel Excel sheet, see 
Figure 4.84. 
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Figure 4.84 File pull-down: Export Task>Select Gases/Channel Excel 

sheet 

 
Select the channels for which measurements data is to be exported, see 

Figure 4.85. Optionally the measurement data values can be calculated 
using the Rolling Average setting. Up to 1440 minutes (24 hours) is 

allowed. 
 

 
Figure 4.85 Export measurements to Excel format 

 
Select the directory where the Excel format file should be stored, see 

Figure 4.86. The default Excel file name is the name of the current task, 
which can be altered if desired. 
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Figure 4.86 Export Excel file dialogue 

 
When the export is finished press Close, see Figure 4.85. 

 
The export Excel workbook file consists of several tabs. 

 
The first tab shows the setup of the Monitor, see Figure 4.87. 

 

 
Figure 4.87 Monitor setup 
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The following tabs shows the measurement data for each of the 
channels, see Figure 4.88. 

 
Each measurement is time stamped. 

 

 
Figure 4.88 Channel measurement data in Excel. 

 

The Excel Chart wizard can be used to generate for instance a line graph 
as shown in Figure 4.89. 

 

 
Figure 4.89 Channel measurement data in Excel with graph. 
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If  has been ticked, the ticked channel graph 
snapshot will be added as a tab in the export Excel workbook file. All 

ticked channels will appear as different tabs. 
 

 
Figure 4.90 Channel graph snapshot 

 in Excel 

 

4.5.2 Export Task (Gas view) 
 

The measurement data export can be initiated by using the File menu 

pull-down Export Task>Select Channel/Gas Excel Sheet, see Figure 
4.90. 

 

 
Figure 4.91 File pull-down: Export Task>Select Channel/Gas Excel Sheet 

 
Select the gases for which measurements data is to be exported, see 

Figure 4.92. Optionally the measurement data values can be calculated 

using the Rolling Average setting. Up to 1440 minutes (24 hours) is 
allowed. 
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Figure 4.92 Export measurements to Excel format 

 

Select the directory where the Excel format file should be stored, see 
Figure 4.93. The default Excel file name is the name of the current task, 

which can be altered if desired. 

 

 
Figure 4.93 Export Excel file dialogue 

 
When the export is finished press Close, see Figure 4.92. 
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The first tab shows the setup of the Monitor, see Figure 4.94a. 
 

   
Figure 4.94a The ‘Monitor Setup’ tab 

 

The export Excel workbook file consists of a tab for each gas, see Figure 
4.94b. 

 
Each measurement is time stamped. 

 

 
Figure 4.94b Gas measurement data in Excel. 
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The Excel Chart wizard can now be used to generate for instance a line 
graph as shown in Figure 4.95. 

 

 
Figure 4.95 Gas measurement data in Excel with graph. 

 

If  has been ticked, the ticked gas graph 
snapshot will be added as a tab in the export Excel workbook file. All 

ticked gasses will appear as different tabs. 
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Figure 4.96 Gas graph snapshot 

 in Excel 

 

4.6 Errors/Warnings Window 
 

The Errors/Warnings window can be switched on/off by using the View 
menu pull-down Errors/Warnings Window. 

 

 
Figure 4.97 View pull-down: Errors/Warnings Window 

 
Warnings and errors while running the LumaSoft Gas application will be 

shown in the Errors/Warnings window, see Figure 4.98, and those 
occurring during measurement will be shown in Measurement 

Errors/Warnings window, see Figure 4.99. 
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Figure 4.98 Errors/Warnings window 

 
 

Figure 4.99 Measurement Errors/Warnings window 
 

Measurement errors is also marked with an asterix (*) next to the Date 
Time stamp, as shown in Figure 4.100. 

 

 
Figure 4.100 Error marking of measurements 
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4.7 Export log 
 

When having a task open it is possible to export 3 types of logs into CSV 
(comma separated files), suitable for opening in Microsoft Excel. 

 
The 3 types of logs, which can be exported, are: 

 
• Measurement Errors/Warnings 

• User Events 
• Alarms 

 
To perform the Export Log select the File menu pull-down Export Log, 

see Figure 4.101. 

 

 
Figure 4.101 File pull-down: Export Log 

 
Open the Export Log window, giving the possibility to export the 3 

types of logs, see Figure 4.102. A time interval for the log can also be 
specified. 

 

 
Figure 4.102 Export Log 

 
Select one of the 3 log types in the Select Type of Log group box and 

select the Export soft-key to export to a CSV-file. 
 

Select the folder where the log file should be saved, see Figure 4.103. 
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Figure 4.103 Save export log CSV file 

 
Also a preview of the 3 log types can be made by using the Preview 

soft-key. See examples in Figure 4.104, 4.105 and 4.106. 
 

 

Figure 4.104 Measurement Errors/Warnings log preview 

 
 

 

Figure 4.105 User Events log preview 

 
 

 

Figure 4.106 Alarms log preview 
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This chapter shows how to 
 

- Export Task (Section 5.1) 
- Export/Import Task configuration (Section 5.2) 

- Backup/Restore/Delete Task (Section 5.3) 
- Export Log (Section 5.4) 

5.1 Export Task 
 

To view the data in another format and do further calculations on 
data, it is possible to export obtained data to Microsoft Excel. 

 
Two types exports are available, either channel-wise (see Section 

5.1.1) or gas-wise (see Section 5.1.2). 
 

Please note that Microsoft Office must be installed for the 
export task functionality to work. 

 

5.1.1 Export Task (Channel view) 
 

If the LumaSoft Gas application is not started start it and login with 
username and password. 

 

 
Figure 5.1 User Login 

 

Select Export Task>Select Gases/Channel Excel Sheet in the 
File pull-down menu. 
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Figure 5.2 File pull-down: Export Task>Select Gases/Channel Excel 

Sheet 

 
The Export Task Figure 5.3 window will appear. 

 

 
Figure 5.3 Select which task to export 
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Select the task to be exported to Excel and the channels from which 

to view the data. Optionally the measurement data values can be 
calculated using the Rolling Average setting. Up to 1440 minutes 

(24 hours) is allowed. Press OK to proceed. 
 

 
Figure 5.4 Type in a filename for the excel file 

 

Search for a folder where the task should be stored, and type in a 
name for the task in the field: File Name, see Figure 5.4. 

 

The default file name for the excel file is the name of the export task. 
 

Press the Save soft-key to save the Excel file, see Figure 5.4. 
 

Press Close (see Figure 5.3) when the Excel file has been exported. 
 

The exported task can be opened in Excel format from the above 
selected folder. 

 
The Excel spread sheet contains information about the setup of the 

specific measurement in the first tab of the Excel file, see Figure 5.5, 
and the measurement data for each channel of the multiplexer in the 

following tab(s), se Figure 5.6. 
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Figure 5.5 Excel file: Monitor setup tab. 

 

 
Figure 5.6 Excel file: Measurement data tab. 
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5.1.2 Export Task (Gas view) 
 
If the LumaSoft Gas application is not started start it and login with 

username and password. 
 

 
Figure 5.7 User Login 

 
Select Export Task>Select Channel/Gas Excel Sheet in the File 

pull-down menu. 
 

 
Figure 5.8 File pull-down: Export Task>Select Channel/Gas Excel 

Sheet 
 

The Export Task Figure 5.9 window will appear. 
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Figure 5.9 Select which task to export 

 

Select the task to be exported to Excel and the gases from which to 
view the data. Optionally the measurement data values can be 

calculated using the Rolling Average setting. Up to 1440 minutes 

(24 hours) is allowed. Press OK to proceed. 
 

 
Figure 5.10 Type in a filename for the excel file 



Chapter 5 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 134 of 215 

 
Search for a folder where the task should be stored, and type in a 

name for the task in the field: File Name, see Figure 5.10. 
 

The default file name for the excel file is the name of the export task. 
 

Press the Save soft-key to save the Excel file, see Figure 5.10. 
 

Press Close (see Figure 5.9) when the Excel file has been exported. 
 

The exported task can be opened in Excel format from the above 
selected folder. 

 
The first tab shows the setup of the Monitor, see Figure 5.11a. 

 

   
Figure 5.11a The ‘Monitor Setup’ tab 
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The export Excel workbook file consists of a tab for each gas, see 
Figure 5.11. 

 
Each measurement is time stamped. 

 

 
Figure 5.11b Excel file: Measurement data tab. 

 

5.2 Export/Import Task Configuration 
 
The task configuration export makes an export of a task setup into a 

file in xml format. 

 
The advantage is that once a task has been setup and a backup has 

been made with the export task configuration, it can be reused by 
doing an import of the task configuration. This saves the work of 

doing the same setup again. 
 

5.2.1 Export task configuration 
 

If the LumaSoft Gas application is not started start it and login with 
username and password. 
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Figure 5.12 User Login 
 

Select Export Task Configuration in the File pull-down menu. 
 

 
Figure 5.13 File pull-down: Export Task Configuration 

 

The following window will appear. 
 

 
Figure 5.14 Select a task to export its configuration 

 
Select the task for which the configuration is to be exported to a xml-

file. Press OK to proceed. (See Figure 5.14) 
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Figure 5.15 Type in a filename for the xml task configuration file 

 

Search for a folder where the xml task configuration should be stored, 

and type in a name for the task configuration file in the field: File 
Name. (See Figure 5.15) 

 
The default file name for the xml configuration file is the name of the 

task that is having its configuration exported. 
Press the Save soft-key to save the xml task configuration file. (See 

Figure 5.15) 
 

Press Close when the task configuration file has been saved. (See 
Figure 5.14) 

 

5.2.2 Import Task Configuration 
 

If the LumaSoft Gas application is not started start it and login with 

username and password. 
 

 
Figure 5.16 User Login 

 
Select Import Task Configuration in the File pull-down menu. 
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Figure 5.17 File pull-down: Import Task Configuration 

 

 
Figure 5.18 Select xml configuration file to be imported 

 
Select the xml file to import. 
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After having opened the xml file the following message might appear, 
if the task already exist in the database. 

 

 
Figure 5.19 Task Validation window 

 

After pressing the Yes soft-key you can define a new task name for 
the imported task, see Figure 5.20. 

 

 
Figure 5.20 New Task name 

 

Press the OK soft-key to import the task configuration. 
 

5.3 Backup/Restore/Delete Task 
 
This function enables to backup and restore measurement tasks 

stored in the SQL Server database. 
 

The backup will contain both setup and measurement data. 
 

Please note that users with the Operator access level cannot 
make a backup/restore of a task. 

 

Also note that only users with the Super access level can 
delete a task. 

 

5.3.1 Backup Task 
 
If the LumaSoft Gas application is not started start it and login with 

username and password. 
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Figure 5.21 User Login 

 

Select Backup Task in the File pull-down menu, see Figure 5.22. 

 

 
Figure 5.22 File pull-down: Backup Task 

 

A window will appear, showing the available tasks for backup. 
 

 
Figure 5.23 Select task to backup 

 

Select the task for which a backup file is to be made, and press OK to 
proceed. 



Chapter 5 
_______________________________________________________________________ 

_______________________________________________________________________ 

BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 141 of 215 

 

 
Figure 5.24 Type in a filename 

 

Search for a folder where the task backup file should be stored and 
type in a file name in the window shown in Figure 5.24. 

 
The default file name for the task backup file is the name of the task 

selected for backup. 
 

Press the Save soft-key to save the Backup file. (See Figure 5.24) 
 

Press the Close soft-key after the backup. (See Figure 5.23) 
 

If you do not have sufficient rights to make the backup, you will get a 
Backup failed message, see Figure 5.25. In that case you must ensure 

that the group Everyone has the full rights for the backup folder. 
 

 
Figure 5.25 Backup failed message 

 
Check with your system administrator that the following rights for the 

group Everyone are created for the backup folder (Figure 5.26). 
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Figure 5.26 Backup folder rights for group Everyone 

 

5.3.2 Restore Task 
 

All backup files, made using the Backup Task function, can be 
restored. 

 
If the LumaSoft Gas application is not started start it and login with 

username and password. 
 

 
Figure 5.27 User Login 

 
Select Restore Task in the File pull-down menu (Figure 5.28). 
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Figure 5.28 File pull-down: Restore Task 

 
 

 
Figure 5.29 Select which task to restore 

 

In Figure 5.29 select which of the stored tasks to restore and press 
Open. 
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In case that the task already exists in the SQL database the following 
message will appear, where it is possible if desired to confirm the 

overwriting of the existing task. 
 

 
Figure 5.30 Confirm overwrite when restoring 

 

5.3.3 Delete Task 
 
If the LumaSoft Gas application is not started start it and login with 

username and password. 
 

 
Figure 5.31 User Login 

 
Select Delete Task in the File pull-down menu (Figure 5.32) or 

select the  icon from the task bar. 

 

 
Figure 5.32 File pull-down: Delete Task 

 
A window will appear showing all existing tasks. 
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Figure 5.33 Select which task to delete 

 
Select the task which should be deleted and press OK (See Figure 

5.33). The following window will pop up to make sure that the user 

wants to delete the task. 
 

 
Figure 5.34 Press OK if the task should be deleted 

 

5.4 Export Log 
 

When not having a task open it is possible to export 2 types of logs 
into CSV (comma separated files), suitable for opening in Microsoft 

Excel. 
 

The 2 types of logs, which can be exported, are: 
 

- User Activities 
- Errors Warnings 

 
If the LumaSoft Gas application is not started start it and login with 

username and password. 
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Figure 5.35 User Login 

 

Select Export Log in the File pull-down menu (Figure 5.36). 

 

 
Figure 5.36 File pull-down: Export Log 

 

The Export Log window opens, giving the possibility to export the 2 
types of logs, see Figure 5.37. A time interval for the log can also be 

specified. 
 

The User Activities log shows the history for user actions (Figure 
5.40). 

 

The Errors/Warnings log shows error and warnings messages 
presented for the user (Figure 5.39). 
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Figure 5.37 Export Log 

 

Select one of the 2 log types in the Select Type of Log group box 
and select the Export soft-key to export to a CSV-file. 

 
Select the folder where the log file should be saved, see Figure 5.38 

 

 
Figure 5.38 Save export log CSV file 

 

Also a preview of the 2 log types can be made by using the Preview 
soft-key. See examples in Figure 5.39 and Figure 5.40. 
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Figure 5.39 Error/Warnings log preview 

 

 
Figure 5.40 User Activities log preview 
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Warning and Errors occurring during the operation of the LumaSoft 

Gas application will be shown in 2 windows at the bottom of the 
application. 

 
How to enable the view of these 2 Warning and Error windows is 

described in Section 4.6. 
 

The Warnings and errors occurring during measurement will appear in 
the Measurement Errors/Warnings window, see Figure 6.1. 

 

 
Figure 6.1 Measurement Errors/Warnings window 

 

The Warnings and Errors shown in the Measurement 

Errors/Warnings window originates either from the Monitor or the 
Multiplexer. 

 

6.1 Monitor Error/Warnings 
 

The Warnings and Errors which originates from the Gas Monitor is 
described in chapter 17 in the manual “BE6025 Instruction Manual, 

1412i Photoacoustic Gas Monitor”and in chapter 15 in the 
BE6030 Instruction Manual 1314i Photoacoustic Gas Monitor, 

in chapter 14 in the BE6028 Instruction Manual 3434i SF6 Leak 
Detector and in chapter 17 in the BE6049 Instruction Manual 

1512 Photoacoustic Gas Monitor.. 
 

Warning/errors originating from the Monitor will be given the 

Error/Warning Number 255, as shown in Figure 6.1. 
 

6.2 Multiplexer (Multipoint sampler) Error/Warnings 
 
The warnings and errors which originate from the Multiplexer is 

described in Chapter 4 in the manual “BE6037 User Manual for 
Multipoint Sampler INNOVA 1409”. 

 
The Error/Warning Number will show the Warning flag value and 

Error flag value as specified in the above 1409 Multipoint Sampler 
manuals. 
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1. When installing the LumaSoft Gas software you must be logged in as 

Administrator that means that you must have “administrator” rights. 
 

Please also note that you must have Administrator rights or 
Power User rights to run the LumaSoft Gas application after 

installation. 
 

A fresh Windows installation is recommended in order to avoid 
conflicts with other previously installed third-party software. 

Especially other Microsoft SQL Server  installations can cause 
conflicts. 

 
Please also observe the computer requirements in section 2.1.1, with 

respect to the needed Windows version. If Windows 7 is used  

Windows 7 Service Pack 1 needs to be present, in order for the SQL 
Server 2014 used by LumaSoft Gas to be installed. 

 
2. Start the installation of LumaSoft Gas. Insert the USB memory key 

containing the LumaSoft Gas software into an USB port and open 
Windows Explorer. Locate the Removable Disk associated with 

the USB memory key. Double-click the Index file in order to open its 
contents in your browser. 
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Now click to select the appropriate LumaSoft Gas 7820 or 7880 
software for installation. You might get a warned that this type of file 

can harm your computer, which can be skipped. At the bottom of 
your browser window you can start the installation by selecting the 

Open option. 
 

 
The installation file will automatically install all the necessary 

packages required to run the LumaSoft Gas application. The installer 
will start unpacking with the following window. Please wait. 

 

 
 

After a while the following window appears. Press the OK button to 
continue: 

 

 
 

3. First installer will check for the “.NET Framework 3.5”, whether it is 

already installed on the target PC. It will install the “. NET  Framework 
3.5” if it is not already installed, otherwise it will skip the “. NET 3.5 

Framework” installation. If “. NET Framework 3.5” is already installed 
please continue to step 4. in this installation guide. 

 
IMPORTANT! Please note that you must be connected to the 

internet in order for the “.NET Framework 3.5” to be downloaded 
and installed. 
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Click “Download and install this feature” continue. Wait for the 

.NET Framework 3.5 to be downloaded.  
 

 

 
 

 

Now the “.NET Framework 3.5” is downloaded. 

 

 
 

 



Appendix A 
_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 155 of 215 

 
And later the “.NET Framework 3.5 is installed. 

 

 
 

Press Close to finish. 
 

 
 

 



Appendix A 
_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 156 of 215 

 
4. The installer will ask you to install “HASP security key driver” for the 

USB license key.  
 

You can skip this if you have “HASP security key driver” 
already installed on the local PC in a previous LumaSoft Gas 

install, by pressing ‘Cancel’.  
 

If you select OK, it will start preparing the installation. 
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Press Next to continue. 

 

 

 

Choose “I accept the license agreement” and press the Next 
button. 

 

 



Appendix A 
_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 
 7820 and 7880 Page 158 of 215 

 
Press Next to continue. 

 

 
 

The HASP key driver will now be installed. 
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After installing the HASP key driver press Finish. 

 

 

 
 

5. The following window will appear. Press the OK button to install the 
“SQL-Express 2014” database server.  

 
In case you already installed the "SQL-Express 2014" database server 

in a previous LumaSoft Gas installation, you can skip installing it by 
pressing the Cancel button. 
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Then wait for the installation of the SQL-Express 2014 database to 
finish. 
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6. Next the installer will install the DTS communication server. Press 

Next to continue. 
 

 

 
Select the radio button install for Everyone and press Next 
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Select Next to confirm installation of DTS. 
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After installation of DTS press Close. 

 

 
 

 
7. After successful installation of DTS server the LumaSoft Gas 

installation will start. Press Next to start installation of LumaSoft. 
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Select install for Everyone and press Next 

 

 

 
Select Next to confirm installation of LumaSoftGas 
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After installation of LumaSoftGas press Close. 
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8. The installation of the USB driver for the 1412i Gas Monitor will start. 

The following window will appear. Press OK to install the USB driver. 
In case the USB driver has already been installed you can press 

Cancel. 
 

 
 

Select Next to start the installation of the USB driver 

 

 
 

Tick Always trust software from “LumaSense Technologies” 
and press Install  
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Select Finish to exit the installation of the USB driver 
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9. The installation of the OPC Core Components will start. The following 

window will appear. Press OK to install the OPC Core Components. In 
case the OPC Core Components has already been installed you can 

press Cancel. 
 

 
  

 Select the I Agree radiobutton. Press Next to continue. 
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 Select the Everyone radiobutton. Press Next to continue. 
 

 
 

 Press Next to start the installation of the OPC Core Components. 
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Press Close when installation is finished. 
 

 

 

 

10. Now the LumaSoftGas database will be installed on your local PC. This 
will take a while. 
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11. During installation of the LumaSoftGas database you will get a 
warning message, depending whether you are installing 7820 Single 

Point or 7880 Multi Point. This warning is due to the LumaSoft Gas 
database server password was changed to a strong password from 

7820 version 1.0.6 /7880 version 1.0.6, due to new requirements in 
Windows 10.  

 
7820 installation: 

 
 

7880 installation: 

 
 

12. After successful installation of the database the following message 

appears. 
 

 
 

13. Press OK to proceed. Installation of the LumaSoft Gas software was 

successful if all the installation succeeded. 
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14. Press OK to finish the installation package setup. 

 
15. In case you are using the USB interface in the Gas Monitor you can 

now connect the USB interface cable between your PC and the  Gas 

Monitor. Locate the output labelled  at the back of the Monitor. 
 

 
16. This finalises the installation of the LumaSoft Gas software. 
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C.1 How to enable automated backup of the LumaSoft Gas database at 

regular intervals 

 

A. Start the SQL Server 2014 Management Studio application. 

 
 

B. Wait for the app to startup (it only happens the first time the app is 

started). 
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C. Wait screen for app to start 

 

 

D. As Authentication select SQL Server Authentication 

Use login: sa  and Password: LUMAsoft1234! 
 

Tick Remember password 
 

Press the Connect button to continue 
 

 
 

 

 

 

 

 

 



Appendix B 

_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 

 7820 and 7880 Page 176 of 215 

E. Expand the Databases folder by clicking the + sign to the left of it. 
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F. Right-click on the LumaSoftGas database and select Tasks->Back 

Up… 

 
 

G. Choose the Media Options page and select Overwrite all existing 

backup sets and tick Verify backup when finished 
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H. Choose Script Action to File in order to make a database backup 

script file 

 
 

I. Now create a folder to be used for saving the script file 
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J. Write a name for the script file and press the Save button in order to 

create a script file with the name ‘7880backupScript’. 

 
 

K. When the script file is successfully created you will get the message 

Scripting completed successfully in the lower left corner. 

 
 

L. Close the SQL Server 2014 Management Studio Express application. 
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M. Open the Notepad editor ( to be found in All Programs->Accessories ) 

and enter the following content. Replace the name of your computer 

with the text marked as red and replace the folder name where you 

previously saved the backup script file, with the text marked as 

green. 

 
 

Below a description of the sqlcmd parameters. 
 

sqlcmd parameter Description 

-U sa login id 

-P LUMAsoft1234! password 

-S DESKTOP-BUU8D4H\LUMASOFTGASDB2 server 

-l 20 login 

timeout 

-i C:\Users\per\Documents\SQLserverBackups\7880backupScript.sql inputfile 

-o Log.txt outputfile 
 

N. Save the file in the same folder as the backup script file and name it 

RunBackup.bat. Please make sure that the file is not of .txt type but 

of .bat type. 
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O. Type ‘Task Scheduler’ in the search field with the magnifying glass 

below to the left.  

 
 

P. Start the Task Scheduler  

Q. Choose Create Task.. action 
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R. Enter Name: , Description: and Configure for: as shown below. Press 

the OK button. 

 
 

S. Select the Triggers tab and press the New button 
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T. Enter the desired time schedule and interval for the database backup 

and press the OK button when finished 

 
 

U. The database backup schedule (trigger) is listed.  
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V. Select the Action tab and press the New button 

 
 

W. Press the Browse button and find the RunBackup.bat that you have 

created previously. 

As the Start in (optional): folder type in the folder name for the 

RunBackup.bat file. 

Press the OK button when finished. 
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X. Close the Task Scheduler. This concludes the setup of the automated 

backup of the LumaSoft Gas 7880 database. You can check the status 

of the backup in a log file (Log.txt) found in the script folder 
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C.2 How to restore the LumaSoft Gas database 

 

A. Start the SQL Server 2014 Management Studio application. 

 
 

B. Wait for the app to startup (it only happens the first time the app 

is started). 

 

C. Wait screen for app to start 
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D. As Authentication select SQL Server Authentication 

Use login: sa  and Password: LUMAsoft1234! 

 

Tick Remember password 
 

 
 

 

E. Expand the Databases folder by clicking the + sign to the left of it. 
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F. Right-click on the LumaSoftGas database and select Tasks-

>Restore->Database… 
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G. Choose the Options page and tick Overwrite the existing 

database. 

Warning! Please note that you will loose all tasks created after the last 

automatic backup. You can eventually backup (see 5.3.1) the tasks created 
after the last automatic backup before restoring the automatic backup. 

 
Press the OK button to restore the LumaSoft Gas 7880 database. 

 

 
 

H. A successful restore results in the following message.  

 
 

Press OK to continue. 

Close the SQL Server 2014 Management Studio Express application. 
 



Appendix C 

_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 

 7820 and 7880 Page 190 of 215 
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Only applicable for 7880. 
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This appendix contains a list of all the OPC Server tags offered by LumaSoft Gas 
7880. 

 
These tags will be active when a measurement is running. When running without 

a Multipoint Sampler the Channel 1 OPC tags will be used for the measurement 
results. 

 
The 7880 OPC server conforms to the OPC DA (Data access) version 3.0 as well 

as the previous versions 1.0 and 2.0.  
 

The name (Prog ID) of the 7880 OPC server is ‘LumaSense.DaServer.1’.  
 

The tags are listed in ascending order according to the numerical part of the OPC 
ItemID. 

 

Please note that the OPC Server only are present in the 7880 Multipoint 
version and not in the 7820 Single point version of LumaSoft Gas. 

 
 

OPC Server Tags 

Tag Name 
Data 
type  OPC ItemID 

Channel 1 Gas A Concentration Float Channel1/GasA/Concentration/1010100 

Channel 1 Gas A Alarm HH occurred Boolean Channel1/GasA/AlarmHHOccurred/1010200 

Channel 1 Gas A Alarm H occurred Boolean Channel1/GasA/AlarmHOccurred/1010300 

Channel 1 Gas A Alarm L occurred Boolean Channel1/GasA/AlarmLOccurred/1010400 

Channel 1 Gas A Alarm LL occurred Boolean Channel1/GasA/AlarmLLOccurred/1010500 

Channel 1 Filter A alignment error flag Boolean Channel1/FilterA/AlignmentErrorFlag/1010600 

Channel 1 Gas B Concentration Float Channel1/GasB/Concentration/1020100 

Channel 1 Gas B Alarm HH occurred Boolean Channel1/GasB/AlarmHHOccurred/1020200 

Channel 1 Gas B Alarm H occurred Boolean Channel1/GasB/AlarmHOccurred/1020300 

Channel 1 Gas B Alarm L occurred Boolean Channel1/GasB/AlarmLOccurred/1020400 

Channel 1 Gas B Alarm LL occurred Boolean Channel1/GasB/AlarmLLOccurred/1020500 

Channel 1 Filter B alignment error flag Boolean Channel1/FilterB/AlignmentErrorFlag/1020600 

Channel 1 Gas C Concentration Float Channel1/GasC/Concentration/1030100 

Channel 1 Gas C Alarm HH occurred Boolean Channel1/GasC/AlarmHHOccurred/1030200 

Channel 1 Gas C Alarm H occurred Boolean Channel1/GasC/AlarmHOccurred/1030300 

Channel 1 Gas C Alarm L occurred Boolean Channel1/GasC/AlarmLOccurred/1030400 

Channel 1 Gas C Alarm LL occurred Boolean Channel1/GasC/AlarmLLOccurred/1030500 

Channel 1 Filter C alignment error flag Boolean Channel1/FilterC/AlignmentErrorFlag/1030600 

Channel 1 Gas D Concentration Float Channel1/GasD/Concentration/1040100 

Channel 1 Gas D Alarm HH occurred Boolean Channel1/GasD/AlarmHHOccurred/1040200 

Channel 1 Gas D Alarm H occurred Boolean Channel1/GasD/AlarmHOccurred/1040300 

Channel 1 Gas D Alarm L occurred Boolean Channel1/GasD/AlarmLOccurred/1040400 

Channel 1 Gas D Alarm LL occurred Boolean Channel1/GasD/AlarmLLOccurred/1040500 

Channel 1 Filter D alignment error flag Boolean Channel1/FilterD/AlignmentErrorFlag/1040600 

Channel 1 Gas E Concentration Float Channel1/GasE/Concentration/1050100 

Channel 1 Gas E Alarm HH occurred Boolean Channel1/GasE/AlarmHHOccurred/1050200 

Channel 1 Gas E Alarm H occurred Boolean Channel1/GasE/AlarmHOccurred/1050300 

Channel 1 Gas E Alarm L occurred Boolean Channel1/GasE/AlarmLOccurred/1050400 
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Channel 1 Gas E Alarm LL occurred Boolean Channel1/GasE/AlarmLLOccurred/1050500 

Channel 1 Filter E alignment error flag Boolean Channel1/FilterE/AlignmentErrorFlag/1050600 

Channel 1 Gas W Concentration Float Channel1/GasW/Concentration/1060100 

Channel 1 Gas W Alarm HH occurred Boolean Channel1/GasW/AlarmHHOccurred/1060200 

Channel 1 Gas W Alarm H occurred Boolean Channel1/GasW/AlarmHOccurred/1060300 

Channel 1 Gas W Alarm L occurred Boolean Channel1/GasW/AlarmLOccurred/1060400 

Channel 1 Gas W Alarm LL occurred Boolean Channel1/GasW/AlarmLLOccurred/1060500 

Channel 1 Filter W alignment error flag Boolean Channel1/FilterW/AlignmentErrorFlag/1060600 

Channel 1 Pressure Float Channel1/Pressure/1500100 

Channel 1 Gas Monitor Air flag Boolean Channel1/GasMonitor/Airflag/1500200 

Channel 1 Gas Monitor Error flag Boolean Channel1/GasMonitor/Errorflag/1500300 

Channel 1 Gas Monitor Warning flag Boolean Channel1/GasMonitor/Warningflag/1500400 

Channel 1 Monitor Display Error Message String Channel1/GasMonitor/MonitorDisplayErrorMessage/1500500 

Channel 1 Monitor Display Warning Message String Channel1/GasMonitor/MonitorDisplayWarningMessage/1500600 

Channel 1 Multiplexer error flag Boolean Channel1/Multiplexer/errorflag/1600100 

Channel 1 Multiplexer warning flag Boolean Channel1/Multiplexer/warningflag/1600200 

Channel 1 Multiplexer error number Long Channel1/Multiplexer/errornumber/1600300 

Channel 1 Multiplexer warning number Long Channel1/Multiplexer/warningnumber/1600400 

Channel 1 Multiplexer Error Description String Channel1/Multiplexer/ErrorDescription/1600600 

Channel 1 Multiplexer Warning Description String Channel1/Multiplexer/WarningDescription/1600700 

Channel 2 Gas A Concentration           Float Channel2/GasA/Concentration/2010100 

Channel 2 Gas A Alarm HH occurred       Boolean Channel2/GasA/AlarmHHOccurred/2010200 

Channel 2 Gas A Alarm H occurred        Boolean Channel2/GasA/AlarmHOccurred/2010300 

Channel 2 Gas A Alarm L occurred        Boolean Channel2/GasA/AlarmLOccurred/2010400 

Channel 2 Gas A Alarm LL occurred       Boolean Channel2/GasA/AlarmLLOccurred/2010500 

Channel 2 Filter A alignment error flag Boolean Channel2/FilterA/AlignmentErrorFlag/2010600 

Channel 2 Gas B Concentration           Float Channel2/GasB/Concentration/2020100 

Channel 2 Gas B Alarm HH occurred       Boolean Channel2/GasB/AlarmHHOccurred/2020200 

Channel 2 Gas B Alarm H occurred        Boolean Channel2/GasB/AlarmHOccurred/2020300 

Channel 2 Gas B Alarm L occurred        Boolean Channel2/GasB/AlarmLOccurred/2020400 

Channel 2 Gas B Alarm LL occurred       Boolean Channel2/GasB/AlarmLLOccurred/2020500 

Channel 2 Filter B alignment error flag Boolean Channel2/FilterB/AlignmentErrorFlag/2020600 

Channel 2 Gas C Concentration           Float Channel2/GasC/Concentration/2030100 

Channel 2 Gas C Alarm HH occurred       Boolean Channel2/GasC/AlarmHHOccurred/2030200 

Channel 2 Gas C Alarm H occurred        Boolean Channel2/GasC/AlarmHOccurred/2030300 

Channel 2 Gas C Alarm L occurred        Boolean Channel2/GasC/AlarmLOccurred/2030400 

Channel 2 Gas C Alarm LL occurred       Boolean Channel2/GasC/AlarmLLOccurred/2030500 

Channel 2 Filter C alignment error flag Boolean Channel2/FilterC/AlignmentErrorFlag/2030600 

Channel 2 Gas D Concentration           Float Channel2/GasD/Concentration/2040100 

Channel 2 Gas D Alarm HH occurred       Boolean Channel2/GasD/AlarmHHOccurred/2040200 

Channel 2 Gas D Alarm H occurred        Boolean Channel2/GasD/AlarmHOccurred/2040300 

Channel 2 Gas D Alarm L occurred        Boolean Channel2/GasD/AlarmLOccurred/2040400 

Channel 2 Gas D Alarm LL occurred       Boolean Channel2/GasD/AlarmLLOccurred/2040500 

Channel 2 Filter D alignment error flag Boolean Channel2/FilterD/AlignmentErrorFlag/2040600 

Channel 2 Gas E Concentration           Float Channel2/GasE/Concentration/2050100 

Channel 2 Gas E Alarm HH occurred       Boolean Channel2/GasE/AlarmHHOccurred/2050200 

Channel 2 Gas E Alarm H occurred        Boolean Channel2/GasE/AlarmHOccurred/2050300 

Channel 2 Gas E Alarm L occurred        Boolean Channel2/GasE/AlarmLOccurred/2050400 

Channel 2 Gas E Alarm LL occurred       Boolean Channel2/GasE/AlarmLLOccurred/2050500 

Channel 2 Filter E alignment error flag Boolean Channel2/FilterE/AlignmentErrorFlag/2050600 

Channel 2 Gas W Concentration           Float Channel2/GasW/Concentration/2060100 

Channel 2 Gas W Alarm HH occurred       Boolean Channel2/GasW/AlarmHHOccurred/2060200 
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Channel 2 Gas W Alarm H occurred        Boolean Channel2/GasW/AlarmHOccurred/2060300 

Channel 2 Gas W Alarm L occurred        Boolean Channel2/GasW/AlarmLOccurred/2060400 

Channel 2 Gas W Alarm LL occurred       Boolean Channel2/GasW/AlarmLLOccurred/2060500 

Channel 2 Filter W alignment error flag Boolean Channel2/FilterW/AlignmentErrorFlag/2060600 

Channel 2 Pressure                      Float Channel2/Pressure/2500100 

Channel 2 Gas Monitor Air flag          Boolean Channel2/GasMonitor/Airflag/2500200 

Channel 2 Gas Monitor Error flag        Boolean Channel2/GasMonitor/Errorflag/2500300 

Channel 2 Gas Monitor Warning flag      Boolean Channel2/GasMonitor/Warningflag/2500400 

Channel 2 Monitor Display Error Message String Channel2/GasMonitor/MonitorDisplayErrorMessage/2500500 

Channel 2 Monitor Display Warning Message String Channel2/GasMonitor/MonitorDisplayWarningMessage/2500600 

Channel 2 Multiplexer error flag        Boolean Channel2/Multiplexer/errorflag/2600100 

Channel 2 Multiplexer warning flag      Boolean Channel2/Multiplexer/warningflag/2600200 

Channel 2 Multiplexer error number      Long Channel2/Multiplexer/errornumber/2600300 

Channel 2 Multiplexer warning number    Long Channel2/Multiplexer/warningnumber/2600400 

Channel 2 Multiplexer Error Description String Channel2/Multiplexer/ErrorDescription/2600600 

Channel 2 Multiplexer Warning Description String Channel2/Multiplexer/WarningDescription/2600700 

Channel 3 Gas A Concentration           Float Channel3/GasA/Concentration/3010100 

Channel 3 Gas A Alarm HH occurred       Boolean Channel3/GasA/AlarmHHOccurred/3010200 

Channel 3 Gas A Alarm H occurred        Boolean Channel3/GasA/AlarmHOccurred/3010300 

Channel 3 Gas A Alarm L occurred        Boolean Channel3/GasA/AlarmLOccurred/3010400 

Channel 3 Gas A Alarm LL occurred       Boolean Channel3/GasA/AlarmLLOccurred/3010500 

Channel 3 Filter A alignment error flag Boolean Channel3/FilterA/AlignmentErrorFlag/3010600 

Channel 3 Gas B Concentration           Float Channel3/GasB/Concentration/3020100 

Channel 3 Gas B Alarm HH occurred       Boolean Channel3/GasB/AlarmHHOccurred/3020200 

Channel 3 Gas B Alarm H occurred        Boolean Channel3/GasB/AlarmHOccurred/3020300 

Channel 3 Gas B Alarm L occurred        Boolean Channel3/GasB/AlarmLOccurred/3020400 

Channel 3 Gas B Alarm LL occurred       Boolean Channel3/GasB/AlarmLLOccurred/3020500 

Channel 3 Filter B alignment error flag Boolean Channel3/FilterB/AlignmentErrorFlag/3020600 

Channel 3 Gas C Concentration           Float Channel3/GasC/Concentration/3030100 

Channel 3 Gas C Alarm HH occurred       Boolean Channel3/GasC/AlarmHHOccurred/3030200 

Channel 3 Gas C Alarm H occurred        Boolean Channel3/GasC/AlarmHOccurred/3030300 

Channel 3 Gas C Alarm L occurred        Boolean Channel3/GasC/AlarmLOccurred/3030400 

Channel 3 Gas C Alarm LL occurred       Boolean Channel3/GasC/AlarmLLOccurred/3030500 

Channel 3 Filter C alignment error flag Boolean Channel3/FilterC/AlignmentErrorFlag/3030600 

Channel 3 Gas D Concentration           Float Channel3/GasD/Concentration/3040100 

Channel 3 Gas D Alarm HH occurred       Boolean Channel3/GasD/AlarmHHOccurred/3040200 

Channel 3 Gas D Alarm H occurred        Boolean Channel3/GasD/AlarmHOccurred/3040300 

Channel 3 Gas D Alarm L occurred        Boolean Channel3/GasD/AlarmLOccurred/3040400 

Channel 3 Gas D Alarm LL occurred       Boolean Channel3/GasD/AlarmLLOccurred/3040500 

Channel 3 Filter D alignment error flag Boolean Channel3/FilterD/AlignmentErrorFlag/3040600 

Channel 3 Gas E Concentration           Float Channel3/GasE/Concentration/3050100 

Channel 3 Gas E Alarm HH occurred       Boolean Channel3/GasE/AlarmHHOccurred/3050200 

Channel 3 Gas E Alarm H occurred        Boolean Channel3/GasE/AlarmHOccurred/3050300 

Channel 3 Gas E Alarm L occurred        Boolean Channel3/GasE/AlarmLOccurred/3050400 

Channel 3 Gas E Alarm LL occurred       Boolean Channel3/GasE/AlarmLLOccurred/3050500 

Channel 3 Filter E alignment error flag Boolean Channel3/FilterE/AlignmentErrorFlag/3050600 

Channel 3 Gas W Concentration           Float Channel3/GasW/Concentration/3060100 

Channel 3 Gas W Alarm HH occurred       Boolean Channel3/GasW/AlarmHHOccurred/3060200 

Channel 3 Gas W Alarm H occurred        Boolean Channel3/GasW/AlarmHOccurred/3060300 

Channel 3 Gas W Alarm L occurred        Boolean Channel3/GasW/AlarmLOccurred/3060400 

Channel 3 Gas W Alarm LL occurred       Boolean Channel3/GasW/AlarmLLOccurred/3060500 

Channel 3 Filter W alignment error flag Boolean Channel3/FilterW/AlignmentErrorFlag/3060600 
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Channel 3 Pressure                      Float Channel3/Pressure/3500100 

Channel 3 Gas Monitor Air flag          Boolean Channel3/GasMonitor/Airflag/3500200 

Channel 3 Gas Monitor Error flag        Boolean Channel3/GasMonitor/Errorflag/3500300 

Channel 3 Monitor Display Error Message Boolean Channel3/GasMonitor/MonitorDisplayErrorMessage/3500500 

Channel 3 Monitor Display Warning Message String Channel3/GasMonitor/MonitorDisplayWarningMessage/3500600 

Channel 3 Gas Monitor Warning flag      String Channel3/GasMonitor/Warningflag/3500400 

Channel 3 Multiplexer error flag        Boolean Channel3/Multiplexer/errorflag/3600100 

Channel 3 Multiplexer warning flag      Boolean Channel3/Multiplexer/warningflag/3600200 

Channel 3 Multiplexer error number      Long Channel3/Multiplexer/errornumber/3600300 

Channel 3 Multiplexer warning number    Long Channel3/Multiplexer/warningnumber/3600400 

Channel 3 Multiplexer Error Description String Channel1/Multiplexer/ErrorDescription/3600600 

Channel 3 Multiplexer Warning Description String Channel1/Multiplexer/WarningDescription/3600700 

Channel 4 Gas A Concentration Float Channel4/GasA/Concentration/4010100 

Channel 4 Gas A Alarm HH occurred Boolean Channel4/GasA/AlarmHHOccurred/4010200 

Channel 4 Gas A Alarm H occurred Boolean Channel4/GasA/AlarmHOccurred/4010300 

Channel 4 Gas A Alarm L occurred Boolean Channel4/GasA/AlarmLOccurred/4010400 

Channel 4 Gas A Alarm LL occurred Boolean Channel4/GasA/AlarmLLOccurred/4010500 

Channel 4 Filter A alignment error flag Boolean Channel4/FilterA/AlignmentErrorFlag/4010600 

Channel 4 Gas B Concentration Float Channel4/GasB/Concentration/4020100 

Channel 4 Gas B Alarm HH occurred Boolean Channel4/GasB/AlarmHHOccurred/4020200 

Channel 4 Gas B Alarm H occurred Boolean Channel4/GasB/AlarmHOccurred/4020300 

Channel 4 Gas B Alarm L occurred Boolean Channel4/GasB/AlarmLOccurred/4020400 

Channel 4 Gas B Alarm LL occurred Boolean Channel4/GasB/AlarmLLOccurred/4020500 

Channel 4 Filter B alignment error flag Boolean Channel4/FilterB/AlignmentErrorFlag/4020600 

Channel 4 Gas C Concentration Float Channel4/GasC/Concentration/4030100 

Channel 4 Gas C Alarm HH occurred Boolean Channel4/GasC/AlarmHHOccurred/4030200 

Channel 4 Gas C Alarm H occurred Boolean Channel4/GasC/AlarmHOccurred/4030300 

Channel 4 Gas C Alarm L occurred Boolean Channel4/GasC/AlarmLOccurred/4030400 

Channel 4 Gas C Alarm LL occurred Boolean Channel4/GasC/AlarmLLOccurred/4030500 

Channel 4 Filter C alignment error flag Boolean Channel4/FilterC/AlignmentErrorFlag/4030600 

Channel 4 Gas D Concentration Float Channel4/GasD/Concentration/4040100 

Channel 4 Gas D Alarm HH occurred Boolean Channel4/GasD/AlarmHHOccurred/4040200 

Channel 4 Gas D Alarm H occurred Boolean Channel4/GasD/AlarmHOccurred/4040300 

Channel 4 Gas D Alarm L occurred Boolean Channel4/GasD/AlarmLOccurred/4040400 

Channel 4 Gas D Alarm LL occurred Boolean Channel4/GasD/AlarmLLOccurred/4040500 

Channel 4 Filter D alignment error flag Boolean Channel4/FilterD/AlignmentErrorFlag/4040600 

Channel 4 Gas E Concentration Float Channel4/GasE/Concentration/4050100 

Channel 4 Gas E Alarm HH occurred Boolean Channel4/GasE/AlarmHHOccurred/4050200 

Channel 4 Gas E Alarm H occurred Boolean Channel4/GasE/AlarmHOccurred/4050300 

Channel 4 Gas E Alarm L occurred Boolean Channel4/GasE/AlarmLOccurred/4050400 

Channel 4 Gas E Alarm LL occurred Boolean Channel4/GasE/AlarmLLOccurred/4050500 

Channel 4 Filter E alignment error flag Boolean Channel4/FilterE/AlignmentErrorFlag/4050600 

Channel 4 Gas W Concentration Float Channel4/GasW/Concentration/4060100 

Channel 4 Gas W Alarm HH occurred Boolean Channel4/GasW/AlarmHHOccurred/4060200 

Channel 4 Gas W Alarm H occurred Boolean Channel4/GasW/AlarmHOccurred/4060300 

Channel 4 Gas W Alarm L occurred Boolean Channel4/GasW/AlarmLOccurred/4060400 

Channel 4 Gas W Alarm LL occurred Boolean Channel4/GasW/AlarmLLOccurred/4060500 

Channel 4 Filter W alignment error flag Boolean Channel4/FilterW/AlignmentErrorFlag/4060600 

Channel 4 Pressure Float Channel4/Pressure/4500100 

Channel 4 Gas Monitor Air flag Boolean Channel4/GasMonitor/Airflag/4500200 

Channel 4 Gas Monitor Error flag Boolean Channel4/GasMonitor/Errorflag/4500300 

Channel 4 Gas Monitor Warning flag Boolean Channel4/GasMonitor/Warningflag/4500400 
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Channel 4 Monitor Display Error Message String Channel4/GasMonitor/MonitorDisplayErrorMessage/4500500 

Channel 4 Monitor Display Warning Message String Channel4/GasMonitor/MonitorDisplayWarningMessage/4500600 

Channel 4 Multiplexer error flag Boolean Channel4/Multiplexer/errorflag/4600100 

Channel 4 Multiplexer warning flag Boolean Channel4/Multiplexer/warningflag/4600200 

Channel 4 Multiplexer error number Long Channel4/Multiplexer/errornumber/4600300 

Channel 4 Multiplexer warning number Long Channel4/Multiplexer/warningnumber/4600400 

Channel 4 Multiplexer Error Description String Channel4/Multiplexer/ErrorDescription/4600600 

Channel 4 Multiplexer Warning Description String Channel4/Multiplexer/WarningDescription/4600700 

Channel 5 Gas A Concentration Float Channel5/GasA/Concentration/5010100 

Channel 5 Gas A Alarm HH occurred Boolean Channel5/GasA/AlarmHHOccurred/5010200 

Channel 5 Gas A Alarm H occurred Boolean Channel5/GasA/AlarmHOccurred/5010300 

Channel 5 Gas A Alarm L occurred Boolean Channel5/GasA/AlarmLOccurred/5010400 

Channel 5 Gas A Alarm LL occurred Boolean Channel5/GasA/AlarmLLOccurred/5010500 

Channel 5 Filter A alignment error flag Boolean Channel5/FilterA/AlignmentErrorFlag/5010600 

Channel 5 Gas B Concentration Float Channel5/GasB/Concentration/5020100 

Channel 5 Gas B Alarm HH occurred Boolean Channel5/GasB/AlarmHHOccurred/5020200 

Channel 5 Gas B Alarm H occurred Boolean Channel5/GasB/AlarmHOccurred/5020300 

Channel 5 Gas B Alarm L occurred Boolean Channel5/GasB/AlarmLOccurred/5020400 

Channel 5 Gas B Alarm LL occurred Boolean Channel5/GasB/AlarmLLOccurred/5020500 

Channel 5 Filter B alignment error flag Boolean Channel5/FilterB/AlignmentErrorFlag/5020600 

Channel 5 Gas C Concentration Float Channel5/GasC/Concentration/5030100 

Channel 5 Gas C Alarm HH occurred Boolean Channel5/GasC/AlarmHHOccurred/5030200 

Channel 5 Gas C Alarm H occurred Boolean Channel5/GasC/AlarmHOccurred/5030300 

Channel 5 Gas C Alarm L occurred Boolean Channel5/GasC/AlarmLOccurred/5030400 

Channel 5 Gas C Alarm LL occurred Boolean Channel5/GasC/AlarmLLOccurred/5030500 

Channel 5 Filter C alignment error flag Boolean Channel5/FilterC/AlignmentErrorFlag/5030600 

Channel 5 Gas D Concentration Float Channel5/GasD/Concentration/5040100 

Channel 5 Gas D Alarm HH occurred Boolean Channel5/GasD/AlarmHHOccurred/5040200 

Channel 5 Gas D Alarm H occurred Boolean Channel5/GasD/AlarmHOccurred/5040300 

Channel 5 Gas D Alarm L occurred Boolean Channel5/GasD/AlarmLOccurred/5040400 

Channel 5 Gas D Alarm LL occurred Boolean Channel5/GasD/AlarmLLOccurred/5040500 

Channel 5 Filter D alignment error flag Boolean Channel5/FilterD/AlignmentErrorFlag/5040600 

Channel 5 Gas E Concentration Float Channel5/GasE/Concentration/5050100 

Channel 5 Gas E Alarm HH occurred Boolean Channel5/GasE/AlarmHHOccurred/5050200 

Channel 5 Gas E Alarm H occurred Boolean Channel5/GasE/AlarmHOccurred/5050300 

Channel 5 Gas E Alarm L occurred Boolean Channel5/GasE/AlarmLOccurred/5050400 

Channel 5 Gas E Alarm LL occurred Boolean Channel5/GasE/AlarmLLOccurred/5050500 

Channel 5 Filter E alignment error flag Boolean Channel5/FilterE/AlignmentErrorFlag/5050600 

Channel 5 Gas W Concentration Float Channel5/GasW/Concentration/5060100 

Channel 5 Gas W Alarm HH occurred Boolean Channel5/GasW/AlarmHHOccurred/5060200 

Channel 5 Gas W Alarm H occurred Boolean Channel5/GasW/AlarmHOccurred/5060300 

Channel 5 Gas W Alarm L occurred Boolean Channel5/GasW/AlarmLOccurred/5060400 

Channel 5 Gas W Alarm LL occurred Boolean Channel5/GasW/AlarmLLOccurred/5060500 

Channel 5 Filter W alignment error flag Boolean Channel5/FilterW/AlignmentErrorFlag/5060600 

Channel 5 Pressure Float Channel5/Pressure/5500100 

Channel 5 Gas Monitor Air flag Boolean Channel5/GasMonitor/Airflag/5500200 

Channel 5 Gas Monitor Error flag Boolean Channel5/GasMonitor/Errorflag/5500300 

Channel 5 Gas Monitor Warning flag Boolean Channel5/GasMonitor/Warningflag/5500400 

Channel 5 Monitor Display Error Message String Channel1/GasMonitor/MonitorDisplayErrorMessage/5500500 

Channel 5 Monitor Display Warning Message String Channel1/GasMonitor/MonitorDisplayWarningMessage/5500600 

Channel 5 Multiplexer error flag Boolean Channel5/Multiplexer/errorflag/5600100 

Channel 5 Multiplexer warning flag Boolean Channel5/Multiplexer/warningflag/5600200 
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Channel 5 Multiplexer error number Long Channel5/Multiplexer/errornumber/5600300 

Channel 5 Multiplexer warning number Long Channel5/Multiplexer/warningnumber/5600400 

Channel 5 Multiplexer Error Description String Channel1/Multiplexer/ErrorDescription/5600600 

Channel 5 Multiplexer Warning Description String Channel1/Multiplexer/WarningDescription/5600700 

Channel 6 Gas A Concentration Float Channel6/GasA/Concentration/6010100 

Channel 6 Gas A Alarm HH occurred Boolean Channel6/GasA/AlarmHHOccurred/6010200 

Channel 6 Gas A Alarm H occurred Boolean Channel6/GasA/AlarmHOccurred/6010300 

Channel 6 Gas A Alarm L occurred Boolean Channel6/GasA/AlarmLOccurred/6010400 

Channel 6 Gas A Alarm LL occurred Boolean Channel6/GasA/AlarmLLOccurred/6010500 

Channel 6 Filter A alignment error flag Boolean Channel6/FilterA/AlignmentErrorFlag/6010600 

Channel 6 Gas B Concentration Float Channel6/GasB/Concentration/6020100 

Channel 6 Gas B Alarm HH occurred Boolean Channel6/GasB/AlarmHHOccurred/6020200 

Channel 6 Gas B Alarm H occurred Boolean Channel6/GasB/AlarmHOccurred/6020300 

Channel 6 Gas B Alarm L occurred Boolean Channel6/GasB/AlarmLOccurred/6020400 

Channel 6 Gas B Alarm LL occurred Boolean Channel6/GasB/AlarmLLOccurred/6020500 

Channel 6 Filter B alignment error flag Boolean Channel6/FilterB/AlignmentErrorFlag/6020600 

Channel 6 Gas C Concentration Float Channel6/GasC/Concentration/6030100 

Channel 6 Gas C Alarm HH occurred Boolean Channel6/GasC/AlarmHHOccurred/6030200 

Channel 6 Gas C Alarm H occurred Boolean Channel6/GasC/AlarmHOccurred/6030300 

Channel 6 Gas C Alarm L occurred Boolean Channel6/GasC/AlarmLOccurred/6030400 

Channel 6 Gas C Alarm LL occurred Boolean Channel6/GasC/AlarmLLOccurred/6030500 

Channel 6 Filter C alignment error flag Boolean Channel6/FilterC/AlignmentErrorFlag/6030600 

Channel 6 Gas D Concentration Float Channel6/GasD/Concentration/6040100 

Channel 6 Gas D Alarm HH occurred Boolean Channel6/GasD/AlarmHHOccurred/6040200 

Channel 6 Gas D Alarm H occurred Boolean Channel6/GasD/AlarmHOccurred/6040300 

Channel 6 Gas D Alarm L occurred Boolean Channel6/GasD/AlarmLOccurred/6040400 

Channel 6 Gas D Alarm LL occurred Boolean Channel6/GasD/AlarmLLOccurred/6040500 

Channel 6 Filter D alignment error flag Boolean Channel6/FilterD/AlignmentErrorFlag/6040600 

Channel 6 Gas E Concentration Float Channel6/GasE/Concentration/6050100 

Channel 6 Gas E Alarm HH occurred Boolean Channel6/GasE/AlarmHHOccurred/6050200 

Channel 6 Gas E Alarm H occurred Boolean Channel6/GasE/AlarmHOccurred/6050300 

Channel 6 Gas E Alarm L occurred Boolean Channel6/GasE/AlarmLOccurred/6050400 

Channel 6 Gas E Alarm LL occurred Boolean Channel6/GasE/AlarmLLOccurred/6050500 

Channel 6 Filter E alignment error flag Boolean Channel6/FilterE/AlignmentErrorFlag/6050600 

Channel 6 Gas W Concentration Float Channel6/GasW/Concentration/6060100 

Channel 6 Gas W Alarm HH occurred Boolean Channel6/GasW/AlarmHHOccurred/6060200 

Channel 6 Gas W Alarm H occurred Boolean Channel6/GasW/AlarmHOccurred/6060300 

Channel 6 Gas W Alarm L occurred Boolean Channel6/GasW/AlarmLOccurred/6060400 

Channel 6 Gas W Alarm LL occurred Boolean Channel6/GasW/AlarmLLOccurred/6060500 

Channel 6 Filter W alignment error flag Boolean Channel6/FilterW/AlignmentErrorFlag/6060600 

Channel 6 Pressure Float Channel6/Pressure/6500100 

Channel 6 Gas Monitor Air flag Boolean Channel6/GasMonitor/Airflag/6500200 

Channel 6 Gas Monitor Error flag Boolean Channel6/GasMonitor/Errorflag/6500300 

Channel 6 Gas Monitor Warning flag Boolean Channel6/GasMonitor/Warningflag/6500400 

Channel 6 Monitor Display Error Message String Channel6/GasMonitor/MonitorDisplayErrorMessage/6500500 

Channel 6 Monitor Display Warning Message String Channel6/GasMonitor/MonitorDisplayWarningMessage/6500600 

Channel 6 Multiplexer error flag Boolean Channel6/Multiplexer/errorflag/6600100 

Channel 6 Multiplexer warning flag Boolean Channel6/Multiplexer/warningflag/6600200 

Channel 6 Multiplexer error number Long Channel6/Multiplexer/errornumber/6600300 

Channel 6 Multiplexer warning number Long Channel6/Multiplexer/warningnumber/65600400 

Channel 6 Multiplexer Error Description String Channel6/Multiplexer/ErrorDescription/6600600 

Channel 6 Multiplexer Warning Description String Channel6/Multiplexer/WarningDescription/6600700 
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Channel 7 Gas A Concentration Float Channel7/GasA/Concentration/7010100 

Channel 7 Gas A Alarm HH occurred Boolean Channel7/GasA/AlarmHHOccurred/7010200 

Channel 7 Gas A Alarm H occurred Boolean Channel7/GasA/AlarmHOccurred/7010300 

Channel 7 Gas A Alarm L occurred Boolean Channel7/GasA/AlarmLOccurred/7010400 

Channel 7 Gas A Alarm LL occurred Boolean Channel7/GasA/AlarmLLOccurred/7010500 

Channel 7 Filter A alignment error flag Boolean Channel7/FilterA/AlignmentErrorFlag/7010600 

Channel 7 Gas B Concentration Float Channel7/GasB/Concentration/7020100 

Channel 7 Gas B Alarm HH occurred Boolean Channel7/GasB/AlarmHHOccurred/7020200 

Channel 7 Gas B Alarm H occurred Boolean Channel7/GasB/AlarmHOccurred/7020300 

Channel 7 Gas B Alarm L occurred Boolean Channel7/GasB/AlarmLOccurred/7020400 

Channel 7 Gas B Alarm LL occurred Boolean Channel7/GasB/AlarmLLOccurred/7020500 

Channel 7 Filter B alignment error flag Boolean Channel7/FilterB/AlignmentErrorFlag/7020600 

Channel 7 Gas C Concentration Float Channel7/GasC/Concentration/7030100 

Channel 7 Gas C Alarm HH occurred Boolean Channel7/GasC/AlarmHHOccurred/7030200 

Channel 7 Gas C Alarm H occurred Boolean Channel7/GasC/AlarmHOccurred/7030300 

Channel 7 Gas C Alarm L occurred Boolean Channel7/GasC/AlarmLOccurred/7030400 

Channel 7 Gas C Alarm LL occurred Boolean Channel7/GasC/AlarmLLOccurred/7030500 

Channel 7 Filter C alignment error flag Boolean Channel7/FilterC/AlignmentErrorFlag/7030600 

Channel 7 Gas D Concentration Float Channel7/GasD/Concentration/7040100 

Channel 7 Gas D Alarm HH occurred Boolean Channel7/GasD/AlarmHHOccurred/7040200 

Channel 7 Gas D Alarm H occurred Boolean Channel7/GasD/AlarmHOccurred/7040300 

Channel 7 Gas D Alarm L occurred Boolean Channel7/GasD/AlarmLOccurred/7040400 

Channel 7 Gas D Alarm LL occurred Boolean Channel7/GasD/AlarmLLOccurred/7040500 

Channel 7 Filter D alignment error flag Boolean Channel7/FilterD/AlignmentErrorFlag/7040600 

Channel 7 Gas E Concentration Float Channel7/GasE/Concentration/7050100 

Channel 7 Gas E Alarm HH occurred Boolean Channel7/GasE/AlarmHHOccurred/7050200 

Channel 7 Gas E Alarm H occurred Boolean Channel7/GasE/AlarmHOccurred/7050300 

Channel 7 Gas E Alarm L occurred Boolean Channel7/GasE/AlarmLOccurred/7050400 

Channel 7 Gas E Alarm LL occurred Boolean Channel7/GasE/AlarmLLOccurred/7050500 

Channel 7 Filter E alignment error flag Boolean Channel7/FilterE/AlignmentErrorFlag/7050600 

Channel 7 Gas W Concentration Float Channel7/GasW/Concentration/7060100 

Channel 7 Gas W Alarm HH occurred Boolean Channel7/GasW/AlarmHHOccurred/7060200 

Channel 7 Gas W Alarm H occurred Boolean Channel7/GasW/AlarmHOccurred/7060300 

Channel 7 Gas W Alarm L occurred Boolean Channel7/GasW/AlarmLOccurred/7060400 

Channel 7 Gas W Alarm LL occurred Boolean Channel7/GasW/AlarmLLOccurred/7060500 

Channel 7 Filter W alignment error flag Boolean Channel7/FilterW/AlignmentErrorFlag/7060600 

Channel 7 Pressure Float Channel7/Pressure/7500100 

Channel 7 Gas Monitor Air flag Boolean Channel7/GasMonitor/Airflag/7500200 

Channel 7 Gas Monitor Error flag Boolean Channel7/GasMonitor/Errorflag/7500300 

Channel 7 Gas Monitor Warning flag Boolean Channel7/GasMonitor/Warningflag/7500400 

Channel 7 Monitor Display Error Message String Channel7/GasMonitor/MonitorDisplayErrorMessage/7500500 

Channel 7 Monitor Display Warning Message String Channel7/GasMonitor/MonitorDisplayWarningMessage/7500600 

Channel 7 Multiplexer error flag Boolean Channel7/Multiplexer/errorflag/7600100 

Channel 7 Multiplexer warning flag Boolean Channel7/Multiplexer/warningflag/7600200 

Channel 7 Multiplexer error number Long Channel7/Multiplexer/errornumber/7600300 

Channel 7 Multiplexer warning number Long Channel7/Multiplexer/warningnumber/7600400 

Channel 7 Multiplexer Error Description String Channel1/Multiplexer/ErrorDescription/7600600 

Channel 7 Multiplexer Warning Description String Channel1/Multiplexer/WarningDescription/7600700 

Channel 8 Gas A Concentration Float Channel8/GasA/Concentration/8010100 

Channel 8 Gas A Alarm HH occurred Boolean Channel8/GasA/AlarmHHOccurred/8010200 

Channel 8 Gas A Alarm H occurred Boolean Channel8/GasA/AlarmHOccurred/8010300 

Channel 8 Gas A Alarm L occurred Boolean Channel8/GasA/AlarmLOccurred/8010400 



Appendix C 

_______________________________________________________________________ 

_______________________________________________________________________ 
BE6051-14 LumaSoft Gas Software LumaSense Technologies A/S 

 7820 and 7880 Page 198 of 215 

Channel 8 Gas A Alarm LL occurred Boolean Channel8/GasA/AlarmLLOccurred/8010500 

Channel 8 Filter A alignment error flag Boolean Channel8/FilterA/AlignmentErrorFlag/8010600 

Channel 8 Gas B Concentration Float Channel8/GasB/Concentration/8020100 

Channel 8 Gas B Alarm HH occurred Boolean Channel8/GasB/AlarmHHOccurred/8020200 

Channel 8 Gas B Alarm H occurred Boolean Channel8/GasB/AlarmHOccurred/8020300 

Channel 8 Gas B Alarm L occurred Boolean Channel8/GasB/AlarmLOccurred/8020400 

Channel 8 Gas B Alarm LL occurred Boolean Channel8/GasB/AlarmLLOccurred/8020500 

Channel 8 Filter B alignment error flag Boolean Channel8/FilterB/AlignmentErrorFlag/8020600 

Channel 8 Gas C Concentration Float Channel8/GasC/Concentration/8030100 

Channel 8 Gas C Alarm HH occurred Boolean Channel8/GasC/AlarmHHOccurred/8030200 

Channel 8 Gas C Alarm H occurred Boolean Channel8/GasC/AlarmHOccurred/8030300 

Channel 8 Gas C Alarm L occurred Boolean Channel8/GasC/AlarmLOccurred/8030400 

Channel 8 Gas C Alarm LL occurred Boolean Channel8/GasC/AlarmLLOccurred/8030500 

Channel 8 Filter C alignment error flag Boolean Channel8/FilterC/AlignmentErrorFlag/8030600 

Channel 8 Gas D Concentration Float Channel8/GasD/Concentration/8040100 

Channel 8 Gas D Alarm HH occurred Boolean Channel8/GasD/AlarmHHOccurred/8040200 

Channel 8 Gas D Alarm H occurred Boolean Channel8/GasD/AlarmHOccurred/8040300 

Channel 8 Gas D Alarm L occurred Boolean Channel8/GasD/AlarmLOccurred/8040400 

Channel 8 Gas D Alarm LL occurred Boolean Channel8/GasD/AlarmLLOccurred/8040500 

Channel 8 Filter D alignment error flag Boolean Channel8/FilterD/AlignmentErrorFlag/8040600 

Channel 8 Gas E Concentration Float Channel8/GasE/Concentration/8050100 

Channel 8 Gas E Alarm HH occurred Boolean Channel8/GasE/AlarmHHOccurred/8050200 

Channel 8 Gas E Alarm H occurred Boolean Channel8/GasE/AlarmHOccurred/8050300 

Channel 8 Gas E Alarm L occurred Boolean Channel8/GasE/AlarmLOccurred/8050400 

Channel 8 Gas E Alarm LL occurred Boolean Channel8/GasE/AlarmLLOccurred/8050500 

Channel 8 Filter E alignment error flag Boolean Channel8/FilterE/AlignmentErrorFlag/8050600 

Channel 8 Gas W Concentration Float Channel8/GasW/Concentration/8060100 

Channel 8 Gas W Alarm HH occurred Boolean Channel8/GasW/AlarmHHOccurred/8060200 

Channel 8 Gas W Alarm H occurred Boolean Channel8/GasW/AlarmHOccurred/8060300 

Channel 8 Gas W Alarm L occurred Boolean Channel8/GasW/AlarmLOccurred/8060400 

Channel 8 Gas W Alarm LL occurred Boolean Channel8/GasW/AlarmLLOccurred/8060500 

Channel 8 Filter W alignment error flag Boolean Channel8/FilterW/AlignmentErrorFlag/8060600 

Channel 8 Pressure Float Channel8/Pressure/8500100 

Channel 8 Gas Monitor Air flag Boolean Channel8/GasMonitor/Airflag/8500200 

Channel 8 Gas Monitor Error flag Boolean Channel8/GasMonitor/Errorflag/8500300 

Channel 8 Gas Monitor Warning flag Boolean Channel8/GasMonitor/Warningflag/8500400 

Channel 8 Monitor Display Error Message String Channel8/GasMonitor/MonitorDisplayErrorMessage/8500500 

Channel 8 Monitor Display Warning Message String Channel8/GasMonitor/MonitorDisplayWarningMessage/8500600 

Channel 8 Multiplexer error flag Boolean Channel8/Multiplexer/errorflag/8600100 

Channel 8 Multiplexer warning flag Boolean Channel8/Multiplexer/warningflag/8600200 

Channel 8 Multiplexer error number Long Channel8/Multiplexer/errornumber/8600300 

Channel 8 Multiplexer warning number Long Channel8/Multiplexer/warningnumber/8600400 

Channel 8 Multiplexer Error Description String Channel8/Multiplexer/ErrorDescription/8600600 

Channel 8 Multiplexer Warning Description String Channel8/Multiplexer/WarningDescription/8600700 

Channel 9 Gas A Concentration Float Channel9/GasA/Concentration/9010100 

Channel 9 Gas A Alarm HH occurred Boolean Channel9/GasA/AlarmHHOccurred/9010200 

Channel 9 Gas A Alarm H occurred Boolean Channel9/GasA/AlarmHOccurred/9010300 

Channel 9 Gas A Alarm L occurred Boolean Channel9/GasA/AlarmLOccurred/9010400 

Channel 9 Gas A Alarm LL occurred Boolean Channel9/GasA/AlarmLLOccurred/9010500 

Channel 9 Filter A alignment error flag Boolean Channel9/FilterA/AlignmentErrorFlag/9010600 

Channel 9 Gas B Concentration Float Channel9/GasB/Concentration/9020100 

Channel 9 Gas B Alarm HH occurred Boolean Channel9/GasB/AlarmHHOccurred/9020200 
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Channel 9 Gas B Alarm H occurred Boolean Channel9/GasB/AlarmHOccurred/9020300 

Channel 9 Gas B Alarm L occurred Boolean Channel9/GasB/AlarmLOccurred/9020400 

Channel 9 Gas B Alarm LL occurred Boolean Channel9/GasB/AlarmLLOccurred/9020500 

Channel 9 Filter B alignment error flag Boolean Channel9/FilterB/AlignmentErrorFlag/9020600 

Channel 9 Gas C Concentration Float Channel9/GasC/Concentration/9030100 

Channel 9 Gas C Alarm HH occurred Boolean Channel9/GasC/AlarmHHOccurred/9030200 

Channel 9 Gas C Alarm H occurred Boolean Channel9/GasC/AlarmHOccurred/9030300 

Channel 9 Gas C Alarm L occurred Boolean Channel9/GasC/AlarmLOccurred/9030400 

Channel 9 Gas C Alarm LL occurred Boolean Channel9/GasC/AlarmLLOccurred/9030500 

Channel 9 Filter C alignment error flag Boolean Channel9/FilterC/AlignmentErrorFlag/9030600 

Channel 9 Gas D Concentration Float Channel9/GasD/Concentration/9040100 

Channel 9 Gas D Alarm HH occurred Boolean Channel9/GasD/AlarmHHOccurred/9040200 

Channel 9 Gas D Alarm H occurred Boolean Channel9/GasD/AlarmHOccurred/9040300 

Channel 9 Gas D Alarm L occurred Boolean Channel9/GasD/AlarmLOccurred/9040400 

Channel 9 Gas D Alarm LL occurred Boolean Channel9/GasD/AlarmLLOccurred/9040500 

Channel 9 Filter D alignment error flag Boolean Channel9/FilterD/AlignmentErrorFlag/9040600 

Channel 9 Gas E Concentration Float Channel9/GasE/Concentration/9050100 

Channel 9 Gas E Alarm HH occurred Boolean Channel9/GasE/AlarmHHOccurred/9050200 

Channel 9 Gas E Alarm H occurred Boolean Channel9/GasE/AlarmHOccurred/9050300 

Channel 9 Gas E Alarm L occurred Boolean Channel9/GasE/AlarmLOccurred/9050400 

Channel 9 Gas E Alarm LL occurred Boolean Channel9/GasE/AlarmLLOccurred/9050500 

Channel 9 Filter E alignment error flag Boolean Channel9/FilterE/AlignmentErrorFlag/9050600 

Channel 9 Gas W Concentration Float Channel9/GasW/Concentration/9060100 

Channel 9 Gas W Alarm HH occurred Boolean Channel9/GasW/AlarmHHOccurred/9060200 

Channel 9 Gas W Alarm H occurred Boolean Channel9/GasW/AlarmHOccurred/9060300 

Channel 9 Gas W Alarm L occurred Boolean Channel9/GasW/AlarmLOccurred/9060400 

Channel 9 Gas W Alarm LL occurred Boolean Channel9/GasW/AlarmLLOccurred/9060500 

Channel 9 Filter W alignment error flag Boolean Channel9/FilterW/AlignmentErrorFlag/9060600 

Channel 9 Pressure Float Channel9/Pressure/9500100 

Channel 9 Gas Monitor Air flag Boolean Channel9/GasMonitor/Airflag/9500200 

Channel 9 Gas Monitor Error flag Boolean Channel9/GasMonitor/Errorflag/9500300 

Channel 9 Gas Monitor Warning flag Boolean Channel9/GasMonitor/Warningflag/9500400 

Channel 9 Monitor Display Error Message String Channel9/GasMonitor/MonitorDisplayErrorMessage/9500500 

Channel 9 Monitor Display Warning Message String Channel9/GasMonitor/MonitorDisplayWarningMessage/9500600 

Channel 9 Multiplexer error flag Boolean Channel9/Multiplexer/errorflag/9600100 

Channel 9 Multiplexer warning flag Boolean Channel9/Multiplexer/warningflag/9600200 

Channel 9 Multiplexer error number Long Channel9/Multiplexer/errornumber/9600300 

Channel 9 Multiplexer warning number Long Channel9/Multiplexer/warning number/9600400                                                

Channel 9 Multiplexer Error Description String Channel9/Multiplexer/ErrorDescription/9600600 

Channel 9 Multiplexer Warning Description String Channel9/Multiplexer/WarningDescription/9600700 

Channel 10 Gas A Concentration Float Channel10/GasA/Concentration/10010100 

Channel 10 Gas A Alarm HH occurred Boolean Channel10/GasA/AlarmHHOccurred/10010200 

Channel 10 Gas A Alarm H occurred Boolean Channel10/GasA/AlarmHOccurred/10010300 

Channel 10 Gas A Alarm L occurred Boolean Channel10/GasA/AlarmLOccurred/10010400 

Channel 10 Gas A Alarm LL occurred Boolean Channel10/GasA/AlarmLLOccurred/10010500 

Channel 10 Filter A alignment error flag Boolean Channel10/FilterA/AlignmentErrorFlag/10010600 

Channel 10 Gas B Concentration Float Channel10/GasB/Concentration/10020100 

Channel 10 Gas B Alarm HH occurred Boolean Channel10/GasB/AlarmHHOccurred/10020200 

Channel 10 Gas B Alarm H occurred Boolean Channel10/GasB/AlarmHOccurred/10020300 

Channel 10 Gas B Alarm L occurred Boolean Channel10/GasB/AlarmLOccurred/10020400 

Channel 10 Gas B Alarm LL occurred Boolean Channel10/GasB/AlarmLLOccurred/10020500 

Channel 10 Filter B alignment error flag Boolean Channel10/FilterB/AlignmentErrorFlag/10020600 
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Channel 10 Gas C Concentration Float Channel10/GasC/Concentration/10030100 

Channel 10 Gas C Alarm HH occurred Boolean Channel10/GasC/AlarmHHOccurred/10030200 

Channel 10 Gas C Alarm H occurred Boolean Channel10/GasC/AlarmHOccurred/10030300 

Channel 10 Gas C Alarm L occurred Boolean Channel10/GasC/AlarmLOccurred/10030400 

Channel 10 Gas C Alarm LL occurred Boolean Channel10/GasC/AlarmLLOccurred/10030500 

Channel 10 Filter C alignment error flag Boolean Channel10/FilterC/AlignmentErrorFlag/10030600 

Channel 10 Gas D Concentration Float Channel10/GasD/Concentration/10040100 

Channel 10 Gas D Alarm HH occurred Boolean Channel10/GasD/AlarmHHOccurred/10040200 

Channel 10 Gas D Alarm H occurred Boolean Channel10/GasD/AlarmHOccurred/10040300 

Channel 10 Gas D Alarm L occurred Boolean Channel10/GasD/AlarmLOccurred/10040400 

Channel 10 Gas D Alarm LL occurred Boolean Channel10/GasD/AlarmLLOccurred/10040500 

Channel 10 Filter D alignment error flag Boolean Channel10/FilterD/AlignmentErrorFlag/10040600 

Channel 10 Gas E Concentration Float Channel10/GasE/Concentration/10050100 

Channel 10 Gas E Alarm HH occurred Boolean Channel10/GasE/AlarmHHOccurred/10050200 

Channel 10 Gas E Alarm H occurred Boolean Channel10/GasE/AlarmHOccurred/10050300 

Channel 10 Gas E Alarm L occurred Boolean Channel10/GasE/AlarmLOccurred/10050400 

Channel 10 Gas E Alarm LL occurred Boolean Channel10/GasE/AlarmLLOccurred/10050500 

Channel 10 Filter E alignment error flag Boolean Channel10/FilterE/AlignmentErrorFlag/10050600 

Channel 10 Gas W Concentration Float Channel10/GasW/Concentration/10060100 

Channel 10 Gas W Alarm HH occurred Boolean Channel10/GasW/AlarmHHOccurred/10060200 

Channel 10 Gas W Alarm H occurred Boolean Channel10/GasW/AlarmHOccurred/10060300 

Channel 10 Gas W Alarm L occurred Boolean Channel10/GasW/AlarmLOccurred/10060400 

Channel 10 Gas W Alarm LL occurred Boolean Channel10/GasW/AlarmLLOccurred/10060500 

Channel 10 Filter W alignment error flag Boolean Channel10/FilterW/AlignmentErrorFlag/10060600 

Channel 10 Pressure Float Channel10/Pressure/10500100 

Channel 10 Gas Monitor Air flag Boolean Channel10/GasMonitor/Airflag/10500200 

Channel 10 Gas Monitor Error flag Boolean Channel10/GasMonitor/Errorflag/10500300 

Channel 10 Gas Monitor Warning flag Boolean Channel10/GasMonitor/Warningflag/10500400 

Channel 10 Monitor Display Error Message String Channel10/GasMonitor/MonitorDisplayErrorMessage/10500500 

Channel 10 Monitor Display Warning Message String Channel10/GasMonitor/MonitorDisplayWarningMessage/10500600 

Channel 10 Multiplexer error flag Boolean Channel10/Multiplexer/errorflag/10600100 

Channel 10 Multiplexer warning flag Boolean Channel10/Multiplexer/warningflag/10600200 

Channel 10 Multiplexer error number Long Channel10/Multiplexer/errornumber/10600300 

Channel 10 Multiplexer warning number Long Channel10/Multiplexer/warningnumber/10600400 

Channel 10 Multiplexer Error Description String Channel10/Multiplexer/ErrorDescription/10600600 

Channel 10 Multiplexer Warning Description String Channel10/Multiplexer/WarningDescription/10600700 

Channel 11 Gas A Concentration Float Channel11/GasA/Concentration/11010100 

Channel 11 Gas A Alarm HH occurred Boolean Channel11/GasA/AlarmHHOccurred/11010200 

Channel 11 Gas A Alarm H occurred Boolean Channel11/GasA/AlarmHOccurred/11010300 

Channel 11 Gas A Alarm L occurred Boolean Channel11/GasA/AlarmLOccurred/11010400 

Channel 11 Gas A Alarm LL occurred Boolean Channel11/GasA/AlarmLLOccurred/11010500 

Channel 11 Filter A alignment error flag Boolean Channel11/FilterA/AlignmentErrorFlag/11010600 

Channel 11 Gas B Concentration Float Channel11/GasB/Concentration/11020100 

Channel 11 Gas B Alarm HH occurred Boolean Channel11/GasB/AlarmHHOccurred/11020200 

Channel 11 Gas B Alarm H occurred Boolean Channel11/GasB/AlarmHOccurred/11020300 

Channel 11 Gas B Alarm L occurred Boolean Channel11/GasB/AlarmLOccurred/11020400 

Channel 11 Gas B Alarm LL occurred Boolean Channel11/GasB/AlarmLLOccurred/11020500 

Channel 11 Filter B alignment error flag Boolean Channel11/FilterB/AlignmentErrorFlag/11020600 

Channel 11 Gas C Concentration Float Channel11/GasC/Concentration/11030100 

Channel 11 Gas C Alarm HH occurred Boolean Channel11/GasC/AlarmHHOccurred/11030200 

Channel 11 Gas C Alarm H occurred Boolean Channel11/GasC/AlarmHOccurred/11030300 

Channel 11 Gas C Alarm L occurred Boolean Channel11/GasC/AlarmLOccurred/11030400 
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Channel 11 Gas C Alarm LL occurred Boolean Channel11/GasC/AlarmLLOccurred/11030500 

Channel 11 Filter C alignment error flag Boolean Channel11/FilterC/AlignmentErrorFlag/11030600 

Channel 11 Gas D Concentration Float Channel11/GasD/Concentration/11040100 

Channel 11 Gas D Alarm HH occurred Boolean Channel11/GasD/AlarmHHOccurred/11040200 

Channel 11 Gas D Alarm H occurred Boolean Channel11/GasD/AlarmHOccurred/11040300 

Channel 11 Gas D Alarm L occurred Boolean Channel11/GasD/AlarmLOccurred/11040400 

Channel 11 Gas D Alarm LL occurred Boolean Channel11/GasD/AlarmLLOccurred/11040500 

Channel 11 Filter D alignment error flag Boolean Channel11/FilterD/AlignmentErrorFlag/11040600 

Channel 11 Gas E Concentration Float Channel11/GasE/Concentration/11050100 

Channel 11 Gas E Alarm HH occurred Boolean Channel11/GasE/AlarmHHOccurred/11050200 

Channel 11 Gas E Alarm H occurred Boolean Channel11/GasE/AlarmHOccurred/11050300 

Channel 11 Gas E Alarm L occurred Boolean Channel11/GasE/AlarmLOccurred/11050400 

Channel 11 Gas E Alarm LL occurred Boolean Channel11/GasE/AlarmLLOccurred/11050500 

Channel 11 Filter E alignment error flag Boolean Channel11/FilterE/AlignmentErrorFlag/11050600 

Channel 11 Gas W Concentration Float Channel11/GasW/Concentration/11060100 

Channel 11 Gas W Alarm HH occurred Boolean Channel11/GasW/AlarmHHOccurred/11060200 

Channel 11 Gas W Alarm H occurred Boolean Channel11/GasW/AlarmHOccurred/11060300 

Channel 11 Gas W Alarm L occurred Boolean Channel11/GasW/AlarmLOccurred/11060400 

Channel 11 Gas W Alarm LL occurred Boolean Channel11/GasW/AlarmLLOccurred/11060500 

Channel 11 Filter W alignment error flag Boolean Channel11/FilterW/AlignmentErrorFlag/11060600 

Channel 11 Pressure Float Channel11/Pressure/11500100 

Channel 11 Gas Monitor Air flag Boolean Channel11/GasMonitor/Airflag/11500200 

Channel 11 Gas Monitor Error flag Boolean Channel11/GasMonitor/Errorflag/11500300 

Channel 11 Gas Monitor Warning flag Boolean Channel11/GasMonitor/Warningflag/11500400 

Channel 11 Monitor Display Error Message String Channel11/GasMonitor/MonitorDisplayErrorMessage/11500500 

Channel 11 Monitor Display Warning Message String Channel11/GasMonitor/MonitorDisplayWarningMessage/11500600 

Channel 11 Multiplexer error flag Boolean Channel11/Multiplexer/errorflag/11600100 

Channel 11 Multiplexer warning flag Boolean Channel11/Multiplexer/warningflag/11600200 

Channel 11 Multiplexer error number Long Channel11/Multiplexer/errornumber/11600300 

Channel 11 Multiplexer warning number Long Channel11/Multiplexer/warningnumber/11600400 

Channel 11 Multiplexer Error Description String Channel11/Multiplexer/ErrorDescription/11600600 

Channel 11 Multiplexer Warning Description String Channel11/Multiplexer/WarningDescription/11600700 

Channel 12 Gas A Concentration           Float Channel12/GasA/Concentration/12010100 

Channel 12 Gas A Alarm HH occurred       Boolean Channel12/GasA/AlarmHHOccurred/12010200 

Channel 12 Gas A Alarm H occurred        Boolean Channel12/GasA/AlarmHOccurred/12010300 

Channel 12 Gas A Alarm L occurred        Boolean Channel12/GasA/AlarmLOccurred/12010400 

Channel 12 Gas A Alarm LL occurred       Boolean Channel12/GasA/AlarmLLOccurred/12010500 

Channel 12 Filter A alignment error flag Boolean Channel12/FilterA/AlignmentErrorFlag/12010600 

Channel 12 Gas B Concentration           Float Channel12/GasB/Concentration/12020100 

Channel 12 Gas B Alarm HH occurred       Boolean Channel12/GasB/AlarmHHOccurred/12020200 

Channel 12 Gas B Alarm H occurred        Boolean Channel12/GasB/AlarmHOccurred/12020300 

Channel 12 Gas B Alarm L occurred        Boolean Channel12/GasB/AlarmLOccurred/12020400 

Channel 12 Gas B Alarm LL occurred       Boolean Channel12/GasB/AlarmLLOccurred/12020500 

Channel 12 Filter B alignment error flag Boolean Channel12/FilterB/AlignmentErrorFlag/12020600 

Channel 12 Gas C Concentration           Float Channel12/GasC/Concentration/12030100 

Channel 12 Gas C Alarm HH occurred       Boolean Channel12/GasC/AlarmHHOccurred/12030200 

Channel 12 Gas C Alarm H occurred        Boolean Channel12/GasC/AlarmHOccurred/12030300 

Channel 12 Gas C Alarm L occurred        Boolean Channel12/GasC/AlarmLOccurred/12030400 

Channel 12 Gas C Alarm LL occurred       Boolean Channel12/GasC/AlarmLLOccurred/12030500 

Channel 12 Filter C alignment error flag Boolean Channel12/FilterC/AlignmentErrorFlag/12030600 

Channel 12 Gas D Concentration           Float Channel12/GasD/Concentration/12040100 

Channel 12 Gas D Alarm HH occurred       Boolean Channel12/GasD/AlarmHHOccurred/12040200 
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Channel 12 Gas D Alarm H occurred        Boolean Channel12/GasD/AlarmHOccurred/12040300 

Channel 12 Gas D Alarm L occurred        Boolean Channel12/GasD/AlarmLOccurred/12040400 

Channel 12 Gas D Alarm LL occurred       Boolean Channel12/GasD/AlarmLLOccurred/12040500 

Channel 12 Filter D alignment error flag Boolean Channel12/FilterD/AlignmentErrorFlag/12040600 

Channel 12 Gas E Concentration           Float Channel12/GasE/Concentration/12050100 

Channel 12 Gas E Alarm HH occurred       Boolean Channel12/GasE/AlarmHHOccurred/12050200 

Channel 12 Gas E Alarm H occurred        Boolean Channel12/GasE/AlarmHOccurred/12050300 

Channel 12 Gas E Alarm L occurred        Boolean Channel12/GasE/AlarmLOccurred/12050400 

Channel 12 Gas E Alarm LL occurred       Boolean Channel12/GasE/AlarmLLOccurred/12050500 

Channel 12 Filter E alignment error flag Boolean Channel12/FilterE/AlignmentErrorFlag/12050600 

Channel 12 Gas W Concentration           Float Channel12/GasW/Concentration/12060100 

Channel 12 Gas W Alarm HH occurred       Boolean Channel12/GasW/AlarmHHOccurred/12060200 

Channel 12 Gas W Alarm H occurred        Boolean Channel12/GasW/AlarmHOccurred/12060300 

Channel 12 Gas W Alarm L occurred        Boolean Channel12/GasW/AlarmLOccurred/12060400 

Channel 12 Gas W Alarm LL occurred       Boolean Channel12/GasW/AlarmLLOccurred/12060500 

Channel 12 Filter W alignment error flag Boolean Channel12/FilterW/AlignmentErrorFlag/12060600 

Channel 12 Pressure                      Float Channel12/Pressure/12500100 

Channel 12 Gas Monitor Air flag          Boolean Channel12/GasMonitor/Airflag/12500200 

Channel 12 Gas Monitor Error flag        Boolean Channel12/GasMonitor/Errorflag/12500300 

Channel 12 Gas Monitor Warning flag      Boolean Channel12/GasMonitor/Warningflag/12500400 

Channel 12 Monitor Display Error Message String Channel12/GasMonitor/MonitorDisplayErrorMessage/12500500 

Channel 12 Monitor Display Warning Message String Channel12/GasMonitor/MonitorDisplayWarningMessage/12500600 

Channel 12 Multiplexer error flag        Boolean Channel12/Multiplexer/errorflag/12600100 

Channel 12 Multiplexer warning flag      Boolean Channel12/Multiplexer/warningflag/12600200 

Channel 12 Multiplexer error number      Long Channel12/Multiplexer/errornumber/12600300 

Channel 12 Multiplexer warning number    Long Channel12/Multiplexer/warningnumber/12600400 

Channel 12 Multiplexer Error Description String Channel12/Multiplexer/ErrorDescription/12600600 

Channel 12 Multiplexer Warning Description String Channel12/Multiplexer/WarningDescription/12600700 

Channel 13 Gas A Concentration           Float Channel13/GasA/Concentration/13010100 

Channel 13 Gas A Alarm HH occurred       Boolean Channel13/GasA/AlarmHHOccurred/13010200 

Channel 13 Gas A Alarm H occurred        Boolean Channel13/GasA/AlarmHOccurred/13010300 

Channel 13 Gas A Alarm L occurred        Boolean Channel13/GasA/AlarmLOccurred/13010400 

Channel 13 Gas A Alarm LL occurred       Boolean Channel13/GasA/AlarmLLOccurred/13010500 

Channel 13 Filter A alignment error flag Boolean Channel13/FilterA/AlignmentErrorFlag/13010600 

Channel 13 Gas B Concentration           Float Channel13/GasB/Concentration/13020100 

Channel 13 Gas B Alarm HH occurred       Boolean Channel13/GasB/AlarmHHOccurred/13020200 

Channel 13 Gas B Alarm H occurred        Boolean Channel13/GasB/AlarmHOccurred/13020300 

Channel 13 Gas B Alarm L occurred        Boolean Channel13/GasB/AlarmLOccurred/13020400 

Channel 13 Gas B Alarm LL occurred       Boolean Channel13/GasB/AlarmLLOccurred/13020500 

Channel 13 Filter B alignment error flag Boolean Channel13/FilterB/AlignmentErrorFlag/13020600 

Channel 13 Gas C Concentration           Float Channel13/GasC/Concentration/13030100 

Channel 13 Gas C Alarm HH occurred       Boolean Channel13/GasC/AlarmHHOccurred/13030200 

Channel 13 Gas C Alarm H occurred        Boolean Channel13/GasC/AlarmHOccurred/13030300 

Channel 13 Gas C Alarm L occurred        Boolean Channel13/GasC/AlarmLOccurred/13030400 

Channel 13 Gas C Alarm LL occurred       Boolean Channel13/GasC/AlarmLLOccurred/13030500 

Channel 13 Filter C alignment error flag Boolean Channel13/FilterC/AlignmentErrorFlag/13030600 

Channel 13 Gas D Concentration           Float Channel13/GasD/Concentration/13040100 

Channel 13 Gas D Alarm HH occurred       Boolean Channel13/GasD/AlarmHHOccurred/13040200 

Channel 13 Gas D Alarm H occurred        Boolean Channel13/GasD/AlarmHOccurred/13040300 

Channel 13 Gas D Alarm L occurred        Boolean Channel13/GasD/AlarmLOccurred/13040400 

Channel 13 Gas D Alarm LL occurred       Boolean Channel13/GasD/AlarmLLOccurred/13040500 

Channel 13 Filter D alignment error flag Boolean Channel13/FilterD/AlignmentErrorFlag/13040600 
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Channel 13 Gas E Concentration           Float Channel13/GasE/Concentration/13050100 

Channel 13 Gas E Alarm HH occurred       Boolean Channel13/GasE/AlarmHHOccurred/13050200 

Channel 13 Gas E Alarm H occurred        Boolean Channel13/GasE/AlarmHOccurred/13050300 

Channel 13 Gas E Alarm L occurred        Boolean Channel13/GasE/AlarmLOccurred/13050400 

Channel 13 Gas E Alarm LL occurred       Boolean Channel13/GasE/AlarmLLOccurred/13050500 

Channel 13 Filter E alignment error flag Boolean Channel13/FilterE/AlignmentErrorFlag/13050600 

Channel 13 Gas W Concentration           Float Channel13/GasW/Concentration/13060100 

Channel 13 Gas W Alarm HH occurred       Boolean Channel13/GasW/AlarmHHOccurred/13060200 

Channel 13 Gas W Alarm H occurred        Boolean Channel13/GasW/AlarmHOccurred/13060300 

Channel 13 Gas W Alarm L occurred        Boolean Channel13/GasW/AlarmLOccurred/13060400 

Channel 13 Gas W Alarm LL occurred       Boolean Channel13/GasW/AlarmLLOccurred/13060500 

Channel 13 Filter W alignment error flag Boolean Channel13/FilterW/AlignmentErrorFlag/13060600 

Channel 13 Pressure                      Float Channel13/Pressure/13500100 

Channel 13 Gas Monitor Air flag          Boolean Channel13/GasMonitor/Airflag/13500200 

Channel 13 Gas Monitor Error flag        Boolean Channel13/GasMonitor/Errorflag/13500300 

Channel 13 Gas Monitor Warning flag      Boolean Channel13/GasMonitor/Warningflag/13500400 

Channel 13 Monitor Display Error Message String Channel13/GasMonitor/MonitorDisplayErrorMessage/13500500 

Channel 13 Monitor Display Warning Message String Channel13/GasMonitor/MonitorDisplayWarningMessage/13500600 

Channel 13 Multiplexer error flag        Boolean Channel13/Multiplexer/errorflag/13600100 

Channel 13 Multiplexer warning flag      Boolean Channel13/Multiplexer/warningflag/13600200 

Channel 13 Multiplexer error number      Long Channel13/Multiplexer/errornumber/13600300 

Channel 13 Multiplexer warning number    Long Channel13/Multiplexer/warningnumber/13600400 

Channel 13 Multiplexer Error Description String Channel13/Multiplexer/ErrorDescription/13600600 

Channel 13 Multiplexer Warning Description String Channel13/Multiplexer/WarningDescription/13600700 

Channel 14 Gas A Concentration Float Channel14/GasA/Concentration/14010100 

Channel 14 Gas A Alarm HH occurred Boolean Channel14/GasA/AlarmHHOccurred/14010200 

Channel 14 Gas A Alarm H occurred Boolean Channel14/GasA/AlarmHOccurred/14010300 

Channel 14 Gas A Alarm L occurred Boolean Channel14/GasA/AlarmLOccurred/14010400 

Channel 14 Gas A Alarm LL occurred Boolean Channel14/GasA/AlarmLLOccurred/14010500 

Channel 14 Filter A alignment error flag Boolean Channel14/FilterA/AlignmentErrorFlag/14010600 

Channel 14 Gas B Concentration Float Channel14/GasB/Concentration/14020100 

Channel 14 Gas B Alarm HH occurred Boolean Channel14/GasB/AlarmHHOccurred/14020200 

Channel 14 Gas B Alarm H occurred Boolean Channel14/GasB/AlarmHOccurred/14020300 

Channel 14 Gas B Alarm L occurred Boolean Channel14/GasB/AlarmLOccurred/14020400 

Channel 14 Gas B Alarm LL occurred Boolean Channel14/GasB/AlarmLLOccurred/14020500 

Channel 14 Filter B alignment error flag Boolean Channel14/FilterB/AlignmentErrorFlag/14020600 

Channel 14 Gas C Concentration Float Channel14/GasC/Concentration/14030100 

Channel 14 Gas C Alarm HH occurred Boolean Channel14/GasC/AlarmHHOccurred/14030200 

Channel 14 Gas C Alarm H occurred Boolean Channel14/GasC/AlarmHOccurred/14030300 

Channel 14 Gas C Alarm L occurred Boolean Channel14/GasC/AlarmLOccurred/14030400 

Channel 14 Gas C Alarm LL occurred Boolean Channel14/GasC/AlarmLLOccurred/14030500 

Channel 14 Filter C alignment error flag Boolean Channel14/FilterC/AlignmentErrorFlag/14030600 

Channel 14 Gas D Concentration Float Channel14/GasD/Concentration/14040100 

Channel 14 Gas D Alarm HH occurred Boolean Channel14/GasD/AlarmHHOccurred/14040200 

Channel 14 Gas D Alarm H occurred Boolean Channel14/GasD/AlarmHOccurred/14040300 

Channel 14 Gas D Alarm L occurred Boolean Channel14/GasD/AlarmLOccurred/14040400 

Channel 14 Gas D Alarm LL occurred Boolean Channel14/GasD/AlarmLLOccurred/14040500 

Channel 14 Filter D alignment error flag Boolean Channel14/FilterD/AlignmentErrorFlag/14040600 

Channel 14 Gas E Concentration Float Channel14/GasE/Concentration/14050100 

Channel 14 Gas E Alarm HH occurred Boolean Channel14/GasE/AlarmHHOccurred/14050200 

Channel 14 Gas E Alarm H occurred Boolean Channel14/GasE/AlarmHOccurred/14050300 

Channel 14 Gas E Alarm L occurred Boolean Channel14/GasE/AlarmLOccurred/14050400 
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Channel 14 Gas E Alarm LL occurred Boolean Channel14/GasE/AlarmLLOccurred/14050500 

Channel 14 Filter E alignment error flag Boolean Channel14/FilterE/AlignmentErrorFlag/14050600 

Channel 14 Gas W Concentration Float Channel14/GasW/Concentration/14060100 

Channel 14 Gas W Alarm HH occurred Boolean Channel14/GasW/AlarmHHOccurred/14060200 

Channel 14 Gas W Alarm H occurred Boolean Channel14/GasW/AlarmHOccurred/14060300 

Channel 14 Gas W Alarm L occurred Boolean Channel14/GasW/AlarmLOccurred/14060400 

Channel 14 Gas W Alarm LL occurred Boolean Channel14/GasW/AlarmLLOccurred/14060500 

Channel 14 Filter W alignment error flag Boolean Channel14/FilterW/AlignmentErrorFlag/14060600 

Channel 14 Pressure Float Channel14/Pressure/14500100 

Channel 14 Gas Monitor Air flag Boolean Channel14/GasMonitor/Airflag/14500200 

Channel 14 Gas Monitor Error flag Boolean Channel14/GasMonitor/Errorflag/14500300 

Channel 14 Gas Monitor Warning flag Boolean Channel14/GasMonitor/Warningflag/14500400 

Channel 14 Monitor Display Error Message String Channel14/GasMonitor/MonitorDisplayErrorMessage/14500500 

Channel 14 Monitor Display Warning Message String Channel14/GasMonitor/MonitorDisplayWarningMessage/14500600 

Channel 14 Multiplexer error flag Boolean Channel14/Multiplexer/errorflag/14600100 

Channel 14 Multiplexer warning flag Boolean Channel14/Multiplexer/warningflag/14600200 

Channel 14 Multiplexer error number Long Channel14/Multiplexer/errornumber/14600300 

Channel 14 Multiplexer warning number Long Channel14/Multiplexer/warningnumber/14600400 

Channel 14 Multiplexer Error Description String Channel14/Multiplexer/ErrorDescription/14600600 

Channel 14 Multiplexer Warning Description String Channel14/Multiplexer/WarningDescription/14600700 

Channel 15 Gas A Concentration Float Channel15/GasA/Concentration/15010100 

Channel 15 Gas A Alarm HH occurred Boolean Channel15/GasA/AlarmHHOccurred/15010200 

Channel 15 Gas A Alarm H occurred Boolean Channel15/GasA/AlarmHOccurred/15010300 

Channel 15 Gas A Alarm L occurred Boolean Channel15/GasA/AlarmLOccurred/15010400 

Channel 15 Gas A Alarm LL occurred Boolean Channel15/GasA/AlarmLLOccurred/15010500 

Channel 15 Filter A alignment error flag Boolean Channel15/FilterA/AlignmentErrorFlag/15010600 

Channel 15 Gas B Concentration Float Channel15/GasB/Concentration/15020100 

Channel 15 Gas B Alarm HH occurred Boolean Channel15/GasB/AlarmHHOccurred/15020200 

Channel 15 Gas B Alarm H occurred Boolean Channel15/GasB/AlarmHOccurred/15020300 

Channel 15 Gas B Alarm L occurred Boolean Channel15/GasB/AlarmLOccurred/15020400 

Channel 15 Gas B Alarm LL occurred Boolean Channel15/GasB/AlarmLLOccurred/15020500 

Channel 15 Filter B alignment error flag Boolean Channel15/FilterB/AlignmentErrorFlag/15020600 

Channel 15 Gas C Concentration Float Channel15/GasC/Concentration/15030100 

Channel 15 Gas C Alarm HH occurred Boolean Channel15/GasC/AlarmHHOccurred/15030200 

Channel 15 Gas C Alarm H occurred Boolean Channel15/GasC/AlarmHOccurred/15030300 

Channel 15 Gas C Alarm L occurred Boolean Channel15/GasC/AlarmLOccurred/15030400 

Channel 15 Gas C Alarm LL occurred Boolean Channel15/GasC/AlarmLLOccurred/15030500 

Channel 15 Filter C alignment error flag Boolean Channel15/FilterC/AlignmentErrorFlag/15030600 

Channel 15 Gas D Concentration Float Channel15/GasD/Concentration/15040100 

Channel 15 Gas D Alarm HH occurred Boolean Channel15/GasD/AlarmHHOccurred/15040200 

Channel 15 Gas D Alarm H occurred Boolean Channel15/GasD/AlarmHOccurred/15040300 

Channel 15 Gas D Alarm L occurred Boolean Channel15/GasD/AlarmLOccurred/15040400 

Channel 15 Gas D Alarm LL occurred Boolean Channel15/GasD/AlarmLLOccurred/15040500 

Channel 15 Filter D alignment error flag Boolean Channel15/FilterD/AlignmentErrorFlag/15040600 

Channel 15 Gas E Concentration Float Channel15/GasE/Concentration/15050100 

Channel 15 Gas E Alarm HH occurred Boolean Channel15/GasE/AlarmHHOccurred/15050200 

Channel 15 Gas E Alarm H occurred Boolean Channel15/GasE/AlarmHOccurred/15050300 

Channel 15 Gas E Alarm L occurred Boolean Channel15/GasE/AlarmLOccurred/15050400 

Channel 15 Gas E Alarm LL occurred Boolean Channel15/GasE/AlarmLLOccurred/15050500 

Channel 15 Filter E alignment error flag Boolean Channel15/FilterE/AlignmentErrorFlag/15050600 

Channel 15 Gas W Concentration Float Channel15/GasW/Concentration/15060100 

Channel 15 Gas W Alarm HH occurred Boolean Channel15/GasW/AlarmHHOccurred/15060200 
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Channel 15 Gas W Alarm H occurred Boolean Channel15/GasW/AlarmHOccurred/15060300 

Channel 15 Gas W Alarm L occurred Boolean Channel15/GasW/AlarmLOccurred/15060400 

Channel 15 Gas W Alarm LL occurred Boolean Channel15/GasW/AlarmLLOccurred/15060500 

Channel 15 Filter W alignment error flag Boolean Channel15/FilterW/AlignmentErrorFlag/15060600 

Channel 15 Pressure Float Channel15/Pressure/15500100 

Channel 15 Gas Monitor Air flag Boolean Channel15/GasMonitor/Airflag/15500200 

Channel 15 Gas Monitor Error flag Boolean Channel15/GasMonitor/Errorflag/15500300 

Channel 15 Gas Monitor Warning flag Boolean Channel15/GasMonitor/Warningflag/15500400 

Channel 15 Monitor Display Error Message String Channel15/GasMonitor/MonitorDisplayErrorMessage/15500500 

Channel 15 Monitor Display Warning Message String Channel15/GasMonitor/MonitorDisplayWarningMessage/15500600 

Channel 15 Multiplexer error flag Boolean Channel15/Multiplexer/errorflag/15600100 

Channel 15 Multiplexer warning flag Boolean Channel15/Multiplexer/warningflag/15600200 

Channel 15 Multiplexer error number Long Channel15/Multiplexer/errornumber/15600300 

Channel 15 Multiplexer warning number Long Channel15/Multiplexer/warningnumber/15600400 

Channel 15 Multiplexer Error Description String Channel15/Multiplexer/ErrorDescription/15600600 

Channel 15 Multiplexer Warning Description String Channel15/Multiplexer/WarningDescription/15600700 

Channel 16 Gas A Concentration Float Channel16/GasA/Concentration/16010100 

Channel 16 Gas A Alarm HH occurred Boolean Channel16/GasA/AlarmHHOccurred/16010200 

Channel 16 Gas A Alarm H occurred Boolean Channel16/GasA/AlarmHOccurred/16010300 

Channel 16 Gas A Alarm L occurred Boolean Channel16/GasA/AlarmLOccurred/16010400 

Channel 16 Gas A Alarm LL occurred Boolean Channel16/GasA/AlarmLLOccurred/16010500 

Channel 16 Filter A alignment error flag Boolean Channel16/FilterA/AlignmentErrorFlag/16010600 

Channel 16 Gas B Concentration Float Channel16/GasB/Concentration/16020100 

Channel 16 Gas B Alarm HH occurred Boolean Channel16/GasB/AlarmHHOccurred/16020200 

Channel 16 Gas B Alarm H occurred Boolean Channel16/GasB/AlarmHOccurred/16020300 

Channel 16 Gas B Alarm L occurred Boolean Channel16/GasB/AlarmLOccurred/16020400 

Channel 16 Gas B Alarm LL occurred Boolean Channel16/GasB/AlarmLLOccurred/16020500 

Channel 16 Filter B alignment error flag Boolean Channel16/FilterB/AlignmentErrorFlag/16020600 

Channel 16 Gas C Concentration Float Channel16/GasC/Concentration/16030100 

Channel 16 Gas C Alarm HH occurred Boolean Channel16/GasC/AlarmHHOccurred/16030200 

Channel 16 Gas C Alarm H occurred Boolean Channel16/GasC/AlarmHOccurred/16030300 

Channel 16 Gas C Alarm L occurred Boolean Channel16/GasC/AlarmLOccurred/16030400 

Channel 16 Gas C Alarm LL occurred Boolean Channel16/GasC/AlarmLLOccurred/16030500 

Channel 16 Filter C alignment error flag Boolean Channel16/FilterC/AlignmentErrorFlag/16030600 

Channel 16 Gas D Concentration Float Channel16/GasD/Concentration/16040100 

Channel 16 Gas D Alarm HH occurred Boolean Channel16/GasD/AlarmHHOccurred/16040200 

Channel 16 Gas D Alarm H occurred Boolean Channel16/GasD/AlarmHOccurred/16040300 

Channel 16 Gas D Alarm L occurred Boolean Channel16/GasD/AlarmLOccurred/16040400 

Channel 16 Gas D Alarm LL occurred Boolean Channel16/GasD/AlarmLLOccurred/16040500 

Channel 16 Filter D alignment error flag Boolean Channel16/FilterD/AlignmentErrorFlag/16040600 

Channel 16 Gas E Concentration Float Channel16/GasE/Concentration/16050100 

Channel 16 Gas E Alarm HH occurred Boolean Channel16/GasE/AlarmHHOccurred/16050200 

Channel 16 Gas E Alarm H occurred Boolean Channel16/GasE/AlarmHOccurred/16050300 

Channel 16 Gas E Alarm L occurred Boolean Channel16/GasE/AlarmLOccurred/16050400 

Channel 16 Gas E Alarm LL occurred Boolean Channel16/GasE/AlarmLLOccurred/16050500 

Channel 16 Filter E alignment error flag Boolean Channel16/FilterE/AlignmentErrorFlag/16050600 

Channel 16 Gas W Concentration Float Channel16/GasW/Concentration/16060100 

Channel 16 Gas W Alarm HH occurred Boolean Channel16/GasW/AlarmHHOccurred/16060200 

Channel 16 Gas W Alarm H occurred Boolean Channel16/GasW/AlarmHOccurred/16060300 

Channel 16 Gas W Alarm L occurred Boolean Channel16/GasW/AlarmLOccurred/16060400 

Channel 16 Gas W Alarm LL occurred Boolean Channel16/GasW/AlarmLLOccurred/16060500 

Channel 16 Filter W alignment error flag Boolean Channel16/FilterW/AlignmentErrorFlag/16060600 
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Channel 16 Pressure Float Channel16/Pressure/16500100 

Channel 16 Gas Monitor Air flag Boolean Channel16/GasMonitor/Airflag/16500200 

Channel 16 Gas Monitor Error flag Boolean Channel16/GasMonitor/Errorflag/16500300 

Channel 16 Gas Monitor Warning flag Boolean Channel16/GasMonitor/Warningflag/16500400 

Channel 16 Monitor Display Error Message String Channel16/GasMonitor/MonitorDisplayErrorMessage/16500500 

Channel 16 Monitor Display Warning Message String Channel16/GasMonitor/MonitorDisplayWarningMessage/16500600 

Channel 16 Multiplexer error flag Boolean Channel16/Multiplexer/errorflag/16600100 

Channel 16 Multiplexer warning flag Boolean Channel16/Multiplexer/warningflag/16600200 

Channel 16 Multiplexer error number Long Channel16/Multiplexer/errornumber/16600300 

Channel 16 Multiplexer warning number Long Channel16/Multiplexer/warningnumber/16600400 

Channel 16 Multiplexer Error Description String Channel16/Multiplexer/ErrorDescription/16600600 

Channel 16 Multiplexer Warning Description String Channel16/Multiplexer/WarningDescription/16600700 

Channel 17 Gas A Concentration Float Channel17/GasA/Concentration/17010100 

Channel 17 Gas A Alarm HH occurred Boolean Channel17/GasA/AlarmHHOccurred/17010200 

Channel 17 Gas A Alarm H occurred Boolean Channel17/GasA/AlarmHOccurred/17010300 

Channel 17 Gas A Alarm L occurred Boolean Channel17/GasA/AlarmLOccurred/17010400 

Channel 17 Gas A Alarm LL occurred Boolean Channel17/GasA/AlarmLLOccurred/17010500 

Channel 17 Filter A alignment error flag Boolean Channel17/FilterA/AlignmentErrorFlag/17010600 

Channel 17 Gas B Concentration Float Channel17/GasB/Concentration/17020100 

Channel 17 Gas B Alarm HH occurred Boolean Channel17/GasB/AlarmHHOccurred/17020200 

Channel 17 Gas B Alarm H occurred Boolean Channel17/GasB/AlarmHOccurred/17020300 

Channel 17 Gas B Alarm L occurred Boolean Channel17/GasB/AlarmLOccurred/17020400 

Channel 17 Gas B Alarm LL occurred Boolean Channel17/GasB/AlarmLLOccurred/17020500 

Channel 17 Filter B alignment error flag Boolean Channel17/FilterB/AlignmentErrorFlag/17020600 

Channel 17 Gas C Concentration Float Channel17/GasC/Concentration/17030100 

Channel 17 Gas C Alarm HH occurred Boolean Channel17/GasC/AlarmHHOccurred/17030200 

Channel 17 Gas C Alarm H occurred Boolean Channel17/GasC/AlarmHOccurred/17030300 

Channel 17 Gas C Alarm L occurred Boolean Channel17/GasC/AlarmLOccurred/17030400 

Channel 17 Gas C Alarm LL occurred Boolean Channel17/GasC/AlarmLLOccurred/17030500 

Channel 17 Filter C alignment error flag Boolean Channel17/FilterC/AlignmentErrorFlag/17030600 

Channel 17 Gas D Concentration Float Channel17/GasD/Concentration/17040100 

Channel 17 Gas D Alarm HH occurred Boolean Channel17/GasD/AlarmHHOccurred/17040200 

Channel 17 Gas D Alarm H occurred Boolean Channel17/GasD/AlarmHOccurred/17040300 

Channel 17 Gas D Alarm L occurred Boolean Channel17/GasD/AlarmLOccurred/17040400 

Channel 17 Gas D Alarm LL occurred Boolean Channel17/GasD/AlarmLLOccurred/17040500 

Channel 17 Filter D alignment error flag Boolean Channel17/FilterD/AlignmentErrorFlag/17040600 

Channel 17 Gas E Concentration Float Channel17/GasE/Concentration/17050100 

Channel 17 Gas E Alarm HH occurred Boolean Channel17/GasE/AlarmHHOccurred/17050200 

Channel 17 Gas E Alarm H occurred Boolean Channel17/GasE/AlarmHOccurred/17050300 

Channel 17 Gas E Alarm L occurred Boolean Channel17/GasE/AlarmLOccurred/17050400 

Channel 17 Gas E Alarm LL occurred Boolean Channel17/GasE/AlarmLLOccurred/17050500 

Channel 17 Filter E alignment error flag Boolean Channel17/FilterE/AlignmentErrorFlag/17050600 

Channel 17 Gas W Concentration Float Channel17/GasW/Concentration/17060100 

Channel 17 Gas W Alarm HH occurred Boolean Channel17/GasW/AlarmHHOccurred/17060200 

Channel 17 Gas W Alarm H occurred Boolean Channel17/GasW/AlarmHOccurred/17060300 

Channel 17 Gas W Alarm L occurred Boolean Channel17/GasW/AlarmLOccurred/17060400 

Channel 17 Gas W Alarm LL occurred Boolean Channel17/GasW/AlarmLLOccurred/17060500 

Channel 17 Filter W alignment error flag Boolean Channel17/FilterW/AlignmentErrorFlag/17060600 

Channel 17 Pressure Float Channel17/Pressure/17500100 

Channel 17 Gas Monitor Air flag Boolean Channel17/GasMonitor/Airflag/17500200 

Channel 17 Gas Monitor Error flag Boolean Channel17/GasMonitor/Errorflag/17500300 

Channel 17 Gas Monitor Warning flag Boolean Channel17/GasMonitor/Warningflag/17500400 
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Channel 17 Monitor Display Error Message String Channel17/GasMonitor/MonitorDisplayErrorMessage/17500500 

Channel 17 Monitor Display Warning Message String Channel17/GasMonitor/MonitorDisplayWarningMessage/17500600 

Channel 17 Multiplexer error flag Boolean Channel17/Multiplexer/errorflag/17600100 

Channel 17 Multiplexer warning flag Boolean Channel17/Multiplexer/warningflag/17600200 

Channel 17 Multiplexer error number Long Channel17/Multiplexer/errornumber/17600300 

Channel 17 Multiplexer warning number Long Channel17/Multiplexer/warningnumber/17600400 

Channel 17 Multiplexer Error Description String Channel17/Multiplexer/ErrorDescription/17600600 

Channel 17 Multiplexer Warning Description String Channel17/Multiplexer/WarningDescription/17600700 

Channel 18 Gas A Concentration Float Channel18/GasA/Concentration/18010100 

Channel 18 Gas A Alarm HH occurred Boolean Channel18/GasA/AlarmHHOccurred/18010200 

Channel 18 Gas A Alarm H occurred Boolean Channel18/GasA/AlarmHOccurred/18010300 

Channel 18 Gas A Alarm L occurred Boolean Channel18/GasA/AlarmLOccurred/18010400 

Channel 18 Gas A Alarm LL occurred Boolean Channel18/GasA/AlarmLLOccurred/18010500 

Channel 18 Filter A alignment error flag Boolean Channel18/FilterA/AlignmentErrorFlag/18010600 

Channel 18 Gas B Concentration Float Channel18/GasB/Concentration/18020100 

Channel 18 Gas B Alarm HH occurred Boolean Channel18/GasB/AlarmHHOccurred/18020200 

Channel 18 Gas B Alarm H occurred Boolean Channel18/GasB/AlarmHOccurred/18020300 

Channel 18 Gas B Alarm L occurred Boolean Channel18/GasB/AlarmLOccurred/18020400 

Channel 18 Gas B Alarm LL occurred Boolean Channel18/GasB/AlarmLLOccurred/18020500 

Channel 18 Filter B alignment error flag Boolean Channel18/FilterB/AlignmentErrorFlag/18020600 

Channel 18 Gas C Concentration Float Channel18/GasC/Concentration/18030100 

Channel 18 Gas C Alarm HH occurred Boolean Channel18/GasC/AlarmHHOccurred/18030200 

Channel 18 Gas C Alarm H occurred Boolean Channel18/GasC/AlarmHOccurred/18030300 

Channel 18 Gas C Alarm L occurred Boolean Channel18/GasC/AlarmLOccurred/18030400 

Channel 18 Gas C Alarm LL occurred Boolean Channel18/GasC/AlarmLLOccurred/18030500 

Channel 18 Filter C alignment error flag Boolean Channel18/FilterC/AlignmentErrorFlag/18030600 

Channel 18 Gas D Concentration Float Channel18/GasD/Concentration/18040100 

Channel 18 Gas D Alarm HH occurred Boolean Channel18/GasD/AlarmHHOccurred/18040200 

Channel 18 Gas D Alarm H occurred Boolean Channel18/GasD/AlarmHOccurred/18040300 

Channel 18 Gas D Alarm L occurred Boolean Channel18/GasD/AlarmLOccurred/18040400 

Channel 18 Gas D Alarm LL occurred Boolean Channel18/GasD/AlarmLLOccurred/18040500 

Channel 18 Filter D alignment error flag Boolean Channel18/FilterD/AlignmentErrorFlag/18040600 

Channel 18 Gas E Concentration Float Channel18/GasE/Concentration/18050100 

Channel 18 Gas E Alarm HH occurred Boolean Channel18/GasE/AlarmHHOccurred/18050200 

Channel 18 Gas E Alarm H occurred Boolean Channel18/GasE/AlarmHOccurred/18050300 

Channel 18 Gas E Alarm L occurred Boolean Channel18/GasE/AlarmLOccurred/18050400 

Channel 18 Gas E Alarm LL occurred Boolean Channel18/GasE/AlarmLLOccurred/18050500 

Channel 18 Filter E alignment error flag Boolean Channel18/FilterE/AlignmentErrorFlag/18050600 

Channel 18 Gas W Concentration Float Channel18/GasW/Concentration/18060100 

Channel 18 Gas W Alarm HH occurred Boolean Channel18/GasW/AlarmHHOccurred/18060200 

Channel 18 Gas W Alarm H occurred Boolean Channel18/GasW/AlarmHOccurred/18060300 

Channel 18 Gas W Alarm L occurred Boolean Channel18/GasW/AlarmLOccurred/18060400 

Channel 18 Gas W Alarm LL occurred Boolean Channel18/GasW/AlarmLLOccurred/18060500 

Channel 18 Filter W alignment error flag Boolean Channel18/FilterW/AlignmentErrorFlag/18060600 

Channel 18 Pressure Float Channel18/Pressure/18500100 

Channel 18 Gas Monitor Air flag Boolean Channel18/GasMonitor/Airflag/18500200 

Channel 18 Gas Monitor Error flag Boolean Channel18/GasMonitor/Errorflag/18500300 

Channel 18 Gas Monitor Warning flag Boolean Channel18/GasMonitor/Warningflag/18500400 

Channel 18 Monitor Display Error Message String Channel18/GasMonitor/MonitorDisplayErrorMessage/18500500 

Channel 18 Monitor Display Warning Message String Channel18/GasMonitor/MonitorDisplayWarningMessage/18500600 

Channel 18 Multiplexer error flag Boolean Channel18/Multiplexer/errorflag/18600100 

Channel 18 Multiplexer warning flag Boolean Channel18/Multiplexer/warningflag/18600200 
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Channel 18 Multiplexer error number Long Channel18/Multiplexer/errornumber/18600300 

Channel 18 Multiplexer warning number Long Channel18/Multiplexer/warningnumber/18600400 

Channel 18 Multiplexer Error Description String Channel18/Multiplexer/ErrorDescription/18600600 

Channel 18 Multiplexer Warning Description String Channel18/Multiplexer/WarningDescription/18600700 

Channel 19 Gas A Concentration Float Channel19/GasA/Concentration/19010100 

Channel 19 Gas A Alarm HH occurred Boolean Channel19/GasA/AlarmHHOccurred/19010200 

Channel 19 Gas A Alarm H occurred Boolean Channel19/GasA/AlarmHOccurred/19010300 

Channel 19 Gas A Alarm L occurred Boolean Channel19/GasA/AlarmLOccurred/19010400 

Channel 19 Gas A Alarm LL occurred Boolean Channel19/GasA/AlarmLLOccurred/19010500 

Channel 19 Filter A alignment error flag Boolean Channel19/FilterA/AlignmentErrorFlag/19010600 

Channel 19 Gas B Concentration Float Channel19/GasB/Concentration/19020100 

Channel 19 Gas B Alarm HH occurred Boolean Channel19/GasB/AlarmHHOccurred/19020200 

Channel 19 Gas B Alarm H occurred Boolean Channel19/GasB/AlarmHOccurred/19020300 

Channel 19 Gas B Alarm L occurred Boolean Channel19/GasB/AlarmLOccurred/19020400 

Channel 19 Gas B Alarm LL occurred Boolean Channel19/GasB/AlarmLLOccurred/19020500 

Channel 19 Filter B alignment error flag Boolean Channel19/FilterB/AlignmentErrorFlag/19020600 

Channel 19 Gas C Concentration Float Channel19/GasC/Concentration/19030100 

Channel 19 Gas C Alarm HH occurred Boolean Channel19/GasC/AlarmHHOccurred/19030200 

Channel 19 Gas C Alarm H occurred Boolean Channel19/GasC/AlarmHOccurred/19030300 

Channel 19 Gas C Alarm L occurred Boolean Channel19/GasC/AlarmLOccurred/19030400 

Channel 19 Gas C Alarm LL occurred Boolean Channel19/GasC/AlarmLLOccurred/19030500 

Channel 19 Filter C alignment error flag Boolean Channel19/FilterC/AlignmentErrorFlag/19030600 

Channel 19 Gas D Concentration Float Channel19/GasD/Concentration/19040100 

Channel 19 Gas D Alarm HH occurred Boolean Channel19/GasD/AlarmHHOccurred/19040200 

Channel 19 Gas D Alarm H occurred Boolean Channel19/GasD/AlarmHOccurred/19040300 

Channel 19 Gas D Alarm L occurred Boolean Channel19/GasD/AlarmLOccurred/19040400 

Channel 19 Gas D Alarm LL occurred Boolean Channel19/GasD/AlarmLLOccurred/19040500 

Channel 19 Filter D alignment error flag Boolean Channel19/FilterD/AlignmentErrorFlag/19040600 

Channel 19 Gas E Concentration Float Channel19/GasE/Concentration/19050100 

Channel 19 Gas E Alarm HH occurred Boolean Channel19/GasE/AlarmHHOccurred/19050200 

Channel 19 Gas E Alarm H occurred Boolean Channel19/GasE/AlarmHOccurred/19050300 

Channel 19 Gas E Alarm L occurred Boolean Channel19/GasE/AlarmLOccurred/19050400 

Channel 19 Gas E Alarm LL occurred Boolean Channel19/GasE/AlarmLLOccurred/19050500 

Channel 19 Filter E alignment error flag Boolean Channel19/FilterE/AlignmentErrorFlag/19050600 

Channel 19 Gas W Concentration Float Channel19/GasW/Concentration/19060100 

Channel 19 Gas W Alarm HH occurred Boolean Channel19/GasW/AlarmHHOccurred/19060200 

Channel 19 Gas W Alarm H occurred Boolean Channel19/GasW/AlarmHOccurred/19060300 

Channel 19 Gas W Alarm L occurred Boolean Channel19/GasW/AlarmLOccurred/19060400 

Channel 19 Gas W Alarm LL occurred Boolean Channel19/GasW/AlarmLLOccurred/19060500 

Channel 19 Filter W alignment error flag Boolean Channel19/FilterW/AlignmentErrorFlag/19060600 

Channel 19 Pressure Float Channel19/Pressure/19500100 

Channel 19 Gas Monitor Air flag Boolean Channel19/GasMonitor/Airflag/19500200 

Channel 19 Gas Monitor Error flag Boolean Channel19/GasMonitor/Errorflag/19500300 

Channel 19 Gas Monitor Warning flag Boolean Channel19/GasMonitor/Warningflag/19500400 

Channel 19 Monitor Display Error Message String Channel19/GasMonitor/MonitorDisplayErrorMessage/19500500 

Channel 19 Monitor Display Warning Message String Channel19/GasMonitor/MonitorDisplayWarningMessage/19500600 

Channel 19 Multiplexer error flag Boolean Channel19/Multiplexer/errorflag/19600100 

Channel 19 Multiplexer warning flag Boolean Channel19/Multiplexer/warningflag/19600200 

Channel 19 Multiplexer error number Long Channel19/Multiplexer/errornumber/19600300 

Channel 19 Multiplexer warning number Long Channel19/Multiplexer/warningnumber/19600400 

Channel 19 Multiplexer Error Description String Channel19/Multiplexer/ErrorDescription/19600600 

Channel 19 Multiplexer Warning Description String Channel19/Multiplexer/WarningDescription/19600700 
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Channel 20 Gas A Concentration Float Channel20/GasA/Concentration/20010100 

Channel 20 Gas A Alarm HH occurred Boolean Channel20/GasA/AlarmHHOccurred/20010200 

Channel 20 Gas A Alarm H occurred Boolean Channel20/GasA/AlarmHOccurred/20010300 

Channel 20 Gas A Alarm L occurred Boolean Channel20/GasA/AlarmLOccurred/20010400 

Channel 20 Gas A Alarm LL occurred Boolean Channel20/GasA/AlarmLLOccurred/20010500 

Channel 20 Filter A alignment error flag Boolean Channel20/FilterA/AlignmentErrorFlag/20010600 

Channel 20 Gas B Concentration Float Channel20/GasB/Concentration/20020100 

Channel 20 Gas B Alarm HH occurred Boolean Channel20/GasB/AlarmHHOccurred/20020200 

Channel 20 Gas B Alarm H occurred Boolean Channel20/GasB/AlarmHOccurred/20020300 

Channel 20 Gas B Alarm L occurred Boolean Channel20/GasB/AlarmLOccurred/20020400 

Channel 20 Gas B Alarm LL occurred Boolean Channel20/GasB/AlarmLLOccurred/20020500 

Channel 20 Filter B alignment error flag Boolean Channel20/FilterB/AlignmentErrorFlag/20020600 

Channel 20 Gas C Concentration Float Channel20/GasC/Concentration/20030100 

Channel 20 Gas C Alarm HH occurred Boolean Channel20/GasC/AlarmHHOccurred/20030200 

Channel 20 Gas C Alarm H occurred Boolean Channel20/GasC/AlarmHOccurred/20030300 

Channel 20 Gas C Alarm L occurred Boolean Channel20/GasC/AlarmLOccurred/20030400 

Channel 20 Gas C Alarm LL occurred Boolean Channel20/GasC/AlarmLLOccurred/20030500 

Channel 20 Filter C alignment error flag Boolean Channel20/FilterC/AlignmentErrorFlag/20030600 

Channel 20 Gas D Concentration Float Channel20/GasD/Concentration/20040100 

Channel 20 Gas D Alarm HH occurred Boolean Channel20/GasD/AlarmHHOccurred/20040200 

Channel 20 Gas D Alarm H occurred Boolean Channel20/GasD/AlarmHOccurred/20040300 

Channel 20 Gas D Alarm L occurred Boolean Channel20/GasD/AlarmLOccurred/20040400 

Channel 20 Gas D Alarm LL occurred Boolean Channel20/GasD/AlarmLLOccurred/20040500 

Channel 20 Filter D alignment error flag Boolean Channel20/FilterD/AlignmentErrorFlag/20040600 

Channel 20 Gas E Concentration Float Channel20/GasE/Concentration/20050100 

Channel 20 Gas E Alarm HH occurred Boolean Channel20/GasE/AlarmHHOccurred/20050200 

Channel 20 Gas E Alarm H occurred Boolean Channel20/GasE/AlarmHOccurred/20050300 

Channel 20 Gas E Alarm L occurred Boolean Channel20/GasE/AlarmLOccurred/20050400 

Channel 20 Gas E Alarm LL occurred Boolean Channel20/GasE/AlarmLLOccurred/20050500 

Channel 20 Filter E alignment error flag Boolean Channel20/FilterE/AlignmentErrorFlag/20050600 

Channel 20 Gas W Concentration Float Channel20/GasW/Concentration/20060100 

Channel 20 Gas W Alarm HH occurred Boolean Channel20/GasW/AlarmHHOccurred/20060200 

Channel 20 Gas W Alarm H occurred Boolean Channel20/GasW/AlarmHOccurred/20060300 

Channel 20 Gas W Alarm L occurred Boolean Channel20/GasW/AlarmLOccurred/20060400 

Channel 20 Gas W Alarm LL occurred Boolean Channel20/GasW/AlarmLLOccurred/20060500 

Channel 20 Filter W alignment error flag Boolean Channel20/FilterW/AlignmentErrorFlag/20060600 

Channel 20 Pressure Float Channel20/Pressure/20500100 

Channel 20 Gas Monitor Air flag Boolean Channel20/GasMonitor/Airflag/20500200 

Channel 20 Gas Monitor Error flag Boolean Channel20/GasMonitor/Errorflag/20500300 

Channel 20 Gas Monitor Warning flag Boolean Channel20/GasMonitor/Warningflag/20500400 

Channel 20 Monitor Display Error Message String Channel20/GasMonitor/MonitorDisplayErrorMessage/20500500 

Channel 20 Monitor Display Warning Message String Channel20/GasMonitor/MonitorDisplayWarningMessage/20500600 

Channel 20 Multiplexer error flag Boolean Channel20/Multiplexer/errorflag/20600100 

Channel 20 Multiplexer warning flag Boolean Channel20/Multiplexer/warningflag/20600200 

Channel 20 Multiplexer error number Long Channel20/Multiplexer/errornumber/20600300 

Channel 20 Multiplexer warning number                           Long Channel20/Multiplexer/warningnumber/20600400 

Channel 20 Multiplexer Error Description String Channel20/Multiplexer/ErrorDescription/20600600 

Channel 20 Multiplexer Warning Description String Channel20/Multiplexer/WarningDescription/20600700 

Channel 21 Gas A Concentration Float Channel21/GasA/Concentration/21010100 

Channel 21 Gas A Alarm HH occurred Boolean Channel21/GasA/AlarmHHOccurred/21010200 

Channel 21 Gas A Alarm H occurred Boolean Channel21/GasA/AlarmHOccurred/21010300 

Channel 21 Gas A Alarm L occurred Boolean Channel21/GasA/AlarmLOccurred/21010400 
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Channel 21 Gas A Alarm LL occurred Boolean Channel21/GasA/AlarmLLOccurred/21010500 

Channel 21 Filter A alignment error flag Boolean Channel21/FilterA/AlignmentErrorFlag/21010600 

Channel 21 Gas B Concentration Float Channel21/GasB/Concentration/21020100 

Channel 21 Gas B Alarm HH occurred Boolean Channel21/GasB/AlarmHHOccurred/21020200 

Channel 21 Gas B Alarm H occurred Boolean Channel21/GasB/AlarmHOccurred/21020300 

Channel 21 Gas B Alarm L occurred Boolean Channel21/GasB/AlarmLOccurred/21020400 

Channel 21 Gas B Alarm LL occurred Boolean Channel21/GasB/AlarmLLOccurred/21020500 

Channel 21 Filter B alignment error flag Boolean Channel21/FilterB/AlignmentErrorFlag/21020600 

Channel 21 Gas C Concentration Float Channel21/GasC/Concentration/21030100 

Channel 21 Gas C Alarm HH occurred Boolean Channel21/GasC/AlarmHHOccurred/21030200 

Channel 21 Gas C Alarm H occurred Boolean Channel21/GasC/AlarmHOccurred/21030300 

Channel 21 Gas C Alarm L occurred Boolean Channel21/GasC/AlarmLOccurred/21030400 

Channel 21 Gas C Alarm LL occurred Boolean Channel21/GasC/AlarmLLOccurred/21030500 

Channel 21 Filter C alignment error flag Boolean Channel21/FilterC/AlignmentErrorFlag/21030600 

Channel 21 Gas D Concentration Float Channel21/GasD/Concentration/21040100 

Channel 21 Gas D Alarm HH occurred Boolean Channel21/GasD/AlarmHHOccurred/21040200 

Channel 21 Gas D Alarm H occurred Boolean Channel21/GasD/AlarmHOccurred/21040300 

Channel 21 Gas D Alarm L occurred Boolean Channel21/GasD/AlarmLOccurred/21040400 

Channel 21 Gas D Alarm LL occurred Boolean Channel21/GasD/AlarmLLOccurred/21040500 

Channel 21 Filter D alignment error flag Boolean Channel21/FilterD/AlignmentErrorFlag/21040600 

Channel 21 Gas E Concentration Float Channel21/GasE/Concentration/21050100 

Channel 21 Gas E Alarm HH occurred Boolean Channel21/GasE/AlarmHHOccurred/21050200 

Channel 21 Gas E Alarm H occurred Boolean Channel21/GasE/AlarmHOccurred/21050300 

Channel 21 Gas E Alarm L occurred Boolean Channel21/GasE/AlarmLOccurred/21050400 

Channel 21 Gas E Alarm LL occurred Boolean Channel21/GasE/AlarmLLOccurred/21050500 

Channel 21 Filter E alignment error flag Boolean Channel21/FilterE/AlignmentErrorFlag/21050600 

Channel 21 Gas W Concentration Float Channel21/GasW/Concentration/21060100 

Channel 21 Gas W Alarm HH occurred Boolean Channel21/GasW/AlarmHHOccurred/21060200 

Channel 21 Gas W Alarm H occurred Boolean Channel21/GasW/AlarmHOccurred/21060300 

Channel 21 Gas W Alarm L occurred Boolean Channel21/GasW/AlarmLOccurred/21060400 

Channel 21 Gas W Alarm LL occurred Boolean Channel21/GasW/AlarmLLOccurred/21060500 

Channel 21 Filter W alignment error flag Boolean Channel21/FilterW/AlignmentErrorFlag/21060600 

Channel 21 Pressure Float Channel21/Pressure/21500100 

Channel 21 Gas Monitor Air flag Boolean Channel21/GasMonitor/Airflag/21500200 

Channel 21 Gas Monitor Error flag Boolean Channel21/GasMonitor/Errorflag/21500300 

Channel 21 Gas Monitor Warning flag Boolean Channel21/GasMonitor/Warningflag/21500400 

Channel 21 Monitor Display Error Message String Channel21/GasMonitor/MonitorDisplayErrorMessage/21500500 

Channel 21 Monitor Display Warning Message String Channel21/GasMonitor/MonitorDisplayWarningMessage/21500600 

Channel 21 Multiplexer error flag Boolean Channel21/Multiplexer/errorflag/21600100 

Channel 21 Multiplexer warning flag Boolean Channel21/Multiplexer/warningflag/21600200 

Channel 21 Multiplexer error number Long Channel21/Multiplexer/errornumber/21600300 

Channel 21 Multiplexer warning number Long Channel21/Multiplexer/warningnumber/21600400 

Channel 21 Multiplexer Error Description String Channel21/Multiplexer/ErrorDescription/21600600 

Channel 21 Multiplexer Warning Description String Channel21/Multiplexer/WarningDescription/21600700 

Channel 22 Gas A Concentration           Float Channel22/GasA/Concentration/22010100 

Channel 22 Gas A Alarm HH occurred       Boolean Channel22/GasA/AlarmHHOccurred/22010200 

Channel 22 Gas A Alarm H occurred        Boolean Channel22/GasA/AlarmHOccurred/22010300 

Channel 22 Gas A Alarm L occurred        Boolean Channel22/GasA/AlarmLOccurred/22010400 

Channel 22 Gas A Alarm LL occurred       Boolean Channel22/GasA/AlarmLLOccurred/22010500 

Channel 22 Filter A alignment error flag Boolean Channel22/FilterA/AlignmentErrorFlag/22010600 

Channel 22 Gas B Concentration           Float Channel22/GasB/Concentration/22020100 

Channel 22 Gas B Alarm HH occurred       Boolean Channel22/GasB/AlarmHHOccurred/22020200 
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Channel 22 Gas B Alarm H occurred        Boolean Channel22/GasB/AlarmHOccurred/22020300 

Channel 22 Gas B Alarm L occurred        Boolean Channel22/GasB/AlarmLOccurred/22020400 

Channel 22 Gas B Alarm LL occurred       Boolean Channel22/GasB/AlarmLLOccurred/22020500 

Channel 22 Filter B alignment error flag Boolean Channel22/FilterB/AlignmentErrorFlag/22020600 

Channel 22 Gas C Concentration           Float Channel22/GasC/Concentration/22030100 

Channel 22 Gas C Alarm HH occurred       Boolean Channel22/GasC/AlarmHHOccurred/22030200 

Channel 22 Gas C Alarm H occurred        Boolean Channel22/GasC/AlarmHOccurred/22030300 

Channel 22 Gas C Alarm L occurred        Boolean Channel22/GasC/AlarmLOccurred/22030400 

Channel 22 Gas C Alarm LL occurred       Boolean Channel22/GasC/AlarmLLOccurred/22030500 

Channel 22 Filter C alignment error flag Boolean Channel22/FilterC/AlignmentErrorFlag/22030600 

Channel 22 Gas D Concentration           Float Channel22/GasD/Concentration/22040100 

Channel 22 Gas D Alarm HH occurred       Boolean Channel22/GasD/AlarmHHOccurred/22040200 

Channel 22 Gas D Alarm H occurred        Boolean Channel22/GasD/AlarmHOccurred/22040300 

Channel 22 Gas D Alarm L occurred        Boolean Channel22/GasD/AlarmLOccurred/22040400 

Channel 22 Gas D Alarm LL occurred       Boolean Channel22/GasD/AlarmLLOccurred/22040500 

Channel 22 Filter D alignment error flag Boolean Channel22/FilterD/AlignmentErrorFlag/22040600 

Channel 22 Gas E Concentration           Float Channel22/GasE/Concentration/22050100 

Channel 22 Gas E Alarm HH occurred       Boolean Channel22/GasE/AlarmHHOccurred/22050200 

Channel 22 Gas E Alarm H occurred        Boolean Channel22/GasE/AlarmHOccurred/22050300 

Channel 22 Gas E Alarm L occurred        Boolean Channel22/GasE/AlarmLOccurred/22050400 

Channel 22 Gas E Alarm LL occurred       Boolean Channel22/GasE/AlarmLLOccurred/22050500 

Channel 22 Filter E alignment error flag Boolean Channel22/FilterE/AlignmentErrorFlag/22050600 

Channel 22 Gas W Concentration           Float Channel22/GasW/Concentration/22060100 

Channel 22 Gas W Alarm HH occurred       Boolean Channel22/GasW/AlarmHHOccurred/22060200 

Channel 22 Gas W Alarm H occurred        Boolean Channel22/GasW/AlarmHOccurred/22060300 

Channel 22 Gas W Alarm L occurred        Boolean Channel22/GasW/AlarmLOccurred/22060400 

Channel 22 Gas W Alarm LL occurred       Boolean Channel22/GasW/AlarmLLOccurred/22060500 

Channel 22 Filter W alignment error flag Boolean Channel22/FilterW/AlignmentErrorFlag/22060600 

Channel 22 Pressure                      Float Channel22/Pressure/22500100 

Channel 22 Gas Monitor Air flag          Boolean Channel22/GasMonitor/Airflag/22500200 

Channel 22 Gas Monitor Error flag        Boolean Channel22/GasMonitor/Errorflag/22500300 

Channel 22 Gas Monitor Warning flag      Boolean Channel22/GasMonitor/Warningflag/22500400 

Channel 22 Monitor Display Error Message String Channel22/GasMonitor/MonitorDisplayErrorMessage/22500500 

Channel 22 Monitor Display Warning Message String Channel22/GasMonitor/MonitorDisplayWarningMessage/22500600 

Channel 22 Multiplexer error flag        Boolean Channel22/Multiplexer/errorflag/22600100 

Channel 22 Multiplexer warning flag      Boolean Channel22/Multiplexer/warningflag/22600200 

Channel 22 Multiplexer error number      Long Channel22/Multiplexer/errornumber/22600300 

Channel 22 Multiplexer warning number    Long Channel22/Multiplexer/warningnumber/22600400 

Channel 22 Multiplexer Error Description String Channel22/Multiplexer/ErrorDescription/22600600 

Channel 22 Multiplexer Warning Description String Channel22/Multiplexer/WarningDescription/22600700 

Channel 23 Gas A Concentration           Float Channel23/GasA/Concentration/23010100 

Channel 23 Gas A Alarm HH occurred       Boolean Channel23/GasA/AlarmHHOccurred/23010200 

Channel 23 Gas A Alarm H occurred        Boolean Channel23/GasA/AlarmHOccurred/23010300 

Channel 23 Gas A Alarm L occurred        Boolean Channel23/GasA/AlarmLOccurred/23010400 

Channel 23 Gas A Alarm LL occurred       Boolean Channel23/GasA/AlarmLLOccurred/23010500 

Channel 23 Filter A alignment error flag Boolean Channel23/FilterA/AlignmentErrorFlag/23010600 

Channel 23 Gas B Concentration           Float Channel23/GasB/Concentration/23020100 

Channel 23 Gas B Alarm HH occurred       Boolean Channel23/GasB/AlarmHHOccurred/23020200 

Channel 23 Gas B Alarm H occurred        Boolean Channel23/GasB/AlarmHOccurred/23020300 

Channel 23 Gas B Alarm L occurred        Boolean Channel23/GasB/AlarmLOccurred/23020400 

Channel 23 Gas B Alarm LL occurred       Boolean Channel23/GasB/AlarmLLOccurred/23020500 

Channel 23 Filter B alignment error flag Boolean Channel23/FilterB/AlignmentErrorFlag/23020600 
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Channel 23 Gas C Concentration           Float Channel23/GasC/Concentration/23030100 

Channel 23 Gas C Alarm HH occurred       Boolean Channel23/GasC/AlarmHHOccurred/23030200 

Channel 23 Gas C Alarm H occurred        Boolean Channel23/GasC/AlarmHOccurred/23030300 

Channel 23 Gas C Alarm L occurred        Boolean Channel23/GasC/AlarmLOccurred/23030400 

Channel 23 Gas C Alarm LL occurred       Boolean Channel23/GasC/AlarmLLOccurred/23030500 

Channel 23 Filter C alignment error flag Boolean Channel23/FilterC/AlignmentErrorFlag/23030600 

Channel 23 Gas D Concentration           Float Channel23/GasD/Concentration/23040100 

Channel 23 Gas D Alarm HH occurred       Boolean Channel23/GasD/AlarmHHOccurred/23040200 

Channel 23 Gas D Alarm H occurred        Boolean Channel23/GasD/AlarmHOccurred/23040300 

Channel 23 Gas D Alarm L occurred        Boolean Channel23/GasD/AlarmLOccurred/23040400 

Channel 23 Gas D Alarm LL occurred       Boolean Channel23/GasD/AlarmLLOccurred/23040500 

Channel 23 Filter D alignment error flag Boolean Channel23/FilterD/AlignmentErrorFlag/23040600 

Channel 23 Gas E Concentration           Float Channel23/GasE/Concentration/23050100 

Channel 23 Gas E Alarm HH occurred       Boolean Channel23/GasE/AlarmHHOccurred/23050200 

Channel 23 Gas E Alarm H occurred        Boolean Channel23/GasE/AlarmHOccurred/23050300 

Channel 23 Gas E Alarm L occurred        Boolean Channel23/GasE/AlarmLOccurred/23050400 

Channel 23 Gas E Alarm LL occurred       Boolean Channel23/GasE/AlarmLLOccurred/23050500 

Channel 23 Filter E alignment error flag Boolean Channel23/FilterE/AlignmentErrorFlag/23050600 

Channel 23 Gas W Concentration           Float Channel23/GasW/Concentration/23060100 

Channel 23 Gas W Alarm HH occurred       Boolean Channel23/GasW/AlarmHHOccurred/23060200 

Channel 23 Gas W Alarm H occurred        Boolean Channel23/GasW/AlarmHOccurred/23060300 

Channel 23 Gas W Alarm L occurred        Boolean Channel23/GasW/AlarmLOccurred/23060400 

Channel 23 Gas W Alarm LL occurred       Boolean Channel23/GasW/AlarmLLOccurred/23060500 

Channel 23 Filter W alignment error flag Boolean Channel23/FilterW/AlignmentErrorFlag/23060600 

Channel 23 Pressure                      Float Channel23/Pressure/23500100 

Channel 23 Gas Monitor Air flag          Boolean Channel23/GasMonitor/Airflag/23500200 

Channel 23 Gas Monitor Error flag        Boolean Channel23/GasMonitor/Errorflag/23500300 

Channel 23 Gas Monitor Warning flag      Boolean Channel23/GasMonitor/Warningflag/23500400 

Channel 23 Monitor Display Error Message String Channel23/GasMonitor/MonitorDisplayErrorMessage/23500500 

Channel 23 Monitor Display Warning Message String Channel23/GasMonitor/MonitorDisplayWarningMessage/23500600 

Channel 23 Multiplexer error flag        Boolean Channel23/Multiplexer/errorflag/23600100 

Channel 23 Multiplexer warning flag      Boolean Channel23/Multiplexer/warningflag/23600200 

Channel 23 Multiplexer error number      Long Channel23/Multiplexer/errornumber/23600300 

Channel 23 Multiplexer warning number    Long Channel23/Multiplexer/warningnumber/23600400 

Channel 23 Multiplexer Error Description String Channel23/Multiplexer/ErrorDescription/23600600 

Channel 23 Multiplexer Warning Description String Channel23/Multiplexer/WarningDescription/23600700 

Channel 24 Gas A Concentration Float Channel24/GasA/Concentration/24010100 

Channel 24 Gas A Alarm HH occurred Boolean Channel24/GasA/AlarmHHOccurred/24010200 

Channel 24 Gas A Alarm H occurred Boolean Channel24/GasA/AlarmHOccurred/24010300 

Channel 24 Gas A Alarm L occurred Boolean Channel24/GasA/AlarmLOccurred/24010400 

Channel 24 Gas A Alarm LL occurred Boolean Channel24/GasA/AlarmLLOccurred/24010500 

Channel 24 Filter A alignment error flag Boolean Channel24/FilterA/AlignmentErrorFlag/24010600 

Channel 24 Gas B Concentration Float Channel24/GasB/Concentration/24020100 

Channel 24 Gas B Alarm HH occurred Boolean Channel24/GasB/AlarmHHOccurred/24020200 

Channel 24 Gas B Alarm H occurred Boolean Channel24/GasB/AlarmHOccurred/24020300 

Channel 24 Gas B Alarm L occurred Boolean Channel24/GasB/AlarmLOccurred/24020400 

Channel 24 Gas B Alarm LL occurred Boolean Channel24/GasB/AlarmLLOccurred/24020500 

Channel 24 Filter B alignment error flag Boolean Channel24/FilterB/AlignmentErrorFlag/24020600 

Channel 24 Gas C Concentration Float Channel24/GasC/Concentration/24030100 

Channel 24 Gas C Alarm HH occurred Boolean Channel24/GasC/AlarmHHOccurred/24030200 

Channel 24 Gas C Alarm H occurred Boolean Channel24/GasC/AlarmHOccurred/24030300 

Channel 24 Gas C Alarm L occurred Boolean Channel24/GasC/AlarmLOccurred/24030400 
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Channel 24 Gas C Alarm LL occurred Boolean Channel24/GasC/AlarmLLOccurred/24030500 

Channel 24 Filter C alignment error flag Boolean Channel24/FilterC/AlignmentErrorFlag/24030600 

Channel 24 Gas D Concentration Float Channel24/GasD/Concentration/24040100 

Channel 24 Gas D Alarm HH occurred Boolean Channel24/GasD/AlarmHHOccurred/24040200 

Channel 24 Gas D Alarm H occurred Boolean Channel24/GasD/AlarmHOccurred/24040300 

Channel 24 Gas D Alarm L occurred Boolean Channel24/GasD/AlarmLOccurred/24040400 

Channel 24 Gas D Alarm LL occurred Boolean Channel24/GasD/AlarmLLOccurred/24040500 

Channel 24 Filter D alignment error flag Boolean Channel24/FilterD/AlignmentErrorFlag/24040600 

Channel 24 Gas E Concentration Float Channel24/GasE/Concentration/24050100 

Channel 24 Gas E Alarm HH occurred Boolean Channel24/GasE/AlarmHHOccurred/24050200 

Channel 24 Gas E Alarm H occurred Boolean Channel24/GasE/AlarmHOccurred/24050300 

Channel 24 Gas E Alarm L occurred Boolean Channel24/GasE/AlarmLOccurred/24050400 

Channel 24 Gas E Alarm LL occurred Boolean Channel24/GasE/AlarmLLOccurred/24050500 

Channel 24 Filter E alignment error flag Boolean Channel24/FilterE/AlignmentErrorFlag/24050600 

Channel 24 Gas W Concentration Float Channel24/GasW/Concentration/24060100 

Channel 24 Gas W Alarm HH occurred Boolean Channel24/GasW/AlarmHHOccurred/24060200 

Channel 24 Gas W Alarm H occurred Boolean Channel24/GasW/AlarmHOccurred/24060300 

Channel 24 Gas W Alarm L occurred Boolean Channel24/GasW/AlarmLOccurred/24060400 

Channel 24 Gas W Alarm LL occurred Boolean Channel24/GasW/AlarmLLOccurred/24060500 

Channel 24 Filter W alignment error flag Boolean Channel24/FilterW/AlignmentErrorFlag/24060600 

Channel 24 Pressure Float Channel24/Pressure/24500100 

Channel 24 Gas Monitor Air flag Boolean Channel24/GasMonitor/Airflag/24500200 

Channel 24 Gas Monitor Error flag Boolean Channel24/GasMonitor/Errorflag/24500300 

Channel 24 Gas Monitor Warning flag Boolean Channel24/GasMonitor/Warningflag/24500400 

Channel 24 Monitor Display Error Message String Channel24/GasMonitor/MonitorDisplayErrorMessage/24500500 

Channel 24 Monitor Display Warning Message String Channel24/GasMonitor/MonitorDisplayWarningMessage/24500600 

Channel 24 Multiplexer error flag Boolean Channel24/Multiplexer/errorflag/24600100 

Channel 24 Multiplexer warning flag Boolean Channel24/Multiplexer/warningflag/24600200 

Channel 24 Multiplexer error number Long Channel24/Multiplexer/errornumber/24600300 

Channel 24 Multiplexer warning number Long Channel24/Multiplexer/warningnumber/24600400 

Channel 24 Multiplexer Error Description String Channel24/Multiplexer/ErrorDescription/24600600 

Channel 24 Multiplexer Warning Description String Channel24/Multiplexer/WarningDescription/24600700 

Set-up Parameters 

Unit gas concentration String Setup/Unit/GasConcentration/50010100 

Unit Water vapour String Setup/Unit/WaterVapour/50010200 

Unit pressure String Setup/Unit/Pressure/50010300 

Unit Temp String Setup/Unit/Temp/50010400 

Unit length String Setup/Unit/Length/50010500 

Unit time String Setup/Unit/Time/50010600 

Gas A name String Setup/Name/GasA/50020100 

Gas B name String Setup/Name/GasB/50020200 

Gas C name String Setup/Name/GasC/50020300 

Gas D name String Setup/Name/GasD/50020400 

Gas E name String Setup/Name/GasE/50020500 

Gas A Molecular weight Float Setup/MolecularWeight/GasA/50030100 

Gas B Molecular weight Float Setup/MolecularWeight/GasB/50030200 

Gas C Molecular weight Float Setup/MolecularWeight/GasC/50030300 

Gas D Molecular weight Float Setup/MolecularWeight/GasD/50030400 

Gas E Molecular weight Float Setup/MolecularWeight/GasE/50030500 

Gas A SIT Float Setup/SIT/GasA/50040100 

Gas B SIT Float Setup/SIT/GasB/50040200 

Gas C SIT Float Setup/SIT/GasC/50040300 
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Gas D SIT Float Setup/SIT/GasD/50040400 

Gas E SIT Float Setup/SIT/GasE/50040500 

Gas W SIT Float Setup/SIT/GasW/50040600 

Normalisation temperature Float Setup/Temperature/Normalisation/50050100 

Humidity interference compensation Boolean Setup/Compensation/HumidityInterference/50060100 

Cross compensation Boolean Setup/Compensation/Cross/50060200                

Flushing mode String Setup/Flushing/Mode/50070100             

Tube length Float Setup/Flushing/TubeLength/50070200       

Chamber Flushing Time Long Setup/Flushing/ChamberFlushTime/50070300 

Tube Flushing Time Long Setup/Flushing/TubeFlushTime/50070400    

Number Of Connected 1409 multiplexers Long Setup/NumberOfConnectedMultiplexers/1409/50090100 

Number of 1409 multiplexer channels  Long Setup/NumberOfMultiplexerChannels/1409/50090300 

Tags for reading last measurement in Gas Monitor 

LastMeasuredSampleChannel Long General/LastMeasuredSampleChannel/600500 



 

_______________________________________________________________________ 

 LumaSense Technologies A/S Tel.:(+45) 44 20 01 00 

 Energivej 30 Fax: (+45) 44 20 01 01 

 DK-2750 Ballerup, Denmark http://www.lumasenseinc.com 
 

7820 
7880 


